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Preface

As companies continue to integrate computer technology into their business operations,
it becomes increasingly important to properly administer the IT function, particularly
with respect to performance and cost.

CIMS Server provides an essential component of an effective financial management
system. The technology behind CIMS Server is based on CIMS Lab’s many years of
experience in the development and implementation of Resource Accounting, Capacity
Planning and IT Chargeback products.

About CIMS Lab

Founded in 1974, CIMS Lab has focused on meeting the financial and resource reporting
requirements of Information Services Departments. CIMS has evolved with corporate IT
management requirements. Focused commitment to client service and support sets
CIMS apart from competing products. Our goal is to provide the best chargeback and
resource reporting software in the world at the lowest possible cost to our customers.

CIMS Lab strongly believes in and executes the concept of continuous product
improvement. Customers have access to CIMS product development personnel to
ensure that customer feedback and other critical issues are incorporated into the next
release of the product.
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Contacting CIMS Lab

Contacting CIMS Lab

To contact CIMS Lab with questions, comments or problems, please use one of the
following methods:

For product assistance or information:

USA & Canada, toll free - (800) 283-4267
International - (916) 783-8525

FAX - (916) 783-2090

World Wide Web - http://www.cimslab.com

Mailing Address:

CIMS Lab, Inc.
3013 Douglas Blvd., Suite 120
Roseville, CA 95661-3842
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About This Guide

About This Guide

This guide describes the installation procedures and administration functions and
features of CIMS Server.

The following table describes the chapters in this guide. If you are installing and setting
up CIMS Server for the first time, you should begin with Chapter 1, About CIMS Server
and then continue to Chapter 2, Installing CIMS Server and Getting Started before
continuing to the other chapters in the guide.

Ch.

No. Chapter Name Content Description

1 About CIMS Server Describes the overall structure and feature set of the
CIMS Server system.

2 [Installing CIMS Server Discusses the installation of the CIMS Server system

and Getting Started components and provides a Getting Started section.

3 Setting Up the System Explains how to configure the various components of

the system.

4 Database Administration  Describes how to use CIMS Server Administrator to
create and administer CIMS Server databases.

5  Processing Data Provides an overview of the data processing cycle and
components and describes how to use CIMS Server
Administrator to set processing options.

6  Troubleshooting and Describes problems you may encounter while setting
Additional Information up and using the CIMS Server system and how to solve
them.
A Database Tables Describes the layout of key database tables used by
CIMS Server.
B  File Layouts Describes the file layout of important files used by the
CIMS Server system.
C  Scripts Describes the scripts that are included in the CIMS
Server installation.
D  Control and Processing Describes the control and processing statements used
Statements by CIMS Processing Engine.
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Conventions
Conventions
Some or all of the following conventions appear in this guide:
Symbol or
Type Style Represents Example
Alternate (online help only) hyperlinked  ...see Data Migration.
color cross-references to other sections
in this guide; if you are viewing
this guide online, you can click
the cross-reference to jump
directly to its location
Italic words that are emphasized ...the entry after the current entry...
a new term ...called a source object.
the titles of other manuals CIMS Server Web Reporting User’s
Guide
variables in file names or system IUSR_computername
names
AcctExcp-yyyymmdd. txt
Bold names of interface items such as  Select the Use Calendar check box

tabs, boxes, buttons, lists, and

check boxes. Enter the path in the Process

Definition Path box

Monospace directories, file names, command Processes folder
names, computer code, computer
screen text, system responses,
command line commands, what Type CIMSServer
the user types

BatchReport.wsf script

<> the name of a key on the Press <Enter>
keyboard
4 navigating a menu or a folder File » Import » Object

Terminology: Reports, Spreadsheets, and Graphs

For simplicity, in this guide, the term “report” refers to reports, spreadsheets, and graphs.

Related Publications

As you use this guide, you might find it helpful to have these additional guides available
for reference:

m CIMS Server Web Reporting User’s Guide

m CIMS Data Collectors for Microsoft Windows Installation and User Guide
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About CIMS Server

This chapter describes the overall structure, benefits and features of the CIMS Server

system.
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What Is CIMS Server?

What Is CIMS Server?

CIMS Server is a full-featured resource accounting and chargeback system that enables
users to consolidate accounting data from multiple IT resources into a common output
format for costing and reporting. This output may then be used for Web-based or static
invoicing and other reporting or as a feed to existing financial systems.

CIMS Server tracks usage data associated with:

Operating systems
Databases

Network systems
Storage systems
Internet systems
E-mail systems
E-commerce systems

Other applications or monitors that create usage metering data

As shown in Figure 1-1 on page 1-3, it is useful to think of CIMS Server as a funnel that
accepts usage data and returns organized information that can help IT managers and staff
to track and allocate resources.
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Spreadsheets
Reports
Graphs

HTML

Resource Cost Chargeback
Usage Allocation and Billing

Figure 1-1 « CIMS Server Collects Usage Data and Organizes It As Reporting Information

CIMS Server runs on the Windows 2000 Server, Windows Server 2003, or Windows XP
operating system with a Microsoft SQL Server or Microsoft Desktop Engine (MSDE)
database (see Database Server on page 1-9) and a Microsoft Internet Information Services
(IIS) Web server.
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Benefits of CIMS Server

Keeping track of IT usage can be a formidable task for any organization. Most sizable
enterprises consist of many platforms, systems, and subsystems, each costly to own,
maintain and operate. In addition, each component has its own unique record format
and metrics.

With CIMS Server, you can process, access, and analyze IT resource usage metrics from
many IT resources and view the results right in your Web browser. CIMS Server helps you
to better understand who is using IT resources and how the resources are being used.

The following are just a few of the benefits of CIMS Server:

m Enterprise-wide cost analysis of IT systems. CIMS Server enables enterprise-wide
cost analysis of IT systems. CIMS Server allows you to allocate, distribute, or charge
IT costs to users, cost centers, and organizations in a manner that is fair,
understandable, reproducible, and easy to administer.

m Centralized data processing. CIMS Server centralizes the processing of your
accounting data on one computer and allows you to view the data on the Web via
extensive customizable reporting features. It is possible to view both high-level and
detailed information with a few clicks of a mouse.

m Full data access and reporting capabilities. CIMS Server integrates Crystal Reports
with any ODBC-compliant database to give your enterprise full data access and
reporting capabilities.

System Features

CIMS Server features include:

B Report, spreadsheet, and graph generation and viewing via the Web

B Batch report generation as well as ad hoc reporting

m Crystal Reports integration

m Multi-level drill down capabilities to view detailed invoice and usage information
(including OS/390 data)

m Integration with CIMS Data Collectors for Windows, UNIX, Linux, Oracle, and
mainframe systems

m Up to 128-byte account code with powerful account code conversion

m Batch processing capabilities via Windows Script and defined Component Object
Model (COM) objects
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CIMS Data Collectors

CIMS Data Collectors are easy-to-use tools that enable you to easily collect and reformat
usage data from any system for input into CIMS Server. CIMS Data Collectors collect
usage data from your enterprise and convert it to an input format called the CIMS Server
Resource File. This file contains CIMS Server Resource Records and is used as input to
CIMS Server. (See CIMS Server Resource File on page B-2 for the CIMS Server Resource
Record format).

CIMS Data Collectors are available for the following platforms: Microsoft Windows,
UNIX, Linux , Oracle, and Mainframe Systems.

The CIMS Server installation includes the option of installing CIMS Data Collectors for
the Windows platform. (Contact CIMS Lab for licensing requirements.) These collectors
collect usage data from Windows operating systems, databases such as Microsoft SQL
Server, Oracle, and DB2, and applications such as Microsoft Exchange Server, IIS,
Windows Files Systems (NTES), and others. Refer to the CIMS Data Collectors for Microsoft
Windows Installation and User Guide for more information.

CIMS Server also accepts feeds from the CIMS UNIX and Mainframe collectors. For
information about these collectors, refer to the CIMS UNIX and mainframe
documentation.

CIMS Server System Components
The CIMS Server system is composed of the following components:
m The CIMS Server application server
m A database server
m A Web server

The following sections describe each of the CIMS Server system components.
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CIMS Server System Components

CIMS Server Application Server

B 1-6

The CIMS Server application server contains the following key components:

CIMS Processing Engine
CIMS Server Administrator

CIMS Server Web Reporting

CIMS Processing Engine

CIMS Processing Engine is a fast, efficient data processing engine capable of handling
large volumes of data. CIMS Processing Engine consists of multiple programs. The four
main programs are CIMSACCT, CIMSSORT, CIMSBILL, and CIMSAdminLib:

CIMSACCT processes the input sources provided by CIMS Data Collectors (see CIMS
Data Collectors on page 1-5) and performs functions such as account code conversion.
CIMSACCT produces an output file containing records that are properly formatted for
input into CIMSBILL.

CIMSSORT converts output from CIMSACCT and produces a sorted version that is
ready to be processed by CIMSBILL. CIMSSORT also combines multiple files into one
file. For example, you can use CIMSSORT to combine CIMSACCT output from three
different data input types into one file.

CIMSBILL processes the output from CIMSACCT and builds output files that contain
the billing information that is used to generate invoices and reports.

CIMSAdminLib contains the class CCIMSCBSLoad that loads the output files from
CIMSACCT and CIMSBILL into the CIMS Server database. CIMSAdminLib is the
central controlling library for all Windows-based CIMS Server functions. It contains
all the COM objects used to manipulate CIMS data.

For more information about CIMS Processing Engine, see Chapter 5, Processing Data.

With powerful data processing capabilities, CIMS Server provides all the data needed to
produce complete, detailed reports, spreadsheets, and graphs. The actual generation of
reports, however, is completed by Crystal Reports (see CIMS Server Web Reporting on

page 1-8).
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CIMS Server Administrator

CIMS Server System Components

CIMS Server Administrator is the administration tool for the CIMS Server system. This
Windows-based GUI application allows the system administrator and CIMS Server
administrators to configure and maintain the information contained in the CIMS Server
database such as rates, users and groups, clients, system configuration settings, and
processing and reporting settings. CIMS Server Administrator also enables
administrators to perform real-time processing.

ans CIMSServer, - CIMS Administrator
File Wiew Help

Server

£3 Chargeback Takle Maintenance
B Clients
[ Rate Codes
[ Rate Groups
B Table Manager
B Account Code Structure
B Calendar
= £3 Processing
[ Process Defintions
[ CPU Normalization
[ Conversion Builder
[ Event Viewer
B £3 Database Loading
B £3 System Administration
[l Select ODBC Data Source

Show Connection Information ==

DEX

Figure 1-2 « CIMS Server Administrator Main Window
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CIMS Server System Components
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The following table shows the administrative tasks performed by the system
administrator and the CIMS Server administrator.

System Administrator Tasks CIMS Server Administrator Tasks

B Defining and configuring the CIMS B Defining account code structures

Server database ) L )
m Creating and maintaining rate, client,

m Selecting the Open Database and calendar definitions

Connectivity (ODBC) data source )
m Defining CIMS Server users and groups

m Creating, adding, and dropping ) ) )
database tables B Setting reporting options

m Configuring the CIMS Server system

m Creating, adding, and dropping ;
settings

database objects

B Loading and exporting data to and

m Performing database backup f o datab
rom the database

procedures

m Defining and categorizing input W Setting processing options

sources m Executing processing jobs

m Scheduling input selection m Setting CIMSACCT and CIMSBILL
options

CIMS Server Web Reporting

Using Crystal Reports as the report writer, the CIMS Server Web Reporting application
provides chargeback and resource accounting reporting data to end users. This data is
available in the form of reports, spreadsheets, and graphs. When viewing an invoice (and
many other reports) the user can drill down within the data to view detailed
information.

CIMS Server Web Reporting users can set up their own list of favorite reports,
spreadsheets, and graphs.

CIMS Server includes standard reports that your Crystal Reports developer can use as
templates to create custom reports for your organization. These reports are referred to as
“custom reports” in this guide to differentiate them from the standard reports that are
provided with CIMS Server.

For more information about CIMS Server Web Reporting, including descriptions of the
standard reports that are provided with CIMS Server, refer to the CIMS Server Web
Reporting User’s Guide.
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Database Server

The database stores administration information as well as the Ident, Detail, and
Summary records that are produced by CIMS Processing Engine (see Chapter 5, Processing
Data, for more information about these records). These records are used by Crystal
Reports to provide robust Web reporting.

The Database Management System (DBMS) that you can use with CIMS Server depends
on the edition of CIMS Server that you are using as discussed in the following sections.

CIMS Server Enterprise Edition

If you are using CIMS Server Enterprise Edition, you can use either Microsoft SQL Server
2000 or 7.0 or MSDE 2000. MSDE 2000 is included with the CIMS Server installation.
However, the use of MSDE has some disadvantages as discussed in CIMS Server
Professional Edition.

Note * Supportis being added for other DBMS platforms such as Oracle and DB2 on
Unix and z/OS.

CIMS Server Professional Edition

CIMS Server Professional Edition requires MSDE 2000. The use of MSDE provides the
following advantages and disadvantages:

Advantages

® No additional cost—MSDE 2000 is included with the CIMS Server installation
m Easy upgrade path from MSDE to Microsoft SQL Server 2000

Disadvantages

m Limit of 2 GB of storage

m Limit of two processors per computer

B Limited administrative tool

Web Server

The Web server provides the components needed for CIMS Server Web Reporting: 1IS
and Crystal Reports.
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CIMS Server System Architecture Diagram

Figure 1-3 illustrates the relationship of the CIMS Server system components.
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Figure 1-3 « Architecture of the CIMS Server system
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Installing CIMS Server and
Getting Started

This chapter provides installation, configuration, and upgrade procedures for the CIMS
Server system. This chapter also provides a Getting Started section to help you to quickly
set up the system.

CIMS Server System COMPONENES .......vieiiiiutieiieineiereeneeseesencessessnsossennns 2-3
Suggested Software and Hardware ...........cociiiiiiiieieieiiieieencncnenesenecececncnss 2-3
Server Spedifications . . ... ... 2-4
Client Spedifications . . .. ... . 2-5
Pre-Installation SEtUP . ......oviuiiiiiiiiiiiiiiiiiiiiiiiiiiieieiietetererersssssnsnsncnsns 2-6
Third-Party Software Licensing Requirements ........... ... ... . i, 2-6
System Setup Checklist . . ... ... . 2-7
Internationalization Setup ... ... 2-9
Installing Crystal REPOIS .....vvineiiiiiiiiiiiiiieieieiiieiiieneneseseeesscesecnsncnenes 2-12
INStAlliNG CIMS SEIVEY . ..uvneninininieninieieieeeeseneseesesencacesescacasescscasescncans 2-13
Performing a New Installation or Upgrade ............. ... ... ... ... i, 2-13
Modifying an Existing Installation . ........ .. ... ... . 2-17
Getting Started .......ooiuiiiiiiiiiiiiiiiiiii ittt ittt ittt eiaaas 2-18
About the Configuration of Microsoft SQL Server and IIS

for the CIMS Server Web Reporting Web Site .......... .. .. .. it 2-18
Create aDatabase . ...... ... ... i 2-21
Set Up CIMS SeIVeI . .ot e e e e e 2-24
Increase the Event Viewer Maximum Log Size .......... ... . ... 2-34
SetUp the Web Server .. ... ... ... 2-35
Set Up CIMS Advanced Spreadsheets (Optional) .......... .. ..., 2-40
Start CIMS Server Web Reporting ... ... ..o i 2-44
TroubleshOOting . . ... .. i 2-45
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Moving and Resizing Dialog BOXES .......ovuiiiiiiiiiiiiieiieieieieieseseicesenencnens 2-45
Viewing Online Help ....ouvniniiiiiiiiiiiiiiiiiiiiiiiiiiiiietnteeiessessecncnsnsncnnns 2-45
Downloading Product Updates ............cooiiuiiiiiiiiiiiiiiiiiiiiiiiiiiienenennanns 2-46
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CIMS Server System Components

Note ¢ For an overview of the architecture of the CIMS Server system,
see Chapter 1, About CIMS Server.

The CIMS Server system is composed of the following hardware/software components:

m CIMS Server application server. Contains the CIMS Server application (includes the
Processing Engine, Administrator, and Web Reporting components).

m Database server. Contains Microsoft SQL Server 2000 or a similar DBMS.
m Web server. Contains Microsoft IIS and Crystal Reports.

You can install all components on one server or on separate servers. In general, a
configuration involving multiple servers might offer users superior performance.

In addition, the system might include multiple clients containing the CIMS Server
Administrator application, terminal emulation software such as Microsoft Terminal
Services, or both.

If you have questions regarding setting up and configuring the CIMS Server system for
your organization, contact CIMS Lab (see Contacting Technical Support on page 6-7).

Suggested Software and Hardware

CIMS Lab recognizes that different organizations have unique existing enterprise systems
in place. As a result, this section describes suggested specifications, not absolute, rigid system
requirements. It is possible that CIMS Server can be run on components not matching
these suggestions, although the system was developed with these specifications in mind.

If you have any questions regarding compatibility of your existing system with
CIMS Server, contact CIMS Lab.
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Suggested Software and Hardware

Server Specifications

H 24

The following are the suggested server specifications for the CIMS Server system. Note
that the hard drive, processor, and memory specifications reflect CIMS Server, the
database server, and the Web server on one computer.

m Microsoft Windows 2000 Server or Windows Server 2003 with the latest service pack

® Microsoft SQL Server 2000 with the latest service pack (SQL Server 7.0 is also
acceptable) or MSDE 2000 (see Database Server on page 1-9)

® Microsoft IIS 5.0 or later (included with Windows 2000 Server and Windows
Server 2003)

m Crystal Reports 9 Advanced Edition with Crystal Enterprise 9 Report Application
Server Edition (both provided by CIMS Lab, see Installing Crystal Reports on
page 2-12)

or
Crystal Reports Developer Edition 8.5
m Microsoft .NET Framework 1.1
m 80 GB available hard drive space, depending on particular data requirements
m 1 GHz processor or faster

B 1 GB of memory
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Client Specifications

The following sections provide the specifications for CIMS Server system and reporting
components installed on a client.

For Installing CIMS Server Administrator

CIMS Server Administrator is a Windows-based GUI application that enables
administrators to create and maintain the administrative and processing settings for
CIMS Server. Administrators can access CIMS Server Administrator remotely using
terminal emulation software to connect to the application on the server (recommended)
or directly by installing CIMS Server Administrator on a client.

The following are the suggested specifications for installation on a client:

m Microsoft Windows NT 4.0/2000/2003/XP with the latest service pack. Although not
recommended, it is also possible to use Windows 98.

B 40 MB available hard drive space
m 400 MHz processor or faster
m 128 MB of memory

You can also install and run CIMS Processing Engine on a client. However, if possible, it
is recommended that you run CIMS Processing Engine on the server using terminal
emulation software to connect to the engine.

For Designing Custom Reports

The following are the suggested specifications for computers used to design custom
Crystal reports for use with CIMS Server:

® Microsoft Windows 98/NT 4.0/2000/2003/XP
B 30 MB hard drive space minimum

m 128 MB of memory

For Viewing Reports

The following requirements apply to computers used to view reports in CIMS Server Web
Reporting:

m Internet Explorer 5.5 or later (if you are using Netscape Navigator, contact CIMS Lab
[see Contacting Technical Support on page 6-7]).

m Internet or network access with necessary security permissions
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Pre-Installation Setup

Before you install CIMS Server, you should review the following sections to make sure
that you have all required third-party software licenses and have your system set up
correctly (including set up for internationalization if needed).

Third-Party Software Licensing Requirements

In addition to licensing CIMS Server, your organization must obtain the appropriate
licenses for the following products. These products are integral to the CIMS Server
system:

m Microsoft SQL Server 2000 or 7.0 (note that this is not applicable if you are
using MSDE)

m Crystal Reports 9 Advanced Edition (CIMS Lab provides the appropriate licensing)

B Microsoft Windows 2000 Server or Windows Server 2003

Note ¢ Use of Crystal Reports may require specific licensing based on the number
and type of users. For more information or clarification about licensing issues,
contact CIMS Lab (see Contacting Technical Support on page 6-7).
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Pre-Installation Setup

Before installing CIMS Server, make sure that you have installed and configured the
components in the following list. Note that the Web server, database server, and CIMS
Server application server may be on one computer.

On the Web Server [

On the Database Server [ |

On the CIMS Server [ |
Application Server

CIMS Server Administrator's Guide

Windows 2000 Server or Windows Server 2003.

I1S 5.0 or later (included with Windows 2000 Server
and Windows Server 2003).

Crystal Reports 9 Advanced Edition with Crystal
Enterprise 9 Report Application Server Edition (both
provided by CIMS Lab) or Crystal Reports Developer
Edition 8.5.

See Installing Crystal Reports on page 2-12 for the steps
required to install Crystal Reports 9 for CIMS Server.

mOpen Web access (and FTP access if necessary).
Server must have Port 80 open for HTTP access by
other client computers in the organization.

Microsoft SQL Server 2000/7.0 or MSDE 2000.

Available SQL Server user ID (login) that has
permission to create tables, views, stored procedures,
and indices.

Windows 2000 Server or Windows Server 2003.
Microsoft .NET Framework 1.1.

You can install the .NET Framework during the
installation of CIMS Server (see page 2-15) or you
can download it from the Microsoft Web site, http://
v4.windowsupdate.microsoft.com/en/default.asp.

If you download the .NET Framework, on the
Windows Update page, click Pick updates to install
and then click your operating system. Microsoft .NET
Framework 1.1 appears in the Recommended
Updates list if it is not installed on your system.
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Pre-Installation Setup
On All Servers m Terminal emulation software such as Microsoft
Terminal Services or physical access to the server.

m Servers are connected to the network and are visible
to each other—preferably on the same Windows
domain.

m User has administrative access to the servers.

m File share enabled (preferred) or FTP access to all
servers.

m Ifz/OS is needed, FIP access from the servers to the
z/OS computer and vice versa.

On All Clients Accessing m Internet Explorer 5.5 or later.

CIMS Server Web Reporting

On All Clients Running B Administrative authority on the client to install CIMS
CIMS Server Administrator Server Administrator.

On All Clients Running m Authority for the client computer and client user ID

Terminal Emulation Software to access the servers via terminal emulation software.

Other Tasks m Obtain the CIMS Server license key provided by CIMS
Lab. You will need to enter the license key in CIMS
Server Administrator after installation.

If you do not have your license key, contact CIMS Lab
(see Contacting Technical Support on page 6-7).
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Internationalization Setup

You can localize the following features in CIMS Server to reflect the language required
for your organization (the default is US English).

m Date and numeric formatting (such as numbers and currency) that appear in:
e The CIMS Server Web Reporting Web site
e CIMS Server Administrator
e Reports

m Headers and footers that appear in reports

You cannot localize the text that appears in CIMS Server Administrator or the Help text
in CIMS Server Administrator and CIMS Server Web Reporting. In addition, it is not
recommended that you change the text that appears on the CIMS Server Web Reporting
Web site. Changing this text requires changes to the Active Server Pages (ASP’) and
JavaScript code that runs the Web site.

Setting Up Your System for Internationalization
The language used by CIMS Server is determined by the following settings:

m The regional settings for the Web site user.

m The regional settings for the user logged on to the server running CIMS Server
Administrator.

m The language specified for the database ODBC Data Source used by CIMS Server.
m The regional settings for the user using CIMS Server Web Reporting from a client.

The following sections provide the steps required to configure these settings for your
organization. In most cases, you will already have these settings set to the correct language.

Select the Web Site User’s Regional Settings on the Web Server

The date, time, and numeric formats shown in CIMS Server Web Reporting and reports
are dependent on the regional settings for the Web site user. When setting up the CIMS
Server Web Reporting Web site, you can choose one of the following users:

B An anonymous user (IUSR_computername, where computername is the name of the
computer running the CIMS Server Web Reporting Web site)

B A Windows authenticated user

For more information, see Set the User Authentication Method for the CIMS Server Web
Reporting Web Site on page 2-36.
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You need to set the regional settings for the user as follows:

1 Log on to the server as the user (either IUSR_computername or the Windows
authenticated user).

2 Click Start » Settings » Control Panel.
3 Double-click Regional Options.
The Regional Options dialog box appears.
4 On the General tab, click the language that you want from the list.

5 Click OK to save the change and close the dialog box.

Note * The regional settings change will not appear in the Web site or reports until
you restart IIS. (To restart IIS, see page 6-4.)

Select the CIMS Server Administrator User’s Regional Settings

You need to select the regional settings for the user logged on to the server running CIMS
Server Administrator. To select the regional settings for the user, follow the steps in Select
the Web Site User’s Regional Settings on the Web Server beginning with Step 2.

Select the Language for the ODBC Data Source

In the Windows ODBC Data Source Administrator, you need to select the language for
each ODBC Data Source used by CIMS Server. The steps for configuring a data source for
CIMS Server are provided in Select and Configure the Database As an ODBC Data Source
on page 2-24.

Note  The change to the language source will not appear in reports until you restart
I1S. (To restart IIS, see page 6-4.)

Select the CIMS Server Web Reporting User’s Regional Settings
on the Client

You need to set the correct regional setting for the user on each client that is using CIMS
Server Web Reporting. This enables Microsoft Excel to display dates, times, currency, and
numbers in the correct format when you view a report as a spreadsheet.

To select the regional settings for the user, follow the steps in Select the Web Site User’s
Regional Settings on the Web Server beginning with Step 2
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Change the Report Headers and Footers (Optional)

CIMS Server includes a variety of standard reports that you can use as templates to create
custom reports. These reports are in C:\Program Files\CIMSLab\Server\Reports\
Standard if you installed CIMS Server in the default location.You can change the headers
and footers that appear in these reports as follows:

1 In Crystal Reports, open the report that you want to change.
2 Right-click the text that you want to change, and then click Edit Text Option.

3 Save the report using the same file name in the Custom reports folder.
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Installing Crystal Reports

Installing Crystal Reports

H 2-12

Note ¢ The installation procedures in this section apply to Crystal Reports 9. For
information regarding installation of Crystal Reports 8.5, see page 6-8.

CIMS Lab provides Crystal Reports 9 Advanced Edition. This edition includes Crystal
Enterprise 9 Report Application Server Edition. You need to install both of these
components and Crystal Reports 9 Service Pack 2 in the following order:

1 Crystal Reports 9 Advanced Edition (provided on the CD labeled Crystal Reports)

2 Crystal Enterprise 9 Report Application Server Edition (provided on a separate CD
labeled Crystal Enterprise Report Application Server)

Note * Make sure that you install the Report Application Server Edition. Crystal
Reports 9 Advanced Edition also includes a Crystal Enterprise 9 Standard Edition
CD. Do not install the Standard Edition.

3 Crystal Reports 9 Service Pack 2

To install Crystal Reports 9 Advanced Edition:

1 Logon to Windows as a user in the Administrators group.
2 Do one of the following:

e Ifyou are installing from the installation CD, insert the Crystal Reports CD. If the
CD does not start automatically, browse to your CD-ROM drive and double-click
Setup.exe.

e Ifyou are installing from another location, for example from a network drive,
double-click Setup.exe.

3 Click Install and follow the instructions in the Installation Wizard. CIMS Lab
recommends that you select the Typical installation in the Select Installation Type
dialog box.

To install Crystal Enterprise 9 Report Application Server Edition:

Follow the same steps provided for installing Crystal Reports. However, install Crystal
Enterprise Report Application Server Edition rather than Crystal Reports. CIMS Lab
recommends that you select the Full installation in the Installation Type dialog box.

To install Crystal Reports 9 Service Pack 2:

Crystal Reports 9 Service Pack 2 is available on the CIMS Lab FTP site (ftp://
ftp.cimslab.com) and CIMS Product CD. The path on both the FTP site and CIMS
Product CD is CIMSServer\CrystalPatches\Crystal 9 Patches\cr90win_en_sp2.exe).

Double-click cr90win_en_sp?2.exe and follow the instructions in the InstallShield
wizard.
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Installing CIMS Server

This section describes the steps required to install CIMS Server. (Before you begin the
installation, make sure thatyou have installed and configured the components described
in System Setup Checklist on page 2-7.)

Note ¢ You can install the CIMS Server Administrator component of CIMS Server on
a client or clients (see Client Specifications on page 2-5) in addition to installation on
the server. You can also install CIMS Processing Engine on a client. However, if
possible, it is recommended that you install and CIMS Processing Engine on the
server.

To begin the CIMS Server installation:

1 Logon to Windows as a user in the Administrators group.
2 Click the Windows Start button, and then click Run.

3 Enter the path to the CIMS Server setup program (Setup. version&release.exe), and
then click OK. (The path depends on the location of the setup program, i.e., CIMS
Product CD, network drive, etc. For example, if you are installing from the CIMS
Product CD on drive D, the path is D: \CIMSServer\Setup. version&release.exe.)

4 Follow the steps provided in the InstallShield Wizard as described in the following
sections. The steps differ depending on whether you are performing a new
installation or modifying an existing installation.

Performing a New Installation or Upgrade

Follow the steps in the InstallShield Wizard to complete a new CIMS Server installation
or to upgrade to a new CIMS Server version or release.

Important! ¢ If you are performing an upgrade (not a new installation), you should
first back up the CIMS Server Collectors and Scripts folders. If you have made
changes to files in these folders and have not renamed these files, the files will be
overwritten when you upgrade to a new version or release of CIMS Server.

You should also confirm that your regular backup of the database and the folder that
contains your process definitions is working. This folder is referred to as Processes
in this guide.

Choose the Destination Location

Choose the default location for installation (C:\Program Files\CIMSLab) or click Browse
to choose another location. Click Next after making your selection.
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Select the Features That You Want to Install

Select the CIMS Server components that you want to install or clear the components that
you do not want to install. For a detailed description of these components, see Chapter 1,
About CIMS Server.

CIMS Administrator. This option installs CIMS Server Administrator. CIMS Server
Administrator is a graphical interface that enables you to create and maintain
administrative and processing settings.

CIMS Processing Engine. This option installs CIMS Processing Engine components
including CIMSACCT.d11, CIMSBILL.d11, CIMSSORT.d11, and CIMSAdminLib.d11. These
components process the CIMS Server Resource Files and load the output into the
CIMS Server database. This option also installs CIMS Aggregation Engine
(CIMSAggregation.d11) used by CIMS Data Collectors.

CIMS Web Reporting. This option installs the CIMS Server Web Reporting
component, which allows end users to view reports from a Web browser.

CIMS Web Reporting—Advanced Spreadsheets. This option installs a beta version
of CIMS Advanced Spreadsheets, an application for creating spreadsheet reports. For
more information about CIMS Advanced Spreadsheets, see Set Up CIMS Advanced
Spreadsheets (Optional) on page 2-40.

CIMS Advanced Spreadsheets is designed to work with a SQL Server database. If you
are using a MSDE database, contact CIMS Lab technical support for assistance (see
Contacting Technical Support on page 6-7).

Scripts. This option installs scripts that can be used to automate tasks in CIMS Server.
For example, scripts used by CIMS Data Collectors, scripts that enable batch
reporting, etc. For a description of these scripts, see Appendix C, Scripts.

CIMS Conversion Engine. This option installs CIMS Conversion Engine. CIMS
Conversion Engine is a utility that converts data collected by CIMS Universal Data
Collector and converts it into CIMS Server Resource Files. For more information
about CIMS Conversion Engine and the CIMS Universal Data Collector, refer to the
CIMS Data Collectors for Microsoft Windows Installation and User Guide.

CIMS Collectors & Processors. This option installs the collector and process
components of CIMS Data Collectors. These components enable you to gather usage
data from many different sources such as operating systems, databases, and
applications for input into CIMS Server.

By default, the CIMS Collectors & Processors check box is selected and all individual
collectors other than the Windows Print Usage collector are selected. CIMS Lab
recommends that you use the Windows Event Log collector to collect print usage
data.

To install individual collectors and processes, expand CIMS Collectors & Processors,
and then select the collectors that you want.
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m MSDE—Microsoft SQL Server 2000 Desktop Data Engine. This option installs
MSDE 2000. In a production environment, it is strongly recommended that you use
Microsoft SQL Server instead of MSDE to manage your database. However, in other
situations, MSDE might meet your requirements. For more information, see CIMS
Server Professional Edition on page 1-9.

Click Next after you have made your selections.

Select the Program Folder

Choose the program folder. Use the default (CIMS Server), type a new program folder
name, or select one from the list. Click Next when you are finished.

Start Copying Files

Click Next to begin copying program files to your system. If IIS is running, a message
appears asking you to confirm that is okay to shut down the program. Click Yes to quit
I1S. Note that the installer restarts IIS before finishing installation.

At this point, the remaining steps in the installation differ depending on the options that
you are installing and whether you have the Fujitsu COBOL Workstation Run-time
program installed (for example, you are upgrading to a new version or release of CIMS
Server and the Fujitsu Run-time is already installed).

If the CIMS Server installation setup is complete, follow the instructions in the Setup
Complete—Reboot Required dialog box, and then click Finish.

If you are prompted to install additional programs, continue to the next appropriate
section.

If you are prompted to enter an IIS Web user name, continue to Enter the I1S Web User
Name on page 2-17.

Install Fujitsu COBOL Workstation Run-time (If Applicable)

The InstallShield Wizard for the Fujitsu COBOL Workstation Run-time program
appears. This program is necessary for execution of the key processing programs
CIMSACCT and CIMSBILL. Click Next, and then click Install. When the installation is
complete, click Finish.

If the CIMS Server installation setup is complete, follow the instructions in the Setup
Complete—Reboot Required dialog box, and then click Finish. Otherwise, complete the
installation as described in the following steps.

Install Microsoft .NET Framework 1.1 (If Applicable)

If you have not installed Microsoft .NET Framework 1.1, you can install it at this point.
Follow the instructions in the Microsoft .NET Framework 1.1 Setup. Click OK when the
installation is complete.

Note ¢ If the message Files In Use appears during the installation, click Ignore. The
.NET Framework will continue to install.
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Install CIMS Windows Process Collector (If Applicable)

If you are installing the CIMS Windows Process collector and want to collect process
usage data from this server, you can install the executable and administrative programs
for the collector as shown in the following steps. If you do not want to collect process
data from this server, click Cancel and then click Yes.

Note ¢ The following instructions are also applicable if you are installing the
Windows Print Usage collector. By default, the Windows Print Usage collector option
is not selected and you will not be prompted to install the collector.

1 Accept the default selection for the collector, Service Collector, and then click Next.
Do not select the other components.

2 Choose the default location for installation (C:\Program Files\CIMSLab) or click
Browse to choose another location. Click Install after making your selection.

3 Click Close when the installation of the collector is complete.

4 If the CIMS Server installation setup is complete, follow the instructions in the Setup
Complete—Reboot Required dialog box, and then click Finish. Otherwise, complete
the InstallShield Wizard as described in the following steps.

CIMS Lab provides a separate setup program for installing the CIMS Windows Process
collector on other computers. For more information, refer to the CIMS Data Collectors for
Microsoft Windows Installation and User Guide.

Install CIMS Advanced Spreadsheets (If Applicable)

If you are installing CIMS Advanced Spreadsheets, the AdvSpreadSheets Setup Wizard
appears. Click Next and complete the wizard as follows:

1 Leave all options at the default settings.
2 Click Next and then click Next again to confirm the installation.

3 Click Close when the installation is complete.
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Enter the 1I1S Web User Name

There are two options for controlling user access to the CIMS Server Web Reporting Web
site: anonymous access and Windows authenticated access. Anonymous access allows
remote access by the IUSR_computername account. I1S user access is described in detail in
Set the User Authentication Method for the CIMS Server Web Reporting Web Site on

page 2-36.

The InstallShield Wizard allows you to enter the IUSR_computername. This name is used
for granting security permissions for CIMS Server folders as described in Assign CIMS
Server Folder Security Permissions on page 2-38.

In most situations, the IUSR_computername account that appears is correct and you can
click Next to continue. If you want to confirm that it is correct, follow the instructions in
To set anonymous access: on page 2-37 to locate the IUSR_computername. If the
IUSR_computername is not correct (for example, you changed your computer name after
installing IIS), you can change it here and then click Next.

If you do not enter the correct IUSR_computername here, you can assign the required
folder privileges manually (see page 2-38). A series of error messages will appear. Click
OK for each message.

Complete the Installation

Follow the instructions in the Setup Complete—Reboot Required dialog box, and then
click Finish.

Modifying an Existing Installation

Follow the steps in this section to modify an existing installation. For example, you have
already installed certain CIMS Data Collectors but now want to install others.

1 Start the InstallShield Wizard from the setup program or Windows Control Panel.
2 Click Moditfy, and then click Next.

3 Select the components that you want to install. (For a description of all components,
see Performing a New Installation or Upgrade on page 2-13.)

4 Follow the instructions presented in the wizard to complete the installation.
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This section takes you through the steps required to set up and use CIMS Server. You
should follow these steps in the order presented.

To help you to get started quickly, this section does not contain the detailed information
found in other chapters in this guide. Where applicable, references to more detailed
information are provided.

Before getting started, make sure that you have installed the system components
required by CIMS Server as shown in System Setup Checklist on page 2-7.

About the Configuration of Microsoft SQL Server and IIS
for the CIMS Server Web Reporting Web Site

The CIMS Server Web Reporting Web site is an ASP application that runs under I1S and
uses an SQL Server database. The database and IIS may be on one server or on separate
servers. To set up SQL Server and IIS for CIMS Server Web Reporting, you must configure
user access for both the SQL Server database and IIS.

The user access methods that you can use for the database and IIS are described in the
following sections.

SQL Server Database User Access

There are two options for controlling user access to the SQL Server database. These
options are set in SQL Server Enterprise Manager as described in Creating User Logins for
the Database on page 2-22.

m Windows authentication. Windows authentication verifies the database user using
the Windows user account.

m SQL Server authentication. SQL Server authentication verifies the database user
using the SQL Server login ID and password.

The user authentication method that you should use is dependent on the IIS and SQL
Server configuration for your organization as shown in Table 2-1on page 2-20.
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II1S Web Site User Access

There are two options for controlling user access to the CIMS Server Web Reporting Web
site. These options are set in Internet Information Services Manager as described in Set
the User Authentication Method for the CIMS Server Web Reporting Web Site on page 2-36.

B Anonymous access. Anonymous access allows remote access by the user ID
IUSR_computername. Users can connect to the CIMS Server Web Reporting Web site
without a Windows user name or password.

m Authenticated access. Authenticated access uses the current Windows user
information on the client computer to allow users to connect to the Web site.

If you are using a MSDE database, you need to use authenticated access.

If you are using a SQL Server 2000 database, you can use anonymous access or
authenticated access depending on the IIS and SQL Server configuration for your
organization as shown in Table 2-1on page 2-20.

Features Not Available with Anonymous Access

If you use anonymous access, you cannot use the auto log on feature for CIMS Server
Web Reporting. In addition, if you use anonymous access and are using the transaction
audit feature, the user ID associated with the transaction will not reflect the actual user
who made the change.

The auto log on feature enables end users to use CIMS Server Web Reporting without
entering a CIMS user ID and password on the Login page. To enable this feature, see Web
Settings on page 3-49.

The transaction audit feature enables CIMS Server administrators to track miscellaneous,
recurring, and credit transactions created in CIMS Server Web Reporting. (For more
information about transactions, refer to the CIMS Server Web Reporting User’s Guide). To
enable transaction audits and other audits such and client and rate, see Table Audit
Settings on page 3-53.
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User Access Requirements by IIS and SQL Server Configuration

The user authentication that you can use for IIS and the SQL Server database is
dependent on whether you have IIS and SQL Server running on one server or separate
servers and whether CIMS Server Web Reporting is running on an Internet or intranet
site.

An intranet site is accessible only to computers connected to an organization’s internal
network. An Internet site is accessible to all computers connected to the Internet.

Table 2-1 shows the allowed user authentication options by the different I1S and SQL
Server configurations your organization might have.

Required IIS Required SQL Server

IS and SQL Server Configuration User Authentication  User Authentication

IIS and SQL Server on the same Authenticated access Windows authentication
server. CIMS Server Web Reporting o
on an intranet site. r

Authenticated access SQL Server authentication
Or

Anonymous access  SQL Server authentication

1S and SQL Server on the separate Authenticated access SQL Server authentication
servers. CIMS Server Web O
Reporting on an intranet site. r

Anonymous access  SQL Server authentication

IIS and SQL Server on same or Anonymous access SQL Server authentication
separate servers. CIMS Server Web
Reporting on an Internet site.

Table 2-1 « 1IS and SQL Server User Authentication Requirements
The steps required to configure user access for the database and IIS are provided in the
following sections:

m Creating User Logins for the Database on page 2-22. Note that this is not required if you
are using an MSDE database.

m Select and Configure the Database As an ODBC Data Source on page 2-24.

m Set the User Authentication Method for the CIMS Server Web Reporting Web Site on
page 2-36.

It is important that review the information in these sections carefully to set the best user
access options for your organization.
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Create a Database

The following sections provide steps for creating a database in MSDE 2000 or Microsoft
SQL Server 2000.

Note * You can use more than one database with CIMS Server. For example, you
might have a production database and a development database. For more
information about creating multiple databases and configuring the databases as
ODBC data sources, see Chapter 4, Database Administration.

Creating an MSDE 2000 Database

When you install MSDE 2000, a default master database (master.mdf) is created. You can
use this database “as is”.

The master database is created in C:\Program Files\Microsoft SQL Server\MSSQL\Data
(if you installed CIMS Server, including MSDE, in the default location). You should
include the Data folder in your backup schedule.

Creating a Microsoft SQL Server 2000 Database

You can create a database using SQL Server Enterprise Manager or the OSQL or ISQL
command-line interface. The following are the steps needed to create a database using
Enterprise Manager:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » Computername » Databases.

3 Right-click the Databases folder, and then click New Database.

4 In the Database Properties dialog box, enter the configuration information for the
new database as follows:

¢ On the General tab, type a name for the database. The name CIMSServer is used in
this guide, but you can use any name.

e Unless you need to change the default settings for the database, you do not need
to reset values in the Data File or Transaction Log tabs.

5 Click OK when you are finished.
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Creating User Logins for the Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. After you create the database,
you need to create a database login for these users as described in To create a user login:
on page 2-23.

The user login includes the user authentication method for the database (Windows
authentication or SQL Server authentication). When creating a login, consider the
following when choosing the authentication method:

m 2-22

Windows authentication verifies the SQL Server user using the Windows user
account. If the user is the CIMS Server administrator, SQL Server uses the account on
the computer running CIMS Server Administrator.

SQL Server authentication verifies the user using the SQL Server login ID and
password. Using this authentication method, you could create a single login for all
CIMS Server administrators, a login for all CIMS Server Web Reporting end users, or
a login for both administrators and end users.

Note ¢ CIMS Server provides an optional table audit feature that enables you to
track changes that have been made to the data in certain database tables (see Tuble
Audit Settings on page 3-53). This information includes the user ID of the person
who made the change. If you use SQL Server authentication for multiple users,
you will not be able to identify the actual user who made the change.

You need to set up an ODBC data source for the database (see Select and Configure the
Database As an ODBC Data Source on page 2-24). If you have a database that has a
Windows authentication and SQL Server authentication login (for example, the CIMS
Server administrator uses Windows authentication and the CIMS Server Web
Reporting end users use SQL Server authentication), you need to create two data
sources.
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To create a user login:

Note * The following steps reflect creating a separate user login for CIMS Server
administrators and CIMS Server Web Reporting end users.

1 In the SQL Server Enterprise Manager, right-click the CIMSServer database.
2 Click New » Database User.
The Database User Properties—New User dialog box appears.
3 In the Login name box, click <new>.
The SQL Server Login Properties—New Login dialog box appears.
4 On the General tab, do the following:
¢ In the Name box, do one of the following:

¢ To use Windows user authentication, enter the user name. To browse for a user,

click the Browse button EI

» To use SQL Server user authentication, type a user login name, for example
CIMSAdmin or CIMSUser.

e In the Authentication area, click either Windows Authentication or SQL Server
Authentication. If you select SQL Server Authentication, type a password.

e In the Defaults area, enter the CIMSServer database in the Database box.

5 If you are creating a login for a CIMS Server administrator, on the Server Roles tab,
select the System Administrators check box.

6 On the Database Access tab, select the Permit check box for the CIMSServer database.
A list of database permits appears with the public check box selected.
7 Leave the public check box selected and do one of the following:

e Ifyou are creating a login for a CIMS Server administrator, select the db_owner
check box, and then click OK.

e Ifyou are creating a login for CIMS Server Web Reporting end users, select the
db_datareader and db_datawriter check boxes, and then click OK.

8 If you selected SQL Server authentication, in the Confirm Password dialog box, type
the login password again, and then click OK.

9 Click OK to close the SQL Server Login Properties—New Login dialog box, and then

click the Close button El to close the Database User Properties—New User dialog
box.

To confirm that the user login has been added, expand the database and click Users.
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m 2-24

Follow the steps in this section to set up CIMS Server.

Select and Configure the Database As an ODBC Data Source

Note ¢ If you are using MSDE, start CIMS Server Administrator

(Start » Programs » CIMS Server » Administrator if you installed CIMS Server in the
default location). Make sure that the default CIMSServer data source is selected and
click OK to close the Select ODBC Data Source dialog box. Keep CIMS Server
Administrator open, and continue to Initialize the Database on page 2-26.

To access the CIMSServer database, you need to select and configure the ODBC data
source for the database as follows:

Note ¢ If the database has a Windows authentication login and a SQL Server
authentication login (for example, the CIMS Server administrator uses Windows
authentication and the CIMS Server Web Reporting end users use SQL Server
authentication), you need to set up two data sources for the database.

1 Start CIMS Server Administrator (Start » Programs » CIMS Server » Administrator if
you installed CIMS Server in the default location).

The Select ODBC Data Source dialog box appears as shown in example Figure 2-1. (If
this box does not appear automatically, click Select ODBC Data Source.)

ans Select ODBC Data Source

Wigw

Machine: J

System Data Sources:

Data Source MName

Cl| (et

[ User Infa]

Uszer ID: Pazsword:

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 2-1 « Select ODBC Data Source Dialog Box
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2 Ifyou enabled SQL Server authentication for the database user login in Creating User
Logins for the Database on page 2-22, make sure that the CIMSServer data source is
selected and type the SQL Server user ID and password in the Login ID and Password
boxes. If you enabled Windows authentication, leave these boxes blank.

3 Double-click the CIMSServer data source.

4 The DSN configuration wizard appears. Follow the steps provided in the wizard to
point to the CIMSServer database. Consult your SQL Server DBA to determine the
settings that you should select in the wizard. Note the following:

¢ The wizard prompts you with the following: How should SQL Server verify the
authenticity of the login ID? Click the correct authentication method (Windows
or SQL Server). If you select SQL Server authentication, enter the SQL Server user
ID and password in the Login ID and Password boxes.

¢ For Internationalization Only. To select the language for the data source other
than the default language, select the Change Language of SQL Server Messages
to check box and click the language that you want from the list.

Important! « Do not select the Use regional settings when outputting currency,
numbers, dates, and times check box (the default for this check box is
unselected). CIMS Server does not support this option. Regional settings are
supplied by the regional options for the user logged on to the computer (see
Internationalization Setup on page 2-9).

5 When the wizard completes, click Test Data Source to make sure that the
configuration was successful, and then click OK until the wizard closes.

6 Click OK to close the Select ODBC Data Source dialog box. Keep CIMS Server
Administrator open and complete the steps shown in the following sections.

Using Data Source UIDs

If you created separate SQL Server database logins for the CIMS Server administrator and
CIMS Server Web Reporting end users in Creating User Logins for the Database on

page 2-22, you need to create a unique identifier (UID) for the database data source that
the Web end user will use to access the database. This may be the same data source used
by the administrator or a different data source as noted in Select and Configure the
Database As an ODBC Data Source on page 2-24. For more information, including the
steps required to create the UID, see Setting a Unique Identifier for an ODBC Data Source
on page 4-7.

CIMS Server Administrator's Guide 2-25 N



B Installing CIMS Server and Getting Started

Getting Started

Initialize the Database

Initializing the database performs the following tasks:

m Creates new database tables

m Populates these tables with an initial set of data

m Creates necessary database objects

Note ¢ Initializing the database should be performed only after installing CIMS
Server for the first time. Do not initialize the database after performing an upgrade—
initializing will overwrite your existing data.

To initialize the database:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Initialize Database.

The Database Initialization dialog box appears as shown in Figure 2-2.

=2 Database Initialization

Initialization Results:

Choose the 'Initialize Database' hutton to start.

Ohject Prefi |gpa.

i Initialize Databaze

Close |

Figure 2-2 - Database Initialization Dialog Box

CIMS Lab strongly recommends that you leave dbo. in the Object Prefix box. This
prefix sets the owner of CIMSServer database objects to dbo in SQL Server allowing any
authorized database user to view the objects. For more information about CIMS
Server database objects, see Chapter 4, Database Administration.

B 2-26
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2 Click Initialize Database to populate the database with the necessary defaults.

Note ¢ If the SQL Server user ID that you are using to access the database does not
have sufficient system administration authority, CIMS Server might not be able to
create database objects or to create objects with the appropriate permissions
during database initialization. In this situation, a warning message appears
recommending that you contact your database administrator or CIMS Lab before
continuing.

3 In the Select Crystal Reports Version dialog box, click the version of Crystal Reports
that you are using for Web reporting, and then click OK.

4 Click OK when the initialization is complete.

Create a Processes Folder

In Windows, rename and/or move the Sample Processes folder. This folder is in
C:\Program Files\CIMSLab if you installed CIMS Server in the default location.

CIMS Lab recommends that you rename this folder Processes and move it to a location
where you keep data. However, you can give this folder any name and move it to any
location. This folder is referred to as Processes in this guide.

The Processes folder is used to store process definitions. A process definition is a folder
that contains the files required to process usage data from a particular source such as a
database, operating system, or application. For more information about process
definitions, see CIMS Server Administrator Processing on page 5-17.

Note that the Processes folder contains sample process definitions. These process
definitions contain sample CIMS Server Resource Files that you can process and load
into the CIMSServer database. Process a Sample CIMS Server Resource File (Optional) on
page 2-33 provides the steps for processing these CIMS Server Resource Files.
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Enter CIMS Server Configuration Settings

You need to set the configuration settings for CIMS Server in CIMS Server Administrator.
To configure the settings:

1 In the main window, click System Administration » Configuration Information.

The Configuration dialog box appears.

2 For the purpose of getting started, complete the Organization, Processing,
Reporting, and License tabs as shown in the following sections. For information
about the remaining tabs, see Configuring System Settings on page 3-42.

Organization Tab

Enter your organization name and address (maximum of 255 characters in each line).

This information appears on the standard invoices that are provided with CIMS Server.

Processing Tab

In the Process Definition Path box, enter the path to the Processes folder as shown in
example Figure 2-3.

Wigw

Organization Processing l Reporting ] Database ] License ] Weh ] Aud'rting] Archiving ] Ciption List]

Path l Options] Closing]

Pracess Definition Path: |E:\Processes Browse ...

Reset To Defaultts

Figure 2-3 « Configuration Dialog Box—Processing Tab

For more information about the Processing tab, see Processing Settings on page 3-44.
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Reporting Tab

The Reporting tab contains the settings for CIMS Server Web Reporting. The Paths
subtab contains the paths to the following report folders:

m Standard. CIMS Server produces chargeback and resource accounting reports based
on IT usage data from your organization. This folder contains a variety of standard
reports that you can use as templates to create custom reports for your organization.
For a description of each of the standard reports, refer to the CIMS Server Web
Reporting User’s Guide.

m Custom. This folder contains custom reports. Custom reports are those that your
Crystal Reports developer creates either independently or from the standard reports.

m Published. This folder contains published reports. Once a report is generated, it can
be published. Publishing a report enables other CIMS Server Web Reporting users to
view the report with the data as it appeared at the time the report was generated.

m AdvSpreadsheets. This folder contains XML definition files for CIMS Advanced
Spreadsheets. The XML files for the standard advanced spreadsheets provided by
CIMS Lab are contained in the Standard subfolder. You can modify the standard XML
files to create custom speadsheets for your organization.

Note that if the CIMS Advanced Spreadsheets application is not installed, the
AdvSpreadsheets folder is not created and the folder path does not appear on the
Paths subtab.

CIMS Lab recommends that you keep the Standard and AdvSpreadsheets\Standard
folders in their default locations because standard reports and spreadsheets might be
updated and/or added with a new version or release of CIMS Server. (A list of new and
updated reports and spreadsheets is included in the release notes that accompany the
new CIMS Server version or release. You can also view all of the available standard
reports and spreadsheets at http://www.cimsserver.com.)

You can keep the Customand Published report folders in the default location or you can
rename and/or move the folders to any location. The reports in the Customand Pub1ished
report folders are not overwritten when you upgrade to a new version or release of CIMS
Server.

Enter the paths for storing your reports (or accept the default locations). Example
Figure 2-4 on page 2-30 shows the default locations if you installed CIMS Server in the
default location.
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Wigw

Organizaﬁon] Processing  Reporting l Database ] License ] Weh ] Aud'rting] Archiving ] Ciption List]

Paths l Options] Invaoice ]

Path to standard reports folder:

|C:\Pr0gram Filez\ZIMSLabiServer ReportsiStandardy
Path to custom reports folder:

|C:\Pr0gram Filez\ZIMSLab'ServerReportsiCustom,
Path to publizhed reports folder:

|C:\Pr0gram Filez\ZIMSLabiServer Reports'Published)
Path to Advanced Spreadsheets Install Folder:

|C:\Pr0gram Filez\ZIMSLabiServeribdvSpreadshest st

Browse...
Browse...
Browse...
Browse...

Reset To Defaultts

Figure 2-4 « Configuration Dialog Box—Reporting Tab

For more information about the Reporting tab, see Reporting Settings on page 3-45.
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License Tab

CIMS Server requires a license key that is provided by CIMS Lab. If you do not have your
license key, contact CIMS Lab (see Contacting Technical Support on page 6-7).

To enter licensing information:

1 Click the appropriate workstation (machine) and enter the license key as shown in
example Figure 2-5.

Wigw

Organizaﬁon] Processing ] Reporting ] Database License ]Web ] Aud'rting] Archiving ] Ciption List]

Machine: | (LOCAL) ﬂ

e [EEEEEEEEEEE

Expiration Date: 12i31/2004

Update License | Remove License

Reset To Defaultts

Figure 2-5 « Configuration Dialog Box—License Tab

2 Click Update License.
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Set the Account Code Structure

CIMS Server uses an account code to identify entities for billing and reporting. This code
determines how CIMS Server interprets and reports input data. The account code

structure defines the account code levels that appear on invoices and other reports. For
more information about defining account codes, see Setting Up the Account Code Structure
on page 3-3.

To define the account code structure:

1

Click Chargeback Administration » Chargeback Table Maintenance » Account

Code Structure.

The Account Code Structure List Maintenance dialog box appears.

Click Edit.

The Account Code Structure Maintenance dialog box appears.

Define your account codes (lengths and descriptions) as shown in example

Figure 2-6, and then click OK.

an5 Account Code Structure Maintenance

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Lewel Description Lencth Full Lencth
1| Company
2 | Divigion

3 Department

mow A R

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

Figure 2-6 « Account Code Structure Maintenance Dialog Box
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Process a Sample CIMS Server Resource File (Optional)

Note ¢ This is an optional step intended to provide a quick introduction to
processing CIMS Server Resource Files. For more information about processing CIMS
Server Resource Files, see Chapter 5, Processing Data.

The primary method for input into CIMS Server is the CIMS Server Resource File. If you
are using CIMS Data Collectors to collect usage data for input into CIMS Server, the
CIMS Server Resource File is created as part of the collection process.

CIMS Server includes sample CIMS Server Resource Files from different databases,
operating systems, and applications. The files are contained in process definition
subfolders within the Processes folder that you created in Create a Processes Folder on
page 2-27.

To process a sample CIMS Server Resource File:

1 Inthe CIMS Server Administrator main window, click Chargeback Administration »
Processing » Process Definitions.

The Process Definitions List Maintenance dialog box appears as shown in Figure 2-7.

@44 Process Definitions List Maintenance |:||E|g|

Wigw

efinitions

nEventlog
CIMSWinPrint
CISWinProcess
DBESpace
MSExchange
MSExchangehb
MSIS-ieh
MSSEL2000
Q5380
QOS380CICS
Q05390082
O53900isk
QOS380SMFE
Tranzactions
Universal
UnixDE2
UnixDB2Storage
UnixFS

UnixQORA

CProgram Files\CIMSLabiSample Processes)

A | Remave

Ediit | Rename Process |

Close

Figure 2-7 « Process Definitions List Maintenance Dialog Box

2 Click the process definition that contains the CIMS Server Resource File that you want
to process, and then click Process.
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3 If processing is successful, the data loads to the database and the Process CIMS was
successful message appears. Click Yes to view the event log (the Event Viewer appears
showing the files processed) or No to skip the event log.

To view the processing results, make sure that the process definition is selected, and then
click Edit. Click the Process Results tab to view the results. (For more information, see
Process Results Tab on page 5-31).

If You Are Installing CIMS Server on Multiple Computers

If you install CIMS Server components on multiple computers (server or client) and the
CIMS Server Administrator application on each computer points to the same database,
you should use Universal Naming Convention ([/NC) names for the Processes and
Reports folder path (see Enter CIMS Server Configuration Settings on page 2-28). The use
of logical drive names is not recommended when using multiple computers.

Note that if you are running CIMSACCT or CIMSBILL on a client and the database is on
a server, the data is stored in the database but physical processing occurs on your
computer. This can result in slower performance because large amounts of data need to
be transferred over the network during processing. Therefore, it is recommended that
you perform all CIMSACCT or CIMSBILL processing directly on the server using terminal
emulation software.

Increase the Event Viewer Maximum Log Size

H 2-34

CIMS Server logs all events (successful and unsuccessful) to the Windows Event Viewer.
To accommodate the large number of data loads generated by CIMS Server, you need to
increase the maximum log size in the Event Viewer as shown in the following steps.
(Note that these steps are for the Microsoft Windows Server 2000 operating system. If
you are using another operating system, refer to the Microsoft documentation if needed.)

1 In Windows, click Start » Settings » Control Panel.

2 Double-click Administrative Tools » Event Viewer.
The Event Viewer window appears.

3 Right-click Application, and then click Properties.
The Application Properties dialog box appears.

4 On the General tab, increase the Maximum log size to at least 16000 KB.

5 Choose one of the following options under When maximum log size is reached:
e Click Overwrite events older than and enter 45 days.

¢ Click Do not overwrite events. This option requires that you clear the log
manually rather than automatically when the log is full.

To avoid deleting older events, do not click Overwrite events as needed.

6 Click OK when you are finished.
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Set Up the Web Server

Follow the steps in this section to set up the Web server. The Web server may reside on
the same server as the CIMS Server application server or on a separate server. Note that
these steps are for I1S 5.1 on the Microsoft Windows 2000 Server operating system. If you
are using another operating system, refer to the Microsoft documentation or contact
CIMS Lab (see Contacting Technical Support on page 6-7).

Install CIMS Server Administrator and Web Reporting on the
Web Server (If Using a Separate Server)

Note ¢ If the Web server (IIS) resides on the same server as the CIMS Server
application server, skip this section.

If you are installing the Web server on a separate server than the CIMS Server application
server, you need to install the CIMS Server Administrator and CIMS Server Web
Reporting components on the Web server.

To install CIMS Server Administrator and CIMS Server Web Reporting, run the CIMS
Server setup program and choose the CIMS Administrator and CIMS Web Reporting
options (see Performing a New Installation or Upgrade on page 2-13).

When installation is complete, start CIMS Server Administrator, click Select ODBC Data
Source, and point to the CIMSServer database.

Set the Home Directory for the CIMS Server Web Reporting Web
Site

This section provides steps for setting the home directory for the CIMS Server Web
Reporting Web server. For further assistance, consult your IIS administrator.

1 Click Start » Settings » Control Panel.
2 Double-click Administrative Tools » Computer Management.

3 Double-click Services and Applications and navigate to Internet Information
Services » Default Web Site.

4 Right-click Default Web Site, and then click Properties.
The Default Web Site Properties dialog box appears.

5 Click the Home Directory tab (see Figure 2-8 on page 2-36).
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| Default Web Site Properties 2=l

Diirectory Security I HTTP Headers I Custom Errors | Server Extenzions I
‘wieb Site I Operators I Performance I IS4P Filters  Home Directory | Documents
‘wihen connecting to this resource, the content should come from:
& & directory located on this computer
" & share located on another computer
A redirection to a URL

Local Path: C:\Program Files\CIMSLab\Serverwieb Browse... |

™ Script source access V' Log visits
¥ Read ¥ Imdes this resource
[~ white

[ Directary browsing

Application Settings

Application name: IDefauIt Application Femove |
Starting point: <Default ‘Web Site>

Configuratian... |
E=ecute Permissions: IScripts only hd
Application Pratection: IMedium [Pooled) j Uniaad |

QK I Cancel | Apply | Help |

Figure 2-8 « Default Web Site Properties Dialog Box—Home Directory Tab

6 Enter the CIMS Server Web Reporting path in the Local Path box (or accept the
default), and then click Apply. If you installed CIMS Server in the default location,
the location is C:\Program Files\CIMSLab\Server\Web. You can also enter a UNC
name (\\Servername\Sharename).

7 Leave the Default Web Site Properties dialog box open and continue to the next
section.

Set the User Authentication Method for the CIMS Server Web
Reporting Web Site

There are two options for controlling user access to the CIMS Server Web Reporting Web
site: anonymous access and authenticated access. Anonymous access allows remote
access by the IUSR_computername account. Users can connect to the CIMS Server Web
Reporting Web site without a user name or password. Authenticated access uses the
current Windows user information on the client computer to allow users to connect to
the Web site.

If you are using a MSDE database, you need to use authenticated access.

If you are using a SQL Server 2000 database, you can use anonymous access Or
authenticated access depending on the IIS and SQL Server configuration for your
organization as shown in Table 2-1on page 2-20.

If you use anonymous access and are using the transaction audit feature, the user ID
associated with the transaction will not reflect the actual user who made the change.

The auto log on feature enables end users to use CIMS Server Web Reporting without
entering a CIMS user ID and password on the Login page. To enable this feature, see Web
Settings on page 3-49.
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The transaction audit feature enables CIMS Server administrators to track miscellaneous,
recurring, and credit transactions created in CIMS Server Web Reporting. (For more
information about transactions, refer to the CIMS Server Web Reporting User’s Guide). To
enable this feature, see Table Audit Settings on page 3-53.

The following sections provide the steps required to enable both authentication types.
To set anonymous access:
1 In the Default Web Site Properties dialog box, click the Directory Security tab.

2 In the Anonymous access and authentication control area click Edit. The
Authentication Methods dialog box appears

3 Click the Anonymous access check box and clear all other check boxes.
4 Click Edit and do the following in the Anonymous User Account dialog box:

e If IUSR_computername appears in the Username box, click OK (see Figure 2-9). If
the TUSR name does not appear, click Browse to find the name.

e Select the Allow IIS to control password check box. CIMS Lab recommends this
option because it enables IIS to change the password for each access to the CIMS
Server Web Reporting Web site.

Anonymous User Account ' ﬂ

Anonymous Uzer

Select the Windows Uszer Account used to access this computer when an
anonymous uger connects to this site.

Usermame: IIUSH_computemameI Browse... |

Bassword: I xxxxxxxxxx

¥ &llow 115 to control password

QK I Cancel | Help |

Figure 2-9 « Anonymous User Account Dialog Box

5 Click OK until the Default Web Site Properties dialog box closes.

6 Restart IIS (see page 6-4).

To set authenticated access:

1 In the Default Web Site Properties dialog box, click the Directory Security tab.

2 In the Anonymous access and authentication control area click Edit. The
Authentication Methods dialog box appears

3 Select the Integrated Windows authentication check box and clear all other check
boxes.

4 Click OK until the Default Web Site Properties dialog box closes.

5 Restart IIS (see page 6-4).
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Assign CIMS Server Folder Security Permissions

The CIMS Server Web Reporting users must have the following security permissions for
the CIMS Server folders shown. If you installed CIMS Server in the default location, the
folders are in C:\Program Files\CIMSLab.

Folder Required Permissions

Server Read & Execute
Server/Web/temp Full Control
Server/Reports/Published Read & Execute, Write

If you selected anonymous access for I1IS on page page 2-37, the user is
IUSR_computername and that user name must be provided with these permissions. If you
selected Windows authenticated access, each Windows user that will be accessing the
CIMS Server Web Reporting Web site must be provided with these permissions.

Note ¢ If the user is IUSR_computername and you entered the correct
IUSR_computername account during installation, CIMS Server automatically sets the
folder security permissions for the user. See Enter the [IS Web User Name on page 2-17.
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Enable Secure Sockets Layer (SSL) for the
CIMS Server Web Reporting Web Site (Optional)

CIMS Server provides an optional auto log on feature that enables users to access the
CIMS Server Web Reporting Web site without entering a user ID and password (see
page 3-49). If you use this feature, Secure Sockets Layer (SSL) is not needed.

If you do not use the auto log on feature, you can enable SSL to protect the user ID and
password needed to access the Web site. SSL is a protocol for ensuring security and
privacy in internet communications via encryption. When SSL is enabled, https://
rather than http:// appears in the URL when a user accesses the Login page of the CIMS
Server Web Reporting Web site.

To set up and enable SSL for the Web site, you need to first obtain a SSL certificate from
a third-party certificate authority and install the certificate for the site. For the steps
required to obtain and install the certificate, refer to the Microsoft Knowledge Base
Article—298805.

Once you have installed the SSL certificate, complete the following steps to enable SSL
for the login ID and password and then restart IIS. (To restart IIS, see page 6-4.)

In the 1IS Manager Window:

1 Navigate to Default Web Site and expand it.

2 Right-click the Secure folder, and then click Properties.

3 On the Directory Security tab, click Edit in the Secure communications area.

4 In the Secure Communications dialog box, select the Require secure channel (SSL)
check box, and then click OK.

In CIMS Server Administrator:

1 Click System Administration » Configuration Information » Web tab » General
subtab.

2 Select the Secure Login check box.

3 Ifyou are using an SSL port other than the default port 443 for the Web site, type the
port number in the Secure Port check box.

4 Click OK when you are finished.
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Set Up CIMS Advanced Spreadsheets (Optional)

N 2-40

Note ¢ If you did not install CIMS Advanced Spreadsheets, skip this section.

CIMS Server includes a variety of standard spreadsheets that are created in Crystal
Reports. In addition to these standard spreadsheets, which are installed by default, you
can choose to install CIMS Advanced Spreadsheets.

The CIMS Advanced Spreadsheets application enables you to build spreadsheets without
Crystal Reports. These spreadsheets have more advanced features such as drilldown and
sorting. CIMS Advanced Spreadsheets uses the Microsoft .NET Framework. CIMS
Advanced Spreadsheets is described in detail in the CIMS Server Web Reporting User’s
Guide.

Note * CIMS Advanced Spreadsheets is designed to work with a SQL Server database.
If you are using a MSDE database, contact CIMS Lab technical support for assistance
(see Contacting Technical Support on page 6-7).

To enable CIMS Advanced Spreadsheets, you need to do the following:

m Install CIMS Advanced Spreadsheets during the CIMS Server installation or as a
separate install (see To Install CIMS Advanced Spreadsheets As a Stand-Alone Application
(Optional) on page 2-43). The following sections assume that you installed CIMS
Advanced Spreadsheets when you installed CIMS CIMS Server.

m Follow the steps in this section to set up CIMS Advanced Spreadsheets.

m Enable CIMS Advanced Spreadsheets in the CIMS Server Administrator Configuration
dialog box (see Options Subtab on page 3-46).

Create an 1IS Application for Advanced Spreadsheets

Note ¢ The following steps are for IIS 5.1 on the Microsoft Windows 2000 Server
operating system. If you are using another operating system, refer to the Microsoft
documentation or contact CIMS Lab (see Contacting Technical Support on page 6-7).

—)

Click Start » Settings » Control Panel.
2 Double-click Administrative Tools » Computer Management.

3 Double-click Services and Applications and navigate to Internet Information
Services » Default Web Site.

4 Expand Default Web Site.
5 Right-click the AdvSpreadsheets folder, and then click Properties.
The AdvSpreadsheets Properties dialog box appears.

6 On the Directory tab, click Create and then click OK.
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Create a SQL Server Login for the ASPNET User (If You Are Using
Windows Authentication)

Note ¢ If you are using SQL Server authentication for the CIMSServer database, the
following steps are not required. Continue to Set Up Folder Permissions on page 2-42.

Microsoft .NET pages run under the computername/ASPNET login by default, where
computername is the name of the computer running SQL Server. If you are using Windows
authentication for the CIMSServer database, add the computername/ASPNET user to the
database as follows:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » Computername » Databases.

3 Expand Databases.

4 Right click the CIMSServer database, and then click New » Database User.
The Database User Properties—New User dialog box appears.

5 In the Login name box, click <new>.
The SQL Server Login Properties—New Login dialog box appears.

6 On the General tab, do the following:

e Enter the computername/ASPNET user in the Name box. To browse for the user, click

the Browse button I:I
e In the Defaults area, enter the CIMSServer database in the Database box.
7 On the Database Access tab, select the Permit check box for the CIMSServer database.
A list of database permits appears with the public check box selected.

8 Leave the public check box selected, select the db_owner check box, and then click
OK.

9 Click OK to close the SQL Server Login Properties—New Login dialog box, and then

click the Close button El to close the Database User Properties—New User dialog
box.
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Set Up Folder Permissions

The CIMS Advanced Spreadsheets application must have permission to write and modify
the AdvSpreadsheets folder. This folder is in C:\Program Files\CIMSLab\Server\Web if
you installed CIMS Server in the default location. To assign the required permissions:

1 Right-click the AdvSpreadsheets folder, and then click Properties.
The AdvSpreadsheets Properties dialog box appears.
2 On the Security tab, click Add.

3 Type computername\ASPNET, where computernameis the name of the computer running
the CIMS Server Web Reporting Web site, and then click OK.

4 Click the Full Control check box for the user.

5 Click OK when you are finished.

Set Folder Location (If Not the Default Location)

Note ¢ If you installed CIMS Advanced Spreadsheets in the default location
(C:\Program Files\CIMSLab\Server\Web\AdvSpreadsheets), the following steps are not
required.

1 In the AdvSpreadsheets folder, open the Web.config file in any text editor.
2 Under <appSettings>, change the spreadsheetlocation key value to the correct path.

3 Save the updated file and restart IIS. (To restart IIS, see page 6-4).

Set Up Internationalization (Optional)

You can localize CIMS Advanced Spreadsheets to reflect culture-specific information for
your organization as follows:

1 In the AdvSpreadsheets folder, open the Web.config file in any text editor.

2 Under <appSettings>, change the charset key value to the applicable code. The
default is en-us (US English).

The Microsoft Web site contains a list of valid codes ( http://msdn.microsoft.com/
library/default.asp?url=/library/en-us/cpref/html/frlrfSystemGlobalizationCulture
InfoClassTopic.asp).

3 Save the updated file and restart IIS. (To restart IIS, see page 6-4).
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To Install CIMS Advanced Spreadsheets As a Stand-Alone
Application (Optional)

If you installed CIMS Server in the default location, the CIMS Advanced Spreadsheets
install program, CIMSSpreadsheet.ms1, is in C:\Program Files\CIMSLab\Server\
AdvSpreadsheets.

The following are the suggested system specifications for the stand-alone CIMS
Advanced Spreadsheets application:

m Microsoft Windows 2000 Server or Windows Server 2003 with the latest service pack

® Microsoft SQL Server 2000 with the latest service pack (SQL Server 7.0 is also
acceptable)

B Microsoft .NET Framework 1.1

To install CIMS Advanced Spreadsheets as a stand-alone application:
1 Logon to Windows as a user in the Administrators group.

2 Click the Windows Start button, and then click Run.

3 Enter the path to the CIMS Advanced Spreadsheets install program,
CIMSSpreadsheet.msi, and then click OK.

4 Follow the steps provided in the install wizard.
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Start CIMS Server Web Reporting

1 Inthe Web browser, enter the URL for the server running CIMS Server Web Reporting.
This is the server that you set up in Set Up the Web Server on page 2-35. If you are
running the browser on the same computer as the Web server, enter the URL http:/
/localhost.

2 Click Login to open the Login page.

3 Typetheuser ID adminand the password password, and then click OK. This is a default
user and password created by CIMS Server (see About Users and Groups on page 2-45).

Note * You can enable the auto log on feature that allows users to access CIMS
Server Web Reporting without entering a user ID and password. For more
information, see page 3-49.

If you have successfully loaded sample data from the Processes folder, you should be
able to create reports from the Reports » Run Reports menu (see Figure 2-10). For
instructions, refer to the CIMS Server Web Reporting User’s Guide.

<A http:/localhost/TReports.asp?select=1 - Microsoft Internet Explorer,

File Edit View Favorites Tools  Help

@Back @ _) \ﬂ @ ih /'f__j Search ‘ip;/Favorites @Media @ ﬁ}{v :_\', E @ .‘3

Address @ http: fflocalhostf TReports, aspPselect=1

CIMS

Server

Login Spreadsheets Favorites Admin Help Logout Home

RepO Vie‘bPuhlished Reports

Create a Report

Invoices

Account Reports
Top Usage Reports
Yariance Reports
Trend

Resource Detail
Audit

Other

&) TReparts.asprselect=1

Figure 2-10 « CIMS Server Web Reporting—Reports Menu
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Moving and Resizing Dialog Boxes

Note * You can select the Crystal Report viewer that you want to use to view reports.
When you install CIMS Server, the default viewer is HTML (see Web Settings on
page 3-49).

If you select the ActiveX or Java viewer, you will receive a warning message asking if
you want to install and run Crystal Smart Viewer for ActiveX or Java when you
attempt to run a report after installing CIMS Server for the first time. Click Yes. It is
also advisable that you select the Always trust content from Crystal Decisions, Inc
check box.

About Users and Groups

A user is an individual with access rights to CIMS Server Web Reporting. Each user can
belong to only one user group. Users are granted the rights and privileges granted to the
group. This system of users and groups allows you to control which reports a user can
access, the clients that the user can view in reports, and the administrative privileges for
the user.

When you initialized the database (see page 2-26), CIMS Server added the default
administrator user admin that belongs to the user group Admin. The group Admin has
administrative privileges in CIMS Server Web Reporting and can view all reports and
clients.

For instructions on how to create users and groups, see Working with Users and Groups on
page 3-25.

Troubleshooting

For troubleshooting information, see Chapter 6, Troubleshooting and
Additional Information.

Moving and Resizing Dialog Boxes

You can the move and resize the dialog boxes in CIMS Server Administrator. To move a
dialog box, simply drag the box. To resize the box, point to the horizontal or vertical edge
of the box. When the double arrow appears, click the edge of the box and drag it to the
size that you want.

To return a dialog box to its original position and size, click View » Reset Form Position
to Default where this command is available. Where this command is not available, the
dialog box returns to its original location and size when it is closed and reopened.

Viewing Online Help

To view context-sensitive online help in CIMS Server Administrator, press <F1>.
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Downloading Product Updates

You can download product updates by visiting the CIMS Lab Web site (http://
www.cimslab.com) and clicking Customer Area » Product Updates. Note thatyou need
to provide your CIMS Server license key as a password.
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Setting Up the System

This chapter describes how to use CIMS Server Administrator to set up the CIMS Server
system, including defining the account code structure, entering rates and rate groups,
creating users and groups, and setting reporting options.

Setting Up the Account Code Structure .......oouvviiiiiiiiiiiiiiieiiieieeiencieeeenenenens 3-3
Account Code Structure Example . ... e 3-3
Defining the Account Code Structure .......... ... i e 3-4
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Setting Up the Account Code Structure

CIMS Server uses an account code to identify entities for billing and reporting. This code
determines how CIMS Server interprets and reports input data.

One of the first steps in implementing CIMS Server is defining the account code
structure. This structure defines the account code levels that appear on invoices and other
reports.

For more information about account codes, see Setting Up Account Codes and Performing
Account Code Conversion on page 5-33.

Account Code Structure Example

An account code can contain up to 128 bytes. The structure of the account code reflects
the chargeback hierarchy for your organization arranged from highest to lowest level
(e.g., company, division, department). You can define as many account code levels as
necessary within the maximum available 128-byte field length.

For example, the following 17-byte account code contains four levels:

AABBBBCCCDDDDDDDD

Level 1, AA
Full Length = 2 bytes
Description = Company

Level 2, AABBBB
Full Length = 6 bytes
Description = Division

Level 3, AABBBBCCC
Full Length = 9 bytes
Description = Department

Level 4, AABBBBCCCDDDDDDDD
Full Length = 17 bytes
Description = User

To see how you would define this account code for CIMS Server, see Figure 3-3 on
page 3-6.
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Defining the Account Code Structure

CIMS Server includes a default account code structure called Standard. Use this structure
to define your account code.

If you need to create additional account code structures for reporting, see Defining
Alternate Account Code Structures on page 3-8.

To create account code levels:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Account Code Structure.

The Account Code Structure List Maintenance dialog box appears as shown in
Figure 3-1.

an5 Account Code Structure List Maintenance

Wigw

Account Code Structure

A | Remave | Ediit | Rename

Figure 3-1 « Account Code Structure List Maintenance Dialog Box
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2 Click Edit.

Setting Up the Account Code Structure

The Account Code Structure Maintenance dialog box appears as shown in Figure 3-2.

an5 Account Code Structure Maintenance

- B

Account Code Structure: Standard

Define Account Code Levels

Starting Offzet into Account Code: 1

Lewel Description
1|Level1
2|Level 2
3|Level 3

4|Level 4

Full Lencth

Adld Entry | RemoveEntry| In=ert Entry |

Cancel |

g
16
32
G4

Figure 3-2 « Account Code Structure Maintenance Dialog Box

3 In the Starting Offset into Account Code box, accept the default to begin reporting
from the first account code level or enter another starting position to begin reporting
at another level (see To set the starting offset number: on page 3-7).

4 Inthe Description and Length boxes, edit the sample description and length for each
level of the account code (maximum of 128 levels where each level is a length of 1).
To add a level to the end of the account code structure, click Add Entry. To add a level
above an existing level, click the level, and then click Insert Entry.

For example, the account codes structure shown in Account Code Structure Example on
page 3-3 is entered as shown in Figure 3-3 on page 3-6.
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an5 Account Code Structure Maintenance

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Lewel Description Lencth Full Lencth
1| Company
2 | Divigion
3 Department

2
4
3
g

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

Figure 3-3 « Example Account Code Structure

Note the difference between the length and full length. The length is the number of
bytes representing the specific entity. For example, the 4-byte BBBB in Level 2
represents the division.

The full length is automatically calculated and represents the total number of bytes
for the level. For example, Level 2 includes 2 bytes for the company and 4 bytes for
the division for a total of 6 bytes.

5 Click OK when you are finished.
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To set the starting offset number:

The starting offset number determines the account code levels that are presented in
reports. If you want to begin reporting from a level other than Level 1, enter the offset
position for the level at which you want to begin reporting.

For example, if you have two user groups and one group wants to begin reporting at the
User level shown in Figure 3-3 on page 3-6, you could set up a second account code
structure with one level for User and an offset of 10 (the position where the User level
begins in the account code structure) as shown in Figure 3-4.

an5 Account Code Structure Maintenance

Account Code Structure: Group B
Starting Offzet into Account Code: 10

Define Account Code Levels

Lewel Description Lencth Full Lencth
1 |Uszer g g

Adld Entry | RemoveEntry| In=ert Entry |

Figure 3-4 « Adding a Second Account Code Structure with Different Starting Offset

Note that in this situation, users in groups using this account code structure cannot view
any report levels other than User in CIMS Server Web Reporting (see Working with Reports
on page 3-34). To avoid this restriction, you could create a report for the User level in
Crystal Reports rather than create an additional account code structure. For more
information, contact CIMS Lab (see Contacting Technical Support on page 6-7).

To remove an account code level:

Click the level, and then click Remove Entry.
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Defining Alternate Account Code Structures

H 3-8

If needed, you can create additional account code structures. For example, you may need
account codes with different levels or different offset positions.

Note ° If you have alternate account code structures, you need to choose the correct
structure when you create CIMS Server user groups. The account code structure
defaults to Standard (see Working with Reports on page 3-34).

To add an alternate account code structure:

1

6

In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Account Code Structure.

The Account Code Structure List Maintenance dialog box appears.
Click Add.

In the Add Account Code Structure dialog box, enter the name of the new account
code structure (maximum of 32 characters), and then click OK.

The Account Code Structure Maintenance dialog box appears.

In the Starting Offset into Account Code box, accept the default or enter a starting
offset number (see To set the starting offset number: on page 3-7).

Click Add Entry to add each level. (To add a level above an existing level, click the
level, and then click Insert Entry).

Click OK when you are finished.

To rename an alternate account code structure:

1

2

Click the structure, and then click Rename.

In the Change Account Code Structure Name dialog box, enter the new name of the
account code structure, and then click OK.

To remove an alternate account code structure:

Click the structure, and then click Remove.
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Working with Rates

CIMS Server uses a rate to calculate a cost for each resource being reported. Rates are
organized by rate codes, tables, and groups as described in the following sections.

Defining Rate Codes

The rate code represents the resource units being reported (e.g., CPU time, transactions
processed, or lines printed). The rate code includes the value for the resource and other
rate processing information.

Rate codes are contained in rate tables. CIMS Server includes a default STANDARD table
that contains sample rate codes. You can modify, delete, or add rate codes in this table
to reflect the rate codes in your CIMS Server Resource Files. You can also create

additional tables for differential costing (see Defining Alternate Rate Tables on page 3-13).

Each rate code belongs to one rate group. Rate groups are logical groups that are used for
grouping resources on invoices and other reports and for drill down (detailed) reporting.
For more information about rate groups, see Defining Rate Groups on page 3-14.

To add a rate code:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

The Rate Code List Maintenance dialog box appears.

2 If the Rate Table list contains multiple tables, click the rate table that you want to add
the rate to. (If there are multiple tables, All appears in the Rate Table list by default.)

3 Click Add Rate.

4 In the Add New Rate Code dialog box, enter the new rate code (maximum of eight
characters), and then click OK.

The Rate Code Maintenance dialog box appears as shown in example Figure 3-5 on
page 3-10.
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@75 Rate Code Maintenance

[ STANDARD f Z003 ]
[ General |

Deseription:  |03/330 Cpu Mintes

Walue: o0 Rate Index:  |g
Rate Group: | Baten - Add rate group ..

[ Detsil |

™ Use 4 decimals for rate Resource Conversion: |pividge By B0 =
[ Rate iz per thousand Conversion Factor:
™ Do not adjust for zero cost Resource Decimals: 2 =

[ Flat fee money charges
v CPU Value Report Flag 1: |1—
Report Flag 2: |—

Comments: |

Rate Shift Maintenance Ok | Cancel

Figure 3-5 « Rate Code Maintenance Dialog Box

5 Edit the rate code settings as follows:

e Description. Enter a meaningful description of the rate code (maximum of 40
characters). The description appears on reports, graphs, and spreadsheets.

e Value. Enter the amount to be charged for the consumption of the resource
represented by this rate code. Keep in mind:

» Rate value corresponds to the specified rate code.

Note ¢ The following currency values are for example purposes only. CIMS
Server supports all currencies.

e $25 isinput as 25.

e $1.25is inputas 1.25.

* Negative values are preceded by a minus (e.g., -1).
* Maximum Rate is 9999999v99999999.

e The value is multiplied by the resource amount contained in matching CIMS
Server Resource Files. For example, if the rate code value is 25 and a matching
resource file contains a value of 5 hours, then the total charge would be $125.

e Rate Index. The rate index defaults to the order in which the rate code appears in
reports. You can change the order; however, you cannot enter an index number
that is already in use.
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e Rate Group. Click the rate group for the rate code or click Add rate group to create
a new rate group. All rate codes must be assigned to a group.

Note * You can also create rate groups and assign rate codes using the Rate
Group Maintenance dialog box (see Defining Rate Groups on page 3-14).

e Use 4 decimals for rate. This option determines the number of decimal digits that
appear in the rate value in reports. If this check box is selected, the rate value
includes four decimal digits. If this check box is not selected, the rate value
includes eight decimal digits.

e Rate is per thousand. Select this check box to change the rate in reports from per
resource unit to per thousand units.

* Do not adjust for zero cost. Select this check box if you do not want the associated
rate code to be included in zero cost calculations.

About Zero Costing

It is possible within CIMS Server Web Reporting to enter a target recovery amount
for the billing period. (See the CIMS Server Web Reporting User’s Guide for
information about the CIMS Server Zero Cost Center Invoice). CIMS Server then
makes the appropriate adjustments to recover the targeted amount rather than the
amount reflected by the standard multiplication of rate by resource units. This
zero costing allows IT departments to recover a specified amount each billing
period rather than show a profit or loss.

It is not always desirable to apply zero costing to all rates. Often, fixed cost items
such as leased line charges, delivery services, or license fees are excluded from zero
costing. The cost of these items is used as part of the overall calculation, but the
specific rate is not adjusted.

» Flat fee money charges. Select this check box if the resource units for the rate code
are considered a monetary amount rather than units if utilization. When this check
box is selected, the rate value entered in the Value box is ignored.

e CPU Value. Select this check box to normalize CPU usage for this rate (see
Normalizing CPU Values on page 5-49).

e Resource Conversion. You can adjust the total resource units value in reports
using the following conversion factors:

e Default. No conversion is performed.

e Divide By or Multiply By. The total resource units are divided or multiplied by
a set conversion factor (e.g., Divide by 1000, Multiply by 60, etc.).

e Multiply By Conversion Factor. The total resource units are multiplied by the
factor in the Conversion Factor box.
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e Conversion Factor. This box is available only when Multiply By Conversion
Factor is selected in the Resource Conversion box. Type a number by which you
would like to multiply the total resource units for the rate code. This factor can be
up to 16 digits including a decimal.

¢ Resource Decimals. This option determines the number of decimal digits that
appear in the resource units value in reports (e.g., 0= 99, 4 =99.9999). The default
is two decimal digits.

e Report Flag 1 and 2. These boxes allow you to enter a one-character value that you
can use in custom reports. The values for these flags are user-specified.

e Comments. Enter any comments regarding the rate code.
6 Click OK when you are finished.

You cannot add duplicate rate codes to a rate table. Each rate code in a table must be
unique. If you want to use the same rate code more than once, e.g., you charge different
clients different rates for the same resource, you must create separate tables (see Defining
Alternate Rate Tables on page 3-13).

Note ¢ Rates in the Rate Code List Maintenance dialog box are sorted by the index
number. To sort the rates by rate code, rate group, description, etc., click the
appropriate column header. To reverse the sort order, click the column header again.

To edit a rate code:
1 Double-click the code, or click the code and then click Edit Rate.

The Rate Code Maintenance dialog box appears.
2 Follow the steps in To add a rate code: beginning with Step 5 on page 3-10.

To remove a rate code:

Click the rate code, and then click Remove Rate.

Setting Rate Shifts

Rate shifts allow you to set different rates based on the time of day. For example, if a user
is using a computer's resources at 4 a.m., you might charge the user less than if he uses
these resources at 1 p.m. By default, every rate code has one shift. If your CIMS Server
Resource Files contain multiple shift codes, you can define up to eight additional rate
shifts for a total of nine shifts.

To set rate shifts:

1 Click the rate code for which you would like to set rate shifts.
2 Click Edit Rate Shifts.

The Rate Shift Maintenance dialog box appears.
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3 To enter a rate shift, click the Rate Value box next to the shift number and enter a

monetary value. In the adjacent Description box, enter an optional short description
of the rate shift. See example Figure 3-6 on page 3-13.

an Rate Shift Maintenance

[ STANDARD FLLAT10]

Rate Yalue | Description

Shift #2 75 Might

Shift #3 5 Swving
Shift #4 1]

Shift #5 1]

Shift #6 1]

Shift #7 1]

Shift #5 1]

Shift #9 1]

Kevboard Usage: Press the Enter key to edit 2 cell. Use the arrow keys to navigate between celis.

OK | Cancel

Figure 3-6 « Rate Shift Maintenance Dialog Box

4 Click OK when you are finished.

Defining Alternate Rate Tables

If needed, you can create additional rate tables. For example, you might have clients who
are charged different rates for the same resource usage (the Finance department is
charged $20 per hour of CPU usage while the Marketing department is charged $5 per
hour). In this case, you can have two tables with the same rate codes but different values.

To add a rate table:

1

In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

The Rate Code List Maintenance dialog box appears.
Click Add Table at the top of the dialog box.

In the Add New Rate Table dialog box, enter a name (maximum of eight characters),
and then click OK.

The new rate table appears in the Rate Code List Maintenance dialog box.

To add rates to the table, follow the steps for adding a rate code in To add a rate code:
on page 3-9.
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To duplicate a rate table:
1 Click a table in the Rate Table list, and then click Duplicate Table.

2 In the Duplicate Rate Table dialog box, enter a name (maximum of eight characters),
and then click OK.

The new rate table appears in the Rate Code List Maintenance dialog box. The new
table contains all of the rate codes contained in the original rate table.

3 To edit the rates in the table, double-click the code, or click the code and then click
Edit Rate, and follow the steps in To add a rate code: beginning with Step 5 on
page 3-10.

To remove a rate table:

Click the table in the Rate Table list, and then click Remove Table.

WARNING - When you remove a rate table, you lose all rate codes with their associated
rates specific to that table.

Defining Rate Groups

H 3-14

Tip * When working with rate groups, you can access commands for an item by
clicking the appropriate button, or you can access the same commands by right-
clicking the item.

Creating and using rate groups lets you create rate subtotals in reports, graphs, and
spreadsheets. Grouping rates such as CPU charges, Windows charges, and UNIX charges
allows reports to be summarized in a way that is meaningful. It also allows users to create
reports based on grouping rates that have the same identifier or identifiers.

All rate codes must be assigned to a group. For more information, see Adding an
Unassigned Rate Code to a Rate Group on page 3-16.

Note ¢ It is recommended that you do not assign rate codes with different identifiers
to the same rate group. Combining rate codes with different identifiers within the
same group results in reporting anomalies.

Suggestion: Create a separate rate group for each resource file type. For example a
Unix charges group for Unix resource files with the same identifiers. This ensures
that the rate codes within the group have the same identifiers.

To add a rate group:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Groups.

The Rate Group Maintenance dialog box appears displaying an expandable hierarchy
of existing rate groups. Individual rate codes appear within each rate group. See
example Figure 3-7 on page 3-15.
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@42 Rate Group Maintenance

Wigw

[ Rate Group ]

= Rate Groups ~
Al unassigned rate codes
+-Labor charges

M3 Exchange

EXBYSMT - MS Exchange Bytes Sent
EHEMRCY - MS Exchange Emails Receive
EHEMENT - MS Exchange Emailz Sent

WS IS

MS IS8Proxy Server

MS Windows DBI2 charges

MS Windows Cracle charges

MS Windows charges

MS Windows Package charges

ME WWincowes Print

ME Windows Processes

Remove Rate Group | =

Change Rate Group Title

Change Rate Group Description

[ Rate Code |

Add Unassigned Rates to Group

F- - - E- F- - -

ME Windowes SCL Server A
£ >
Rate Group Title: MS Exchange
Rate Group Description: MS Exchange

Close

Figure 3-7 « Rate Group Maintenance Dialog Box

2 Click Rate Groups at the top of the group list, and then click Add Rate Group.

3 In the Add Rate Group dialog box, enter a description of the rate group (maximum of
32 characters), and then click OK.
To remove a rate group:

Click the rate group, and then click Remove Rate Group. If the rate group contains rate
codes, you must delete the codes before you can delete the group.

Changing the Rate Group Description and Title

When you add a rate group, the description and title default to the description that you
assigned to the group. You can change both the description and title of the rate group.
In most cases you do not need to change the title unless you require a shorter field length
for custom reports. Standard reports show the description field, not the title field.

To change the rate group description:

1 Click the group and click Change Rate Group Description.

2 In the Change Rate Group Description dialog box, enter the new description of the
rate group (maximum of 255 characters), and then click OK.
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To change the rate group title:

1 Click the group and click Change Rate Group Title.

2 In the Change Rate Group Title dialog box, enter the new title of the rate group
(maximum of 32 characters), and then click OK.

Adding an Unassigned Rate Code to a Rate Group

To add an unassigned rate code to a rate group:
1 Click the group, and then click Add Unassigned Rates to Group.
The Select Rate Code dialog box appears.

2 Choose the code or codes that you want to add, and then click OK.

Note * In most cases, rate codes are assigned to a rate group when the rate code
is added (see Defining Rate Codes on page 3-9).

Moving an Assigned Rate Code to Another Rate Group

To move a rate code from one group to another, click the rate code that you want to
move and drag it to the desired rate code description.

Removing a Rate Code from a Rate Group

To remove a rate code from a rate group, click the rate code, and then click Remove Rate
From Group.

Working with Clients

Once you have created the account code structure (see Setting Up the Account Code
Structure on page 3-3), you can assign descriptions for the clients represented by your
structure. These descriptions appear in place of the client’s account code in invoices and
other reports. For example, if account code AABBBBCCC represents the Marketing
department, you might assign the description Marketing Department for this code.

You can also specify the rate table used for the client and set up budget and contact and
information.

Note ¢ CIMS Server provides sample clients. You should remove these sample clients
before adding clients for your organization (see To remove a client: on page 3-18).
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To add a client:

Working with Clients

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears as shown in example Figure 3-8.

Note ¢ Clients in the Client List Maintenance dialog box are sorted by account
code. To sort the clients by account name, rate table, etc., click the appropriate
column header. To reverse the sort order, click the column header again.

ans Client List Maintenance

Tools  Wiew

Account Code

Account Name Rate Table | Aternate Account Code

A

Company A4 STAMDARD
Operati .

Purc

Budgets | Contacts | Close |

| Remave | Ediit |

Figure 3-8 « Client List Maintenance Dialog Box

2 Click Add.

3 Inthe Add Account Code dialog box, enter the account code for the client (maximum
of 128 characters), and then click OK.

The Client Maintenance dialog box appears.

4 Edit the client settings as follows:

e Account Name. Enter the name of the client as you want it to appear in invoices
and other reports. Maximum of 255 characters.

e Alternate Account Code. Enter an alternate account code if used for reporting to
a General Ledger system or other types of reporting where the standard account
code is different. Maximum of 128 characters.
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¢ Rate table. If other than STANDARD, click the rate table used for calculating the
client’s charges. Alternate rate tables are used for clients who are charged different
rates for the same resource usage. For example, the Finance department is charged
$20 per hour of CPU usage, while the Marketing department is charged $5 per
hour. For more information, see Defining Alternate Rate Tables on page 3-13.

e Invoice Contact. If a contact is available for this client, the contact appears in this
list box (see Defining Client Contacts on page 3-21). If there are multiple contacts
for this client, click the appropriate contact from the list.

e Action Codes. CIMS Server does not use action codes. These codes are strictly for
reporting purposes and can be used in the custom reporting process for selecting

data.

5 Click OK when you are finished.

An example of a configured Client Maintenance dialog box is shown in Figure 3-9.

ans Client Maintenance

Account Code: A4

Account MName: |C0mpany Mame

Alternste Account |
Codle:

Rate Tahble: STAMDARD =

Invoice Contact 000001 - Brian Jones |

Action Codes: |— |— |— |— |— |— |— |_

Contacts | Budgets | Ok |

Cancel

Figure 3-9 « Client Maintenance Dialog Box

For information on adding a budget and contact for the client, see Setting Up Client
Budgets on page 3-19 and Defining Client Contacts on page 3-21.

To edit a client:

1 Double-click the client or click the client, and then click Edit.

The Client Maintenance dialog box appears.

2 Follow the steps in To add a client: beginning with Step 4 on page 3-17.

To remove a client:

Click the client, and then click Remove.

B 3-18
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Setting Up Client Budgets

Using CIMS Server’s powerful budgeting feature, you can establish budgets by amount
or units for the individual resources used and/or all resources used by a client. These
budgets allow users to report on client actual vs. budget information.

CIMS Server includes reports that you can use as templates to create custom account level
and resource level budget reports for your organization. For more information about the
CIMS Server budget reports, Account Budget for Period and YID and Line Item Budget,
see the CIMS Server Web Reporting User’s Guide.

To create a budget:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears.
2 Click the client that you want to establish a budget for, and then click Budgets.
The Client Budget Maintenance dialog box appears.
3 Edit the budget settings as follows:
e Year. Click the appropriate year. If the year is not listed, click Budget » Add Year.

e Overall Account Budget. You can set both an overall account budget and budgets
for individual resources.

To set an overall budget for an account, click Overall Account Budget.

To set a budget for individual resources, click Budget » Add Resource Budget or
right-click Overall Account Budget, and then click Add Resource Budget. The
Select Rate Codes dialog box appears. Select the rate code or codes for the
resources that you want, and then click OK. The rate codes appear under Overall
Account Budget.

¢ Budget Amount/Budget Units. You can budget by the monetary amount of
consumed resources (Budget Amount) or the unit amount of consumed resources
(Budget Units). You can enter a total budget and a budget for each month
(period) within the year.

Enter the total budget amount or budget units for the year in the Total box and the
budget amount for each period in the Period boxes (1 through 12/13). (To use 13
month periods, see page 3-24.)

¢ Divide Total (Budget Amount and Budget Units). Click Divide Total to divide
the total budget amount of budget units by the number of periods and
automatically populate the Period boxes with the result. Note that if you change
a total, you must perform this step again.
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¢ Sum Periods (Budget Amount and Budget Units). Click Sum Periods to add the
amounts entered in Period boxes and automatically enter the sum in the Budget
Amount Total or Budget Units Total boxes. Note that if you change the amount
for a period or periods, you must perform this step again.

4 Click Apply to save the changes or click OK to save the changes and close the dialog
box.

An example of a configured Client Budget Maintenance dialog box is shown in
Figure 3-10.

@42 Client Budget Maintenance

Budget  View
Account: A4 - Company A4 Year |annz -
[ Budget Detail |
Overall Accaunt Budget Busget Amount  Budget Units

LLAT0S - Unix user CPU Total a7E00 0

LL&106 - Linix system CPU ) | |

LLATO7 - Unix tatal CPU Divicle Total | Divicle Total |

LLT101 - MS Windowes logins Sum Periods | Sum Periods |

LLT102 - MS Windows connect time PP

LLT103 - MS Windaws image count Lo | 7300 | o

Z0071 - 05390 Jobs Started Period 2: | 7300 | 0
Period 3 | 7300 | 0
Period 4: | 7300 | 0
Period 5: | 7300 | 0
Period 6 | 7300 | 0
Petiod 7: | 7300 | 0
Period & | 7300 | 0
Petiod 3 | 7300 | 0
Period 10: | 7300 | 0
Petiod 11: | 7300 | 0
Petiod 12: | 7300 | 0

Ok | Cancel | Apply

Figure 3-10 - Client Budget Maintenance Dialog Box

To remove a budget:

To remove all budget information for a year, click Budget » Remove Year. This removes
the overall budget and all individual resource budgets for the year selected in the Year
box.

To remove an individual resource budget, click the budget, and then click
Budget » Remove Resource Budget, or right-click the budget, and then click Remove
Resource Budget. The budget is removed from all years.

H 3-20 CIMS Server Administrator's Guide



Setting Up the System H
Working with Clients

Defining Client Contacts

You can create contact information (e.g., name, street and e-mail addresses, phone
numbers, and department) for each client. This information appears on CIMS Server
standard invoices.

To add a contact:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears.

2 Click the client that you want to establish a contact for, and then click Contacts.
The Client Contact List Maintenance dialog box appears.

3 Click Add.

4 In the Client Contact Maintenance dialog box, edit the contact settings as follows:

e Address tab. Enter the contact’s name and company and e-mail addresses. You can
enter the street address on any address line or lines. However, if want to use the
View Address Map button to view a map for the address, you need to enter the
address in the following order:

e Address Line 1: Street Address
e Address Line 3: City, State, Zip
e Phone tab. Enter the contact’s phone numbers.

e Other tab. Enter other contact information such as department, comments, and
Web site URL.

5 Click OK when you are finished. Note that the contact will not appear in the Invoice
Contact drop-down box until you close and re-open the Client Maintenance dialog
box.

To edit a contact:

Click the contact, and then click Edit.

To remove a contact:

Click the contact, and then click Remove.

Importing and Exporting Client Data

Client information is contained in the CIMS Client table. You can load and unload data
to/from the CIMS Client table via a number of custom scripts that are provided with
CIMS Server. For more information, see Appendix C, Scripts or contact CIMS Lab (see
Contacting Technical Support on page 6-7).
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Setting Up a Calendar

The calendar is an optional feature that is particularly useful for organizations that do
not want to run billings on standard monthly/yearly periods. CIMS Server supports up
to 13 periods per year (see page 3-24). Organizations using standard monthly/yearly
periods do not need to use the calendar feature.

When using the calendar, you can use the CURRENT or PREVIOUS keywords in both
CIMSACCT and CIMSBILL to indicate that you want to process records that contain end

dates in the current or previous period. For more information, see Chapter 5, Processing
Data.

Setting Up Calendar Information

H 3-22

To set CIMS Server to use the calendar:

1 In the CIMS Server Administrator main window, click System
Administration » Configuration Information.

The Configuration dialog box appears.
2 Click the Processing tab.
3 On the Options subtab, select the Use Calendar check box, and then click OK.
To set calendar information:
1 Click Chargeback Administration » Chargeback Table Maintenance » Calendar.

The Setup Calendar dialog box appears as shown in example Figure 3-11.
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Year: Wv Add Year | Remove Year |

Beginning Date Ending Date Close Date
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et From Period 1
Ok | Cancel | Apply |

Figure 3-11 « Setup Calendar Dialog Box

CIMS Server Administrator's Guide 3-23 N



B Setting Up the System

Setting Up a Calendar

H 3-24

2

Edit the calendar as follows:
e In the Year list, click the appropriate year.
e Set the Beginning Date and Ending Date for each period as needed.

e To have all periods proceed sequentially from the first period, click Set From
Period 1.

e To add a new year, click Add Year.
e To remove the currently displayed year, click Remove Year.

Note that the Close Date for the period appears if a close date has been set (see
page 3-44). The close date appears for the period in which it was set, the previous
period, and future periods. In example Figure 3-11 on page 3-23, a first of the month
close date was set in Period 9 (September). Therefore Period 8 and all future periods
show a close date.

Click Apply to save the changes or click OK to save the changes and close the dialog
box.

Using 13 Accounting Periods

If your organization uses 13 accounting periods, you can set this calendar format as
follows:

1

In the CIMS Server Administrator main window, click System
Administration » Configuration Information.

In the Configuration dialog box, click the Processing tab.

On the Options subtab, select the Use 13 Periods check box, and then click OK. Note
that the Use Calendar check box must also be selected.

Calendar Considerations

The maximum entries that CIMSACCT or CIMSBILL reads from the CIMS Calendar
table is 52. (See page A-13 for more information about the CIMS Calendar table.)
Therefore, you need to delete periods from previous years as they pass.

The periods for a particular year must be entered in date sequence.

The CIMS Calendar table must have the current and previous periods defined.
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Working with Users and Groups

A user is an individual with access rights to CIMS Server Web Reporting. Each user can
belong to only one user group. Users are granted the rights and privileges granted to the
group.

This system of users and groups allows you to control the following:

m The reports that a user can access in CIMS Server Web Reporting. A user can access
only those reports that are assigned to the user’s group.

B The clients (account codes) that a user can view in reports. A user can view only those
clients that are assigned to the user’s group.

B Theadministrative privileges for a user. A user assigned to a group with administrative
privileges can update configuration and other information in CIMS Server Web
Reporting.

Default Administrator User and Group

When you initialize the database during the setup process (see [nitialize the Database on
page 2-26), CIMS Server adds a default user and user group. This group has
administrative privileges in CIMS Server Web Reporting and can view all reports and
clients.

The ID for the default user is admin and the password is password. The ID for the default
user group is Admin.
Defining Users

You can use CIMS Server Administrator to create and maintain user information such as
ID, password, and other user-specific options used for CIMS Server Web Reporting.

To add a user:

1 In the CIMS Server Administrator main window, click System
Administration » Users and Groups » Users.

The User List Maintenance dialog box appears as shown in example Figure 3-12 on
page 3-26.

CIMS Server Administrator's Guide 3-25 N



Bl Setting Up the System

Working with Users and Groups

B 3-26

ans Lser List Maintenance

Uszer ID | Full Mame Wieh Session D

502
Joan Joan Watzon BO3797525

r Administrator 596006

Al | Remove | Eclit | Edit Configuration Cptions | Close |

Figure 3-12 « User List Maintenance Dialog Box

Click Add.

In the Add New User dialog box, enter an ID for the user (maximum of eight
characters) and the click OK. The User Maintenance dialog box appears.

Edit the user settings as follows.

Full Name. Enter the user’s full name.

Display full path on Favorites page. Select this check box to display the full path
for favorite reports on the Favorites page of CIMS Server Web Reporting. For more
information, refer to the CIMS Server Web Reporting User’s Guide.

Display full path on Published Reports page. Select this check box to display the
full path for published reports on the Published Reports page of CIMS Server Web
Reporting. For more information, refer to the CIMS Server Web Reporting User’s
Guide.

Crystal Viewer. This setting determines the Crystal viewer used for this user of
CIMS Server Web Reporting. (To set this option for all users, see Web Settings on
page 3-49.) You can choose one of the following:

e Default. This option uses the viewer set on the Web tab of the Configuration
dialog box (see page 3-49).

e ActiveX. This option works only in Internet Explorer.

e Java using Browser JVM. This option works in Internet Explorer or Netscape
Navigator.

e HTML. This option works in Internet Explorer or Netscape Navigator.
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e Group. Click the group that you want to add the user to or accept the default
Admin group. Note that if you need to add a new group for the user, you can create
the group and add the user as described in Defining User Groups on page 3-29.

¢ Configuration Options Maintenance. When you click this button, the User
Configuration Options List Maintenance dialog box appears. You can add user
configuration options that can be used for custom reports and Web pages in this
dialog box. See To add configuration options: on page 3-54.

CIMS Lab recommends that you consult technical support for assistance in adding
user configuration options (see Contacting Technical Support on page 6-7).

e Domain Name/Domain User ID. CIMS Server Web Reporting provides an
automatic log on feature. To enable a user to use this feature, you need to enter the
user’s Windows domain name and user ID. You also need to enable auto log on
(see page 3-49) and set IIS security for the CIMS Server Web Reporting Web site to
Integrated Windows authentication (see page 2-37).

You can click Browse to select the domain and user from the Select Domain Name
and User ID dialog box. To find a domain and user in the Select Location and
Select User lists:

a Type a complete or partial value in the text box and then click Find or use the
scroll bar.

b Click OK when you are finished.

e New Password. If you are not using the automatic log on feature for CIMS Server
Web Reporting, use this box to enter a password for the user or to change an
existing password as follows:

a Type the password. The password is alphanumeric and case-sensitive and can
be a maximum of 16 characters.

b Click OK.

¢ In the Confirm New Password dialog box, type the password again, and then
click OK.

d Click OK to confirm that the password has been changed.

5 Click OK when you have finished editing the user settings.
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An example of a configured User Maintenance dialog box is shown in Figure 3-13.

ans Lser Maintenance

joan

Full Mame: |J0an Watzon

Perzonalization
Dizplay full path on Favorites page

Dizplay full path on Publizhed Reports page

Crystal Viewer: |Defaun

Group: | AR

Configuration Options Maintenance... |

Domain User Information

Domain User IC: Joan

Change Password

Mewe Passward:

Domain Mame: ARCCO Browse...

Lelle]

Cancel |

Figure 3-13 - User Maintenance Dialog Box

To edit a user:

1 Click the user, and then click Edit.

The User Maintenance dialog box appears.

2 Follow the steps in To add a user: beginning with Step 4 on page 3-26.

To remove a user:

Click the user, and then click Remove.

B 3-28
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Defining User Groups

You can use CIMS Server Administrator to create and maintain user groups including
adding users to groups and assigning group access to reports and clients.

Tip * When working with groups, you can access commands for an item from the
menu bar, or you can access the same commands by right-clicking the item.

Note ¢ A user can belong to only one group. If you need to place a user in more than
one group, create a new group for the user. For example, a user who needs access to
the reports assigned to Group A and Group B should be assigned to Group C that has
access to the combined reports of Group A and Group B. Assigning a user to only one
group makes it easier to determine the user’s full access rights.

To add a group:

1 In the CIMS Server Administrator main window, click System
Administration » Users and Groups » Groups. The Group List Maintenance dialog
box appears as shown in example Figure 3-14.

=42 Group List Maintenance

GEroups View

Group - ROOT

List Mairtenance

Users Reports Clients

Figure 3-14 « Group List Maintenance Dialog Box

1 Click Groups » Add Group on the menu bar.

2 In the Add Group dialog box, enter an ID for the group (maximum of eight
characters), and then click OK.

The Group Maintenance dialog box appears.
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3 Edit the group settings as follows:

Description. Use this box to change the description of the group (the default is the
group ID followed by “Group”). Note that if you add a description, the description
rather than the group ID appears in the Group List Maintenance dialog box.

Account Code Structure. If there are multiple account code structures, click the
account structure for the group.

Allow Transaction Maintenance. Select this check box to allow the users within
this group to perform transaction maintenance in CIMS Server Web Reporting. For
more information, refer to the CIMS Server Web Reporting User’s Guide.

Administrative Access. Select this check box to give the users within this group
administrative configuration options in CIMS Server Web Reporting. For more
information, refer to the CIMS Server Web Reporting User’s Guide.

Split Account Code on Transaction Entry. If this check box is selected (the
default), users within this group are allowed to enter account codes by levels when
adding account codes in the Miscellaneous, Recurring, and Credit Transaction
pages in CIMS Server Web Reporting. Users can either type the account code in the
box for each level or select the code if an accompanying select box is available. The
following option, Max Levels of Account Code to Display, determines the
number of account code levels that include a select box.

The account code levels displayed are dependent on the levels defined in the
account code structure selected for the group.

For more information about using transactions in CIMS Server Web Reporting,
refer to the CIMS Server Web Reporting User’s Guide.

Max Level of Account Code to Display. If the Split Account Code on Transaction
Entry check box is selected, type the number of levels that you want to include
select boxes for. For example, if you have five account code levels, but only want
to include select boxes for the three highest levels, type 3 in this box. The
remaining two levels will have a text box in which users can type the account code,
but no select box to browse for the account code.

The data loaded in the select boxes is pulled from the CIMS Client table. If the
CIMS Client table is large, the transaction page can take more time to load if
multiple select boxes are included. Limiting the number of select boxes can reduce
the amount of time required for the transaction page to load.

The default, 0, specifies that all account code levels include select boxes.
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¢ Configuration Options Maintenance. When you click this button, the Group
Configuration Options List Maintenance dialog box appears. This dialog box
contains entries for some of the group configuration options that you have set. For
example, the option TransSplitAccountCode represents the Split Account Code
on Transaction Entry check box. Do not delete these entries.

You can add group configuration options that can be used for custom reports and
Web pages in this dialog box. See To add configuration options: on page 3-54.

CIMS Lab recommends that you consult technical support for assistance in adding
group configuration options (see Contacting Technical Support on page 6-7).

4 Click OK when you are finished editing the group settings.

An example of a configured Group Maintenance dialog box is shown in Figure 3-15. In
this example, transaction maintenance and administrative privileges are not enabled.

=42 Group Maintenance

Group (D AR

Description: |A.I'R

Account Code Structure: |Standard

Group Privileges
Allowe Transaction Maintenance
Administrative Access

Tranzaction Entry
Split Account Code on Transaction Entry

Mz levels of Account Code to display:

Configuration Cptions Maintenance |

171

Cancel

Figure 3-15 - Group Maintenance Dialog Box

To edit a group:

1 Click the group and click Groups » Edit on the menu bar.

The Group Maintenance dialog box appears.

2 Follow the steps in To add a group: beginning with Step 3 on page 3-30.
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To add a user to a group:

1 Click the group, and then click Groups » Add User on the menu bar.
The Select User dialog box appears.

2 Choose the user or users, and then click OK.

Note * You can edit a user’s settings by double-clicking the user in the Group List
Maintenance dialog box.

To remove a user from a group:

Click the user, and then click Users » Remove on the menu bar.

To remove a group:

Click the group, and then click Groups » Remove on the menu bar.

Adding or Removing Report Access to/from a Group

Users that belong to a group that has administrative access enabled have access to all
reports. By default, new users are added to the Admin group, which has administrative
access enabled and full access to all reports. If you want to restrict user access to reports,
you need to do both of the following:

m Select the Use Report Access Security check box on the Configuration dialog box
Reporting/Options subtab (see page 3-45). If this check box is not selected, all users
can access all reports regardless of whether administrative access is enabled for their

group.

m Create a group or groups that do not have administrative access enabled (the
Administrative Access check box is not selected) and add the appropriate users.

Note  If you change the Use Report Access Security option (i.e., you select the check
box or clear it), the change will not take effect in CIMS Server Web Reporting until
you click Upgrade Configuration on the Edit Configuration page or restart IIS.

The following steps for adding or removing report access are only applicable if both of
the preceding requirements are met.

To add access to reports:
1 Expand the group and click Reports Allowed.
2 Click Reports » Add on the menu bar.
The Select Report dialog box appears.
3 Choose the report or reports that you want to add, and then click OK.

4 Expand Reports Allowed to view the reports that you added.
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To remove access to a report:

1 Expand Reports Allowed.

2 Click the report, and then click Reports » Remove on the menu bar.

Adding or Removing Client Access to/from a Group

You can add access to clients to each group. This allows members of the group to see
these client account codes in reports. For more information about clients, see Working
with Clients on page 3-16.

To add access to clients:

1 Expand the group, click Clients Allowed, and do one of the following:
e To allow all clients, click Clients » Allow All Clients on the menu bar.

e To allow certain clients, click Clients » Add on the menu bar. In the Select Client
dialog box, choose the client or clients that you want to add, and then click OK.

2 Expand Clients Allowed to view the clients that you added.

Note that the account code structure selected for the group might have an offset position
greater than 1. However, client access is always determined by the first position in the
account code, regardless of the offset position. The clients that you add will contain the
full account code as assigned for the clients in the CIMS Client table.

Although the full account code appears for the clients in the Clients Allowed list for the
group, the users assigned to the group will be able to view data for only the account code
level(s) specified by the offset.

For example, assume that you have the following account codes:

AABBB
AACCC

In the account code structure selected for the group, the first level of the account code is
defined as a length of 2 and the second level is defined as a length of 3. The offset
position for the account code is 3, which determines that users assigned to the group can
view data for clients BBB and CCC only. However, the complete client account codes AABBB
and AACCC appear in the Clients Allowed list.

For more information about the account code structure, see Setting Up the Account Code
Structure on page 3-3.

To remove access to clients:
1 Double-click Clients Allowed.
2 Click the client, and then click Clients » Remove on the menu bar.

Accessing User, Report, and Client Lists

You can edit user, report, and client settings by clicking Users, Reports, or Clients in the
Group List Maintenance dialog box.
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Web-based reporting is a key feature of CIMS Server. You can use CIMS Server
Administrator to configure several reporting options for CIMS Server Web Reporting
including defining the reports that users can access and grouping these reports by report
groups.

For more information about using Web-based reporting, refer to the CIMS Server Web
Reporting User’s Guide.

Adding Reports to the Reports List

H 3-34

The report list in conjunction with report groups (see Defining Report Groups on

page 3-36) determines the reports that users can access in CIMS Server Web Reporting.
By default, the report list contains the CIMS Server standard reports. If you are using
custom reports, you can remove the standard reports (see To remove a report: on

page 3-35). If a standard report is in a report group, you must first remove the report
from the group (see To remove a report from a report group: on page 3-37).

To add a report:

1 In the CIMS Server Administrator main window, click System Administration »
Reporting » Reports.

The Reports List Maintenance dialog box appears as shown in example Figure 3-16.

Note * Reports in the Report List Maintenance dialog box are sorted by ID
number. To sort the reports by name or description, click the appropriate column
header. To reverse the sort order, click the column header again.

@44 Report List Maintenance |:”E| PZ|

Wigw

I # [Maime Description ~

000000002 Budget RBGTC

| e | |

Figure 3-16 « Reports List Maintenance Dialog Box
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2 Click Add.

3 Inthe Add New Report dialog box, enter the name of the report (e.g., Cost Variance),
and then click OK. Maximum of 32 characters.

The Report Maintenance dialog box appears.
4 Enter the report settings as follows:
¢ Name. Use this box to change the name of the report.

e Filename. The name of the report file without the path. To browse for a report file,

click the Browse button _I Maximum of 255 characters.

e Template File Name. Consult CIMS Lab before using this option (see Contacting
Technical Support on page 6-7).

e Description. Enter a description of the report. Maximum of 255 characters.
5 Click OK when you are finished.

An example of a configured Report Maintenance dialog box is shown in Figure 3-17.

@44 Report Maintenance

Report ID: 3
Iame: |C031 Wariance
File: Mame: |r\.-arc:_rpt
(Exclode the path name)
Template File Narme: | j
Description: |RVARC

OK | Cancel |

Figure 3-17 + Report Maintenance Dialog Box
To edit the settings for a report:
1 Click the report, and then click Edit.
The Report Maintenance dialog box appears.
2 Follow the steps in To add a report: beginning with Step 4.

To remove a report:

Click the report, and then click Remove. If the report is in a report group, you must first
remove the report from the group (see To remove a report from a report group: on
page 3-37).
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Tip * When working with report groups, you can access commands for an item from
the menu bar, or you can access the same commands by right-clicking the item.

Report groups are useful in CIMS Server Web Reporting because they allow you to
categorize related reports in a single group. For example, you might create groups by
report type (e.g., invoice, variance, account) or by data type (e.g., CPU, UNIX,
Windows).

There are two type of report groups:
e Start Groups. These are the larger groups that contain other groups.

e Groups. These are the standard report groups that are contained in a Start Group.
Groups contain reports.

There are three default Start Groups: Reports, Graphs, and Spreadsheets. Although you
can add other Start Groups, only the default groups appear in CIMS Server Web
Reporting. To use Start Groups other than the default groups, you need to create a
customized Web site.

The default Start Groups (Reports, Graphs, and Spreadsheets) are required for CIMS
Server Web Reporting and must be ordered 1, 2, and 3 as shown Figure 3-18. Do not
remove, rename, or reorder these groups.

To add a report group:

1 In the CIMS Server Administrator main window, click System
Administration » Reporting » Report Groups. The Report Group Maintenance
dialog box appears as shown in example Figure 3-18.

=42 Report Group Maintenance

Group View

.: ]
= % 1 - Reports
+ % Invoices
% Account Reports
% “ariance Reports
% Trend
% Resource Detail
% Cither
% Custom
Graphs
Spreadsheets
% Standard Spreadshests
% Custom Spreadsheets

F-[- -

2.
3-

+ P

Start Group Description: Root

Report List Maintenance

Figure 3-18 « Report Group Maintenance Dialog Box
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2 Do one of the following:

e To add a Start Group, click Group » Add Start Group on the menu bar. In the Add
Start Group dialog box, enter the name of the Start Group, and then click OK.

e Toadd a group to a Start Group, click the Start Group, and then click Group » Add
Group on the menu bar. In the Add Group dialog box, enter the name of the
group, and then click OK.

To add a report to a report group:

1 To add areport to a report group, click the group, and then click Group » Add Report
on the menu bar. Note that you cannot add a report to a Start Group.

The Select Report dialog box appears.
2 Choose the report or reports that you want to add, and then click OK.

To view the reports that you added, double-click the group.

Note * Report groups that do not contain at least one report will not appear on the
Reports page in CIMS Server Web Reporting.

To remove a report from a report group:

Click the report, and then click Report » Remove Report from Group on the menu bar.

Note * Removing a report deletes the report from the report group, not from the
system.

To remove a report group:

Click the group, and then click Group » Remove Group on the menu bar. Note that you
cannot remove a report group that contains other groups or reports.
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Other Report Group Options

Once you have created a report group, you can:
B Rename the group or change its description
B Re-sort the group or report display order

m Make a group the default group for user-defined reports

To rename a report group or change its description:

1 Click the group, and then click Group » Change Group Name or Change Group
Description on the menu bar.

2 In the Change Group Name/Description dialog, box enter the new name or
description. Note that the default description is the group name.
To re-sort the group or report display order:

1 Click the group that contains the groups or reports that you want to re-sort, and then
click Group » Change Group Display Order or Change Report Display Order on
the menu bar.

The Report Group/Report Display Sequence dialog box appears.
2 Click a group/report, and then click the up or down arrow to reposition the item.

3 Click OK when you are finished.

To set the default group for user-defined reports:

In CIMS Server Web Reporting, end users can create reports using the standard templates
provided with CIMS Server or custom templates developed by your Crystal Reports
developer. For more information about user-defined reports and descriptions of the
standard templates, refer to the CIMS Server Web Reporting User’s Guide.

To make a group the default group for reports or spreadsheets created by end users, click
the group, and then click Group » Default Report/Spreadsheet Group on the menu bar.
On the Reports or Spreadsheets page of CIMS Server Web Reporting, the user-defined
reports or spreadsheets appear in the group selected as the default group.

The default group appears bold and is designated by *Reports/Spreadsheet Default in
the lower left corner of the Report Group Maintenance dialog box.

The default group for user-defined reports is Custom and the default group for user-
defined spreadsheets is Custom Spreadsheets.
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Headlines are links that appear in the home page of the CIMS Server Web Reporting Web
site. A headline can link to any URL. This feature has many uses including displaying
announcements such as the latest CIMS chargeback data is available, a new report is
available, etc.

To add a headline:

1 In the CIMS Server Administrator main window, click System
Administration » Reporting » Web Reporting Headlines.

The Web Reporting Headline Maintenance dialog box appears.

2 Click Add.

The Headline Maintenance dialog box appears.

3 Enter the headline settings as follows:

e Date. Click the date that you want to assign to the headline. Note that this is not
the date that the headline appears on the Web site—the headline appears as soon
as it is created.

e Headline. Enter the text of the headline.

¢ Headline Link. Enter the URL for the headline (the headline appears as a link).

4 Click OK when you are finished.

An example of a configured Headline Maintenance dialog box is shown in Figure 3-19.

a5 Headline Maintenance

Headlline IC:

Date:

Headlline:

Headlline Link:

1

10M 12002 -

L E®

|ielcome to CIMS Lak!

|hﬂp: Thawewy cimslab.com

OK | Cancel

Figure 3-19
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To edit a headline:

1

2

Click the headline and in the Web Reporting Headline Maintenance dialog box, and
then click Edit.

The Headline Maintenance dialog box appears.

Follow the steps in To add a headline: beginning with Step 3 on page 3-39.

To remove a headline:

Click the headline in Web Reporting Headline Maintenance dialog box, and then click
Remove.

Maintaining Identifiers

When you process a CIMS Server Resource File, the identifiers within that file are stored
in the CIMS Ident table. You can perform the following maintenance tasks for these
identifiers:

B 3-40

Add a description for the identifier. By default, the identifier description is the same
as the identifier name. For reporting purposes, you can add detailed descriptions for
identifiers that appear as alphanumeric strings. In some reports, these descriptions
appear in the Identifier list to enable drill down of units or rates by identifier.

Remove unused identifiers. You can remove any unused identifiers from the CIMS
Ident table. Unused identifiers are those that are not contained in an CIMS Detail
Ident table. For more information about the CIMS Ident and CIMS Detail Ident
tables, see Appendix A, Database Tables.

Enable options for custom reporting. You set options for each identifier, such as flags,
for custom reporting.

To add an identifier description:

1

2

3

In the CIMS Server Administrator main window, click System
Administration » Identifiers Maintenance. The Identifier List Maintenance dialog
box appears.

Click the identifier that you want to edit, and then click Edit.
The Identifier Maintenance dialog box appears.
Enter the identifier settings as follows:

e Name. This is the name of the identifier as it appears in the CIMS Server Resource
File. Do not change the name unless you want to assign a new identifier to the
same description. For example, the identifier ABC has been changed to ABCD. The
identifier name has changed, but the description remains the same.

e Description. Enter a description for the identifier (maximum of 255 characters).

CIMS Server Administrator's Guide



Setting Up the System H
Maintaining Identifiers

e Active/Inactive. These options are available for custom reports. The use of these
options is user-specified.

e Report Flag. This box allows you to enter a one-character value that you can use
in custom reports. The value for this flag is user-specified.

An example of a configured Identifier Maintenance dialog box is shown in Figure 3-20.

== |dentifier Maintenance

Identifier I g + Active
" Inactive

Mame: |C_IP

Description: |Client IP Address

Report Flag:

OK | Cancel ‘

Figure 3-20 - Identifier Maintenance Dialog Box

To remove unused identifiers:

Click Remove Unused Identifiers.
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Configuring System Settings

You can configure the following system settings using CIMS Server Administrator:

B 3-42

Organization information. Name and address of your organization.

Processing settings. Global processing settings for the system such as the path to the
Processes folder and whether the CIMS Calendar table and/or a close date are used
for processing.

Reporting settings. Report-related settings such as file location, invoice numbering,
and security.

Database settings. Database-related settings such as time-out period and load
priority.

License information. Product license key.

Web settings. Web site settings for CIMS Server Web Reporting.
Table audit settings. Table audit options.

Database load archive settings. Settings for archiving database loads.

Configuration options. Additional settings for custom reports and Web pages.

Important! ¢ If you change any of these settings in CIMS Server Administrator, the
changes will not take effect in CIMS Server Web Reporting until you click Upgrade
Configuration on the Edit Configuration page or restart IIS.

In addition, some of these settings can be configured in CIMS Server Administrator
or CIMS Server Web Reporting. If CIMS Server Web Reporting is open when you
make these changes, click Refresh before you click Upgrade Configuration. This
ensures that the settings are populated with the values that you set in CIMS Server
Administrator.
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To configure the system settings:

Configuring System Settings

1 In the CIMS Server Administrator main window, click System

Administration » Configuration Information.

The Configuration dialog box appears as shown in example Figure 3-21.

Wigw

Organization Mame:

Address Line 1:
Address Line 2
Address Line 3

Address Line 4

Organization l Processing ] Reporting ] Databasze ] License ] Wiek ] Aud'rting] Archiving ] Option List]

|The Big Time Company

|C0rp0rate Headoguarters

|3013 Douglas Bivd.

[Rosevile, Ca 95681

|Un'rted States of America

Reset To Defaultts

Figure 3-21 - Configuration Dialog Box

2 Complete the tabs in the dialog box as shown in the following sections, and then click

OK to save the settings and close the dialog box.

Note * To return the settings in all tabs to the original default settings, click Reset

To Defaults.

Organization Information

Use the Organization tab to type the name and address of your organization (maximum
of 255 characters in each line), and then click OK. This information appears on the

standard invoices that ship with CIMS Server.

You can also type this information on the Edit Configuration page in CIMS Server Web

Reporting.
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Processing Settings
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Use the Path, Options, and Closing subtabs on the Processing tab to set the processing
settings for CIMS Server.

Path Subtab

Process Definition Path. Enter the path for the process definitions (maximum of 255
characters). For more information about process definitions, see CIMS Server
Administrator Processing on page 5-17.

Options Subtab

Use 13 Periods. Select this check box if your organization uses 13 accounting periods.
For more information, see Using 13 Accounting Periods on page 3-24. If you select this
check box, you must also select Use Calendar.

Use Calendar. Select this check box to set the system to work with the CIMS Calendar
table. The calendar is an optional feature that is particularly useful for organizations
that do not want to run billings on standard monthly/yearly periods. Organizations
using standard monthly/yearly periods do not need to use the calendar feature. For

more information, see Setting Up a Calendar on page 3-22.

Closing Subtab

Close Date. You can set an optional close date for processing input file records.
Records that contain dates before or after this date are processed as described in How
Accounting Dates are Calculated on page 5-15. You can also set close dates for an
individual process definition or definitions (see page 5-26). If you set a close date for
an individual process definition, it overrides the date that you set here.

Click one of the following:
e No Close Date. No close date is set.
» Use Specific Date. Enter a specific close date.

e Use Day Of Month. Click the day of the month that you want to set as the close
date. For example, click 15 if you want a close date of the fifteenth of each month.
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Reporting Settings

Use the Paths, Options, and Invoice subtabs on the Reporting tab to set the report
settings for CIMS Server Web Reporting.

Note * You can also enter some of these settings on the Edit Configuration page in
CIMS Server Web Reporting.

Paths Subtab

m Path to standard reports folder. Enter the path for standard reports (maximum of
255 characters). Standard reports are those that are provided with CIMS Server. In
most cases, standard reports require customizing for your organization.

CIMS Lab recommends that you keep the Standard folder in the default location
because standard reports may be updated and/or added with a new version or release
of CIMS Server.

m Path to custom reports folder. Enter the path for custom reports (maximum of 255
characters). Custom reports are those that your Crystal Reports developer creates
either independently or from the standard reports provided with CIMS Server.
Custom and standard (if applicable) reports are available to users via the Reports or
Spreadsheets page of CIMS Server Web Reporting.

m Path to published reports folder. Enter the path for published reports (maximum of
255 characters). Once a report is generated, it can be published. Publishing a report
enables other CIMS Server Web Reporting users to view the report with the data as it
appeared at the time the report was generated. Published reports can be created via
an automatic batch process on a regular basis (see Batch Reporting Scripts on
page C-14).

Published reports are available via the Published Reports page of CIMS Server Web
Reporting.

Note ¢ End user access to published reports is dependent on the security
permissions for the published reports folder. Be sure that the folder permissions
shown in Assign CIMS Server Folder Security Permissions on page 2-38 are assigned for
the appropriate users.

m Path to Advanced Spreadsheet Install folder. Enter the path for CIMS Advanced
Spreadsheets (maximum of 255 characters). Note that if the CIMS Advanced
Spreadsheets application is not installed, this folder is not created and the folder path
does not appear in this box.

The AdvSpreadsheets folder contains a Standard subfolder to store the standard
spreadsheets that are provided with CIMS Server. CIMS Lab recommends that you
keep the Standard subfolder in the default location because standard spreadsheets
may be updated and/or added with a new version or release of CIMS Server.
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Options Subtab
m Last Reporting Date. Enter the last reporting date for reports that CIMS Server Web

Reporting users who do not have administrative privileges can view. For example, if
you do not want non-administrator users to view reports for dates after March 2004,
enter 03/31/2004. Users with administrative privileges can view reports for any date.

Rate Drilldown Report Name. This setting defaults to the file name for the Multilevel
Drilldown on Rate report (IINXC006). This report enables you to drill down on up to
five identifiers concurrently when you drill down on the units for a rate in a Web
report. If you are using a custom version of this report, enter the file name for the
custom report.

Note ¢ Consult CIMS Lab before replacing this report with a custom report (see
Contacting Technical Support on page 6-7). The report must follow certain rules.

Rate Group Drilldown Report Name. Type the file name for the Multilevel
Drilldown on Rate Group report (I INXC007). This report enables you to drill down on
up to five identifiers concurrently when you drill down on the units for a rate group
in a Web report. If you are using a custom version of this report, type the file name
for the custom report.

Note ¢ Consult CIMS Lab before replacing this report with a custom report (see
Contacting Technical Support on page 6-7). The report must follow certain rules.

Report Script Timeout. Enter the length of time in seconds that the ASP page will
allow a script to generate a report before timing out. The default is 900 seconds (15
minutes). The minimum value for this setting is 600 seconds (10 minutes) and the
maximum value is 2700 seconds (45 minutes).

Note -« IIS allows you to set the time-out value for ASP scripts. The value set for
Report Script Timeout overrides the time set in IIS only for scripts that are
generating reports. All other scripts use the time-out value set in IIS.

Currency Symbol. The use of this box is user-specified. This box allows you to enter
a currency value that you can use in custom reports (maximum of three characters).

Currency Description. The use of this box is user-specified. This box allows you to
enter a currency description that you can use in custom reports (maximum of 255
characters).

Enable Advanced Spreadsheets. Select this check box to enable CIMS Advanced
Spreadsheets in CIMS Server Web Reporting. Note that IIS and SQL Server must also
be configured to enable CIMS Advanced Spreadsheets as described in Set Up CIMS
Advanced Spreadsheets (Optional) on page 2-40.

Use Report Access Security. Select this check box to set access to reports by user
group (see Adding or Removing Report Access to/from a Group on page 3-32). If this
check box is not selected, users within a group can view all reports regardless of
whether the report is allowed for the group.
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m Use only 1 Crystal Report License on drilldown reports. By default, when you open
a second window in Crystal Reports (for example, when you drill down on resource
units or a rate group in a Web report), a second Crystal Reports license is used.

When this check box is selected, all report information appears in the same window
and only one Crystal Reports license is used.

Invoice Subtab

B Invoice Number Automation. When this check box is selected, invoice numbers in
CIMS Server Web Reporting increase sequentially from the number set in the Invoice
Number box. The number in the Invoice Number box is then automatically updated
to the number of the invoice that was last run.

For example, if the invoice number is initially set to 1, and you run a report that
contains 20 invoices by account code, the invoice number will be automatically
updated to 20. If you run another report containing 5 invoices, the invoice number
will be updated to 25.

When this check box is selected, the parameter Invoice Number does not appear as a
report parameter in CIMS Server Web Reporting. For more information about Web
report parameters, refer to the CIMS Server Web Reporting User’s Guide.

m Invoice Number. If the Invoice Number Automation check box is selected, use this
box to set the number at which you want invoice numbers to begin. Invoices numbers
increase in sequential order from this number. If the Invoice Number Automation
check box is not selected, the invoice number entered as a report parameter in CIMS
Server Web Reporting is used.
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Database Settings

Use the Database tab to set the following:

m Connection Timeout (seconds). Type the maximum number of seconds (maximum

0f 9999) that a database may respond to a query before timing out. If this time period
is exceeded, CIMS Server Administrator assumes that the database server is not
responding and returns an error message.

If you accept the default (0), no time-out period is applied.

Database Load—Process Priority Class. This setting determines the priority in which
CIMS Server processes are run (CIMSACCT, CIMSBILL, database loads, etc.). Because
these processes can use a large amount of CPU time, CIMS Lab recommends that you
accept the default, Below Normal, which allows other processes (for example, IIS and
SQL Server tasks) to take precedence. Consult CIMS Lab before using a priority other
than Below Normal.

Note * Below Normal will not cause processes to run longer.

Database Object Prefix. CIMS Lab strongly recommends that you do not change the
dbo.value for this option. This prefix sets the owner of CIMS Server database objects
to dbo in SQL Server allowing any authorized database user to view the objects.

License Information
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Use the License tab to enter the license key provided by CIMS Lab. If you do not have
your license key, contact CIMS Lab (see Contacting Technical Support on page 6-7).

To enter a license:

1 Enter the appropriate workstation (machine) and type the license key.
2 Click Update License.

To remove a license for a workstation:

1 Enter the workstation.

2 Click Remove License.
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Web Settings

Use the General, User Logging, and Customization subtabs on the Web tab to set the
Web site settings for CIMS Server Web Reporting, including optional custom settings.

General Subtab

m Session Timeout Minutes. Enter the number of minutes of inactivity that are allowed
before a CIMS Server Web Reporting user is automatically logged off the system. The
minimum is 1 minute and the maximum is 9999 minutes.

m Display Account Code Selection to Level. This setting determines the level of
account codes that appear in the Starting Account Code and Ending Account Code
parameter lists in CIMS Server Web Reporting. For example, if you enter 1, only the
top level account codes appear. However, if you enter 3, the first, second, and third
level account codes appear. For more information, about using starting and ending
account codes, refer to the CIMS Server Web Reporting User’s Guide.

You can also enter this setting on the Edit Configuration page in CIMS Server Web
Reporting.

m Crystal Report Viewer. Click the Crystal viewer used for CIMS Server Web Reporting.

Note * You can set different viewers for individual users. CIMS Server Web
Reporting uses the viewer set for the user if it differs from the viewer set here. To
set this option for an individual user, see page 3-26.

You can choose the following:

e Default. If you are using Crystal Reports 9, the default is the HTML viewer. If you
are using Crystal Reports 8.5, the default is the ActiveX viewer.

e ActiveX. This option works only in Internet Explorer.

e Java using Browser JVM. This option works in Netscape Navigator or Internet
Explorer.

e HTML. This option works in Internet Explorer or Netscape Navigator.

You can also enter this setting on the Edit Configuration page in CIMS Server Web
Reporting.

m Crystal Release. Click the Crystal Reports release that you are using for Web
reporting: 85 or 90.

m Port Number. If SSL is not enabled for the CIMS Server Web Reporting Web site and
a port other than port 80 is used, type the port number.

m Secure Port. If SSL is enabled for the CIMS Server Web Reporting Web site and a port
other than port 443 is used, type the port number.
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m Enable Intranet Auto Logon. Select this check box to enable users to automatically
log on to CIMS Server Web Reporting. This feature saves time for users and eliminates
the need to maintain user passwords in the CIMS Server database.

To use this feature, the Windows domain name and user ID for the user must be
entered in the User Maintenance dialog box (see page 3-25) and IIS security for the
CIMS Server Web Reporting Web site must be set to Integrated Windows
authentication (see page 2-37).

m Secure Login. Select this check box if SSL is enabled for the CIMS Server Web
Reporting Web site. For more information about enabling SSL, see page 2-39.

m Allow Password Change. Select this check box to enable users to change their user
password on the CIMS Server Web Reporting Login page.

m Display Account Name on Account Code drop downs. Select this check box to
display the account code description in the Starting Account Code and Ending
Account Code parameter lists in CIMS Server Web Reporting. If you do not select
this check box, the account code description does not appear with the account code.

m Enable Client Dropdown Exact Length. When this check box is selected, only
account codes of the level set in the Display Account Code Selection to Level box
appear as parameters in CIMS Server Web Reporting.

For example, assume that you have an account code of AABBBCCCC, where AA is
level 1, AABBB is level 2, and AABBBCCCC is level 3. If Display Account Code
Selection to Level is set to 3, only code AABBBCCCC appears in the Starting Account
Code and Ending Account Code parameter lists in CIMS Server Web Reporting.

Note that if you select this check box and you do not have clients defined in the CIMS
Client table for the level set in Display Account Code Selection to Level, no account
codes will appear in the parameter lists.

User Logging Subtab

m Log File. If you are logging the usage of CIMS Server Web Reporting, enter the path
for the log file.

m Log IP Address To Skip. If you are logging the usage of CIMS Server Web Reporting,
type the IP address of any client that you do not want to track in the log file. If you
enter only the first number or numbers of an address, any address that begins with
the number(s) will not appear in the log file. For example, if you enter 127.0.0, the
addresses 127.0.0.0 and 127.0.0.1 are not included.

B Require Company Name on login. When this check box is selected, the user must
enter a company or organization name when logging on to CIMS Server Web
Reporting. A text box for the name appears on the Login page.
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Customization Subtab

CIMS Server enables you to create custom Web site settings for CIMS Server Web
Reporting. For example, you might want the Web site to conform to your corporate
standards or to use a custom startup ASP page.

You can use the custom settings feature to select the cascading style sheets, images,
background color, and menu alignment for the Web site.

To use custom Web site settings, you need to first set up the appropriate folders and files
in Windows.

In Windows:

1 Make sure that you have a Custom folder in C:\Program Files\CIMSLab\Server\Web.
(This is the default location. The location of the Web folder might differ on your
system.) The Custom folder should contain an images folder. See example Figure 3-22.
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Figure 3-22 « Web Folder Contents

2 Copy everything in Web/images to Web/Custom/images. (Click Yes to replace the
existing topgraphic.gif file in Custom/images).

3 Copy the CIMS.css file from the Web folder to Web/Custom.
4 Customize the CIMS.css file in the Custom folder as needed.

5 Customize the images in Custom/images as needed.
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6 In Web/Custom/images, replace the topgraphic.gif file with your own image. This is
the image that appears at the top of all Web pages. The image must be named
topgraphic.gif, but it can be in the GIF or JPEG format.

7 In the Custom folder, customize the default.asp page. This is the home page.

In CIMS Server Administrator:

1 On the Web tab, click Custom in the Custom Site box. Edit the following:
¢ Background Color. Type the hexadecimal number for the background color.
e CSS Location. Type Custom/CIMS.css (do not add beginning or ending slashes).
e Image Location. Type Custom/images (do not add beginning or ending slashes).

e Menu Vertical Start Position. Enter the start position (in pixels) for the menu. The
menu begins at the specified number of pixels from the top of the page. The
number of pixels depends on the size of your topgraphic.gif image. To
determine the number of pixels:

a Right-click the topgraphic.gif file, and then click Properties.
b Click the Summary tab to get the image height.
2 Click OK when you are finished.
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Table Audit Settings

Important! ¢ Auditing a table can degrade the table’s performance because the audit
feature uses SQL triggers. Do not use this feature for tables that you do not need to
audit.

Use the Auditing tab to audit changes to certain database tables. Auditing tracks changes
that have been made to the data in the tables, including the Windows user ID of the
person who made the change and the date and time that the change occurred.

Note ¢ Transaction audits might reflect the SQL Server login ID rather than the
Windows user ID. For more information, see Creating User Logins for the Database on
page 2-22.

To audit tables, select the appropriate check boxes in the Select audit types area. Audit
data for a table is stored in an additional table named CIMS Audit <audit type>. For
example, the CIMS Audit Rate table tracks changes to the CIMS Rate table.

You can also view changes to the CIMS Client, CIMS Rate, and CIMS Transaction tables
via the following standard Web reports.

m Client Audit Report (file name RACLX001. rpt)
m Rate Audit Report (file name RARTX001.rpt)
m Transaction Audit Report (file name RATRX001.rpt)

For more information about these reports, including examples, refer to the CIMS Server
Web Reporting User’s Guide.

Note ¢ You need to add these reports to the reports list in the Report List
Maintenance Dialog box and to a report group in the Report Group Maintenance
Dialog box if the reports are not already present (see Working with Reports on
page 3-34).
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Database Load Archive Settings

Use the Archiving tab to set the archiving options for database loads. Archiving saves
selected database loads in a format that you can reload (restore) into the database if the
loads are purged.

m Archive Path. Enter the path for storing the archived database loads. The default path
is C:\Program Files\CIMSLab\Admin\Archive\DSNname, where DSNname is the name of
the data source selected in the Select ODBC Data Source dialog box. If you are using
multiple databases with CIMS Server, you should store the archived loads from each
database in separate folders. The archived database loads are stored in a Zip file and
you cannot determine the data source by the Zip file name.

m Compression Type. Click the compression type that you want to use for the archive
files or None. The default, Deflate, is recommended; however, Deflate64 and
BurrowsWheeler may be used for Zip tools that support them.

m Compression Level. Move the slider to set the compression level. The compression
level controls the amount of compression to be applied when compressing data. The
greater the amount of compression applied, the greater the time it takes to perform
the compression.

For more information about archiving database loads, see Archiving, Purging, and
Restoring Database Loads on page 4-23.

Configuration Options
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Use the Option List tab to set additional configuration options that can be used for
custom reports and Web pages. CIMS Lab recommends that you consult technical
support for assistance in adding configuration settings (see Contacting Technical Support
on page 6-7).

Note ¢ If you add Web reporting-related options, the change(s) will not take effect
until you click Update Configuration on the Edit Configuration page in CIMS Server
Web Reporting or restart IIS.

To add configuration options:
1 Click Add.

2 In the Add New Configuration Option dialog box, enter the name for the new option
(maximum of 80 characters), and then click OK. The Configuration Option
Maintenance dialog box appears.

3 Enter the following information for the option:
e Description. Enter a description of the setting. Maximum of 80 characters.

e Value. Enter the value for the setting (e.g., a folder path or a flag value). Maximum
of 255 characters

¢ Data Type. Click the data type for the value: String, Integer, Floating Point, or
Date/Time.
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This chapter describes how to use CIMS Server Administrator to create and administer
CIMS Server databases.

CreatingaDatabase ...........cccieiiiiiieiiiiiiiiiiiieieneieieseiececececncsescsssasncnes 4-2
Backing Up and Maintaining Databases .............cccoiiiiiiiiiiiiiiiiiiieiiiieeeiencnnes 4-4
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Creating and Dropping Tables . . ... ... i e e 4-13
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Purging Data from the CIMS Detail and CIMS Detail Ident Tables ....................... 4-14
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Creating a Database

The database stores administration information as well as the Ident, Detail, and
Summary records that are produced by CIMS Processing Engine (see Chapter 5, Processing
Data, for more information about these records). These records are used by Crystal
Reports to provide robust Web reporting.

You might have already created a database using the steps in Getting Started on
page 2-18. However, you can use more than one database with CIMS Server. For
example, you might have a production database and a development database. The
following sections provide steps for creating additional databases in Microsoft SQL
Server or MSDE.

Note » Consult your SQL Server DBA for further assistance in creating a database.

Creating a Database in Microsoft SQL Server 2000
To create a database in SQL Server 2000:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » Computername » Databases.

3 Right-click the Databases folder, and then click New Database.

4 In the Database Properties dialog box, enter the configuration information for the
new database as follows:

¢ On the General tab, type a name for the database.

e Unless you need to change the default settings for the database, you do not need
to reset values in the Data File or Transaction Log tabs.

5 Click OK when you are finished.

Creating User Logins for the Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. After you create the database,
you need to create database logins for these users as described in To create a user login: on
page 2-23.
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Creating a Database in MSDE 2000

When you install MSDE 2000, a default master database (master.mdf) is created. You can
use this database “as is”.

To create additional MSDE databases, use either the OSQL or ISQL command-line
interface as follows. Press <Enter> after each command.

1 At the command prompt, log on to the database server. For example:
osql -S servera-test -t

Where -S servera-test indicates the server name and -E indicates use a trusted
connection. Note that there are other switches that you may have to use depending
on your environment. For example, you may have to specify the login ID (-U) and
password ( -P) switches. To view the OSQL switches, type osql /? at the command
prompt.

2 At the 1> prompt, type:

create database database name

Where database name is the name that you want to give the database.
3 At the 2> prompt, type:

go

The following messages appear:

The CREATE DATABASE process is allocating 0.63 MB on disk ‘database name .
The CREATE DATABASE process is allocating 0.49 MB on disk 'database name_log' .

4 At the 1> prompt, type:
quit

The database is created in C:\Program Files\Microsoft SQL Server\MSSQL\Data (if you
installed CIMS Server, including MSDE, in the default location). This is also the location
of the master database. You should include the Data folder in your backup schedule.

Creating a Data Source and Initializing the Database

Once you have created a database, do the following:

1 Create an ODBC data source for the new database and select the data source (see To
create a data source: on page 4-5).

2 Perform the steps in Set Up CIMS Server on page 2-24 (i.e., initialize the database,
enter the configuration settings, etc.).

WARNING - Before you initialize the database, make sure that you have selected the
correct database by clicking Show Connection Information in the CIMS Server
Administrator main window. Initializing overwrites any existing data in a database.
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Backing Up and Maintaining Databases

It is extremely important that you back up your CIMS Server database(s) so that you can
recover your data in case of media failure or natural disaster. CIMS Lab recommends that
you back up your database(s) weekly and that you back up to a different server at another
site.

CIMS Lab also recommends that you use the Database Maintenance Plan feature
included with SQL Server to schedule and perform backup up and maintenance tasks for
databases. To use this feature:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » Computername » Management » Database Maintenance Plans.

3 Right-click Database Maintenance Plans, and then click New Maintenance Plan.

4 Follow the steps provided in the Database Maintenance Plan Wizard.

Setting the Database Recovery Model

CIMS Lab recommends that you change the SQL Server recovery model from Full, the
default, to Simple.

Full recovery allows the database to be recovered to the point of failure. Simple recovery
allows the database to be recovered to the most recent backup. Because any lost data can
be recovered and reloaded from the CIMS Server Resource Files, the benefit offered by
the Full recovery is not as beneficial as the smaller SQL Server log file size and disk space
savings provided by Simple recovery.

To set the database recovery model.:

1 In Enterprise Manager, navigate to the database that you want.
2 Right-click the database, and then click Properties.

3 On the Options tab, click Simple in the Recovery Model list.
4 Click OK.
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Managing ODBC Data Sources

To access the databases that you create for CIMS Server, you need to create an ODBC data
source for each database. You can then select the database that you want to use for
database administration and/or Web reporting by its data source.

To create a data source:

1 In the CIMS Server Administrator main window, click Select ODBC Data Source.

The Select ODBC Data Source dialog box appears as shown in example Figure 4-1.

@2 Select ODBC Data Source |:||E|PZ|

Wigw

Machine: J

System Data Sources:

[ User Infa]

Uszer It |csadminUser Pazsword: [seees

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 4-1 « Select ODBC Data Source Dialog Box

2 Click ODBC Data Source Administrator.

The ODBC Data Source Administrator dialog box appears.

3 Click the System DSN tab.
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Click Add and follow the steps provided by the DSN creation wizard to add the data
source. Consult your SQL Server DBA to determine the settings that you should select
in the wizard. Note the following:

¢ The wizard prompts you with the following: How should SQL Server verify the
authenticity of the login ID? Click the correct authentication method (Windows
or SQL Server). If you select SQL Server authentication, enter the SQL Server user
ID and password in the Login ID and Password boxes.

Note ° If you are using a single database with CIMS Server and you select SQL
Server user authentication, you also need to enter the SQL Server user ID and
password in User ID and Password boxes of the Select ODBC Data Source
dialog box (see Figure 4-1 on page 4-5).

If you are using multiple databases with CIMS Server and you select SQL Server
authentication for each database, you need to open the Data Source List
Maintenance dialog box and create a UID for each database data source
(including the data source for your original database) and enter the
corresponding SQL Server user ID and password (see Setting a Unique Identifier
for an ODBC Data Source on page 4-7).

* For Internationalization Only. To select the language for the data source other
than the default language, select the Change Language of SQL Server Messages
to check box and click the language that you want from the list.

Important! « Do not select the Use regional settings when outputting currency,
numbers, dates, and times check box (the default for this check box is
unselected). CIMS Server does not support this option. Regional settings are
supplied by the regional options for the user logged on to the computer (see
Internationalization Setup on page 2-9).

When the wizard completes, click Test Data Source to make sure that the
configuration was successful, and then click OK until the Select ODBC Data Source
dialog box closes. Note that when you add a data source, the database does not
appear in the Select ODBC Data Source dialog box until you close and re-open the
dialog box.

Click Select ODBC Data Source again, click the new data source, and then click OK.

Perform the steps in Set Up CIMS Server on page 2-24 (i.e., initialize the database,
enter the configuration settings, etc.).

To edit a data source:

1

2

Double-click the data source.
Follow the steps in the DSN configuration wizard to edit the data source.

When the wizard completes, click Test Data Source, and then click OK until the
wizard closes.
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To select a data source:
In the Select ODBC Data Source dialog box, click the data source, and then click OK.

To remove a data source:

Important! ¢ Before you remove a data source, make sure that the data source is not
used for any of the purposes specified in Setting a Unique Identifier for an
ODBC Data Source. For example, you are using multiple databases for Web reporting.

1 Follow Steps 1 through 3 in To create a data source: on page 4-5.
2 Click the data source that you want remove, and then click Remove.

3 Click OK until the Select ODBC Data Source dialog box closes.

Setting a Unique Identifier for an ODBC Data Source

Note ¢ This section is applicable only if you are using multiple databases or you are
using one database with multiple data sources.

Data sources are used by both the CIMS Server Web Reporting Web site and CIMS Data
Collectors. If you are using multiple databases with CIMS Server, you need to use a UID
to identify each data source in the following situations:

B You want to use multiple data sources for Web reporting (see Using Multiple Databases
for CIMS Server Web Reporting on page 4-9).

B You have multiple data sources with Windows authentication enabled and you want
to run scripts against these databases.

B You have multiple data sources with SQL Server authentication enabled (regardless
of whether you are using the data sources for Web reporting or a running scripts
against the data sources). In this situation, a UID is required for each data source to
store the SQL Server user ID and password for that data source.

If you are using a single data source, a UID is not required. Enter the SQL Server user
ID and password in the Select ODBC Data Source dialog box (see Managing ODBC
Data Sources on page 4-5).

You also need to use a UID if you have a database with separate SQL Server logins for
the CIMS Server administrator or administrators and CIMS Server Web Reporting end
users. In this situation, you need to create a UID for the data source that the Web end
user will use to access the database. This may be the same data source used by the
administrator or a different data source as noted in Select and Configure the Database As
an ODBC Data Source on page 2-24.
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To add a data source UID:

1

In the CIMS Server Administrator main window, click System Administration »
Data Sources.

The Data Source List Maintenance dialog box appears.
Click Add.

In the Add Data Source dialog box, type a UID for the data source, and then click OK.
For convenience, you might want to use the data source name as the UID. For
example, if the data source name for the database is CSDEV, you can also use CSDEV as
the UID.

The Select ODBC Data Source dialog box appears.

Click the data source that you want to assign the UID to (if the data source does not
appear, add the source as shown in To create a data source: on page 4-5), and then do
one of the following:

¢ If the data source does not require a SQL Server user ID and password, click OK.

e If the data source does require a SQL Server user ID and password, type the ID and
password in the User ID and Password boxes, and then click OK.

Note ¢ If additional parameters are required to enable connection to the
database, type the parameters in the Additional Parameters box. For more
information, consult your SQL Server DBA.

Repeat this procedure for each UID that you want to add. (For an example of a
configured Data Source List Maintenance dialog box, see Figure 4-2 on page 4-9.)

To edit a data source UID, user ID, and password:

1

Click the UID, and then click Edit.
The Select ODBC Data Source dialog box appears.

Edit the data source user ID, password, or parameters or click ODBC Data Source
Administrator to change the data source configuration settings as shown in To edit a
data source: on page 4-6.

To remove a data source UID:

Click the data source UID, and then click Remove.
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Using Multiple Databases for CIMS Server Web Reporting

There are two scenarios for using multiple databases for Web reporting:

m One Web server with one virtual directory. This scenario allows you to point your
Web site to the default database set in CIMS Server Administrator. You can change the
default database as needed and then update CIMS Server Web Reporting to connect
that database.

m One Web server with multiple virtual directories. This scenario allows you to access
multiple databases without changing the settings in CIMS Server Administrator. You
can access multiple databases during a CIMS Server Web Reporting session by
creating individual virtual directories for each database other than the default
database.

Both scenarios can be used for development, testing, and upgrade purposes. However,
the second scenario is more commonly used.

To use one Web server and one virtual directory:

1 Click the UID for the database that you want to use, and then click Set As Default.
See example Figure 4-2.

ans Site Data Source List Maintenance

Wigw

Machine: | (LoCAL) j

| Data Source D | Data Source MName | Uszer ID | Parameters
CIMServer CIMSServer

A | Remave Ediit | Set az Default

Figure 4-2 - Data Source List Maintenance Dialog Box—Set As Default
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Click Upgrade Configuration on the Edit Configuration page of CIMS Server Web
Reporting or restart IIS. The correct data source should appear in the ODBC DSN field
on the Edit Configuration page.

Repeat this procedure each time you want to use a different database.

To use one Web server and multiple virtual directories:

A typical configuration for multiple virtual directories is one in which the default
directory is pointing to the production database and another directory is created to point
to a development database. Using this scenario as an example:

1

In CIMS Server Administrator, set the production database as the default data source
(see the steps in To use one Web server and one virtual directory: on page 4-9).

In Windows, copy the Web folder and its contents to create a Web site that will point
to the development database. If you installed CIMS Server in the default location, the
Web folder is in C:\Program Files\CIMSLab\Server.

In the new folder, open the WebReportingDataSource.asp file and enter the UID for
the development Web site as follows:

Application("WebSiteUID") = "UID" (where UID is the UID for the development Web
site, see To add a data source UID: on page 4-8).

Create a virtual directory that points to the path for the development Web site folder.
For assistance, consult your IIS administrator.

To access the database that you want, enter the Web site address that points to that
database in the Address bar of the browser used for CIMS Server Web Reporting.
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Managing Database Tables

CIMS Server Administrator includes many powerful tools for managing database tables
used with the CIMS Server system. You can easily create, drop, load, export, and view
database tables.

About Exporting, Loading, Dropping, and Creating Tables

The following is a description of the drop, create, export, and load functions used for
database tables:

Exporting a table from the database creates a comma-delimited text file with the same
name as the table, but does not remove the table or its data. Exporting a table is useful
as a means of backup.

Loading a table into the database first deletes all data currently in the table and then
loads the table file from the file in the directory that you specify. The file must have
the same name as the table (e.g., CIMSRate.txt for the CIMS Rate table).

WARNING - Extreme caution should be used when loading a table. Deleting or
overwriting data can cause unexpected results. Be sure a backup exists before
performing this procedure.

Dropping a table removes the table and its data from the database. You should consult
CIMS Lab before dropping a table (see Contacting Technical Support on page 6-7).

Creating a table creates the table with no data in the database after the table is
dropped.
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Loading and Exporting Tables

To load or export a table:

1 In the main CIMS Server Administrator window, click System
Administration » Database » Database Table Manager.

The Database Table Manager dialog box appears as shown in Figure 4-3.

@44 Database Table Manager

Tools  Wiew

[ Select Takbles |

Tahle Exists in Databaze | Owner  #

At - Client Yes dhao Create selected tables
O it - Rate Yes dho
O Aucit - Transaction Yes dho Drop selected tables
D Calendar Yes dbo
O cliert Yes dho
O cliert Bucget ves dba Load selected tables
D CI!ent Contact Ves too Export selected tables
D Client Contact Mumber Yes dbo

D Configuration - General Yes dbo
D Configuration - Account Levels Yes dbo
O cPU Mormalization Yes dho
D Configuration Options Yes dbo
M Detail Yes dbo b

Ohiject Prefic: Select all tables

Figure 4-3 « Database Table Manager Dialog Box

Note ¢ CIMS Lab strongly recommends that you leave dbo. in the Object Prefix
box. This prefix sets the owner of the tables to dbo in SQL Server allowing any
authorized database user to view the tables.

2 Toload atable, select it in the list of tables. To select all table check boxes, click Select
all tables. Note that the ability to select all tables is dependent on the privileges
assigned by the SQL Server DBA.

3 Click Load Selected Tables or Export Selected Tables. A dialog box appears,
prompting you to select the location that you want to load tables from or export
tables to. Select the correct folder, and then click OK.
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Managing Database Tables

The most commonly exported and loaded tables are the CIMS Client and CIMS Rate
tables and their related tables. You can export and load these tables from the Database
Table Manager or you can use the Chargeback Tables dialog box. This dialog box

includes only client and rate-related tables.

To load or export a client or rate table:

1 In the main CIMS Server Administrator window, click Chargeback
Administration » Chargeback Table Maintenance » Table Manager.

The Chargeback Tables dialog box appears.

2 Select the tables that you want to export or load as shown in example Figure 4-4.
(Note that if you select Client or Rate, all related tables are selected by default. You

can clear those tables that you do not want.)

@42 Chargeback Tables

Wigw

[ Select Takbles |

v Client
v Client Budget
v Client Contact
Jv Client Contact Number

CER

i7 R.ate Group
[v Rate To Rate Group
v Rate Shift

Export Selected Tables Load Selected Tables | Close |

Figure 4-4 - Chargeback Tables Dialog Box

3 Click Export Selected Tables or Load Selected Tables. A dialog box appears,
prompting you to select the location that you want to load tables from or export

tables to. Select the correct folder, and then click OK.

Creating and Dropping Tables

To create or drop a table:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Table Manager.

The Database Table Manager dialog box appears.

2 Select the table(s) you want to create or drop. To select all tables, click Select all

tables.

3 Click Create Selected Tables or Drop Selected Tables. A confirmation message

appears. Click Yes.
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Converting Daily Summary Tables to a Monthly Summary Table

You can consolidate your daily CIMS Summary records so that data is stored in an
aggregated monthly record. This consolidation minimizes storage (there is typically a 90
percent or greater reduction in records) and decreases the time required to generate
monthly reports. A drawback to this consolidation is that you cannot run costed daily
reports against the CIMS Summary table.

To perform the consolidation process, use the ConvertSummaryDailyToMonthly.wsf
script. For more information about this script, see page C-5.

Important! « You should consult CIMS Lab before using this script (see Contacting
Technical Support on page 6-7).

Purging Data from the CIMS Detail and CIMS Detail Ident Tables

The CIMS Detail and CIMS Detail Ident tables can accumulate a large amount of data.
To control the size of these tables, you can specify the number of months of database
loads that you want to maintain in the tables. For example, if you specify six months, the
data loaded to the database during the current month and the preceding six months is
maintained. All data loaded to the database with load dates prior to the specified number of
months is removed permanently, not archived.

To set the number of months that you want to maintain, use the PurgeDetail.wsf script.
For more information about this script, see PurgeDetail.wsf on page C-9.

Important! ¢ You should consult CIMS Lab before using this script (see Contacting
Technical Support on page 6-7).

Updating the Rate Identifiers Table

B 4-14

A key feature of viewing invoices in CIMS Server Web Reporting is the ability to drill
down on the units consumed for a resource by identifier. This feature uses the CIMS Rate
Identifiers table, which contains the rate codes that are processed from the input resource

file(s) and correlates them to their corresponding identifier names in the CIMS Ident
table.

If the identifiers in the CIMS Server Resource File changed and/or a rate code or codes in
the input file have changed, the CIMS Rate Identifiers table will retain unused data in
addition to the current data. Although this does not cause processing problems, the table
can accumulate a large amount of data. To update the table so that it contains only the
current data, in the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Update Rate Identifiers.
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Viewing Tables

To view tables, in the CIMS Server Administrator main window, click System
Administration » Database » Table Viewers » Table Name.

Note ¢ To view other details about a table, see Managing Database Objects on
page 4-16.
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Managing Database Objects

WARNING - Certain reports are dependent on database objects. Dropping or altering
database objects could disable these reports.

In addition to tables, there are three types of database objects in CIMS Server:

m Views. Each view is essentially a saved SQL statement that performs a query that
allows the system to generate a report or reports.

m Stored Procedures. Each procedure is set of SQL statements that can perform both
queries and actions that allow the system to generate a report or reports. Stored
procedures can accept parameters at runtime, whereas views cannot.

B Indexes. These are files that contain the SQL statements that define how a table index
is created. A table index allows the database program to find data in a table without
scanning the entire table. There can be multiple indexes per table or no index at all.

All three types of database objects are XML files. The standard database objects that are
included with CIMS Server are located in C:\Program Files\CIMSLab\Admin\
DBObjects\Standard (if you installed CIMS Server in the default location). You can also
create custom objects and store them in the Custom folder. If you create a custom object
with the same name as a standard object, CIMS Server uses the custom object.

Creating and Dropping Database Objects

You can create or drop (completely remove) standard or custom database objects in the
database.

To create or drop database objects:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Objects Manager.

The Database Objects Maintenance dialog box appears as shown in Figure 4-5 on
page 4-17.
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1{ Database Objects Maintenance

Wigw

Object Location:  |standard - Object Type: |AII j
Definition File | Type “ersion | Exists | Cvner | Description #
D CIMSSp_Account_Summary Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_AuditClient Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_AuditClientContact Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_AuditClientContacthumber Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_AuditRate Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_AuditTransaction Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_BATCH Procedure  01.000000 Yes dbo Implemeritst
D CIMESp_CAP1 Procedure  01.000000 Yes dbo Implemeritst
D CIMSSp_CICS Procedure  01.000000 Yes dbo Implemeritst
DCIMSSp_ConvertSummaryDainToMonthly Procedure  01.000000 Yes dbo Implemeritst
D CIMZSp_DB2 Procedure  01.000000 Yes dbo Implemeritst
D CIMZSp_Detail_by_RateGroup Procedure  01.000000 Yes dbo Implemeritst
<|_| CIMSSn Detail by RateGroon Idertifier Procedure 01 ODOOON. Yes rbhn Imnlﬁmﬁrﬂ)ﬂt b,
COhject Prefix: '7 C:\Pragram Files\CIMSLab\&dminDBObjects\Standard

Select Al Drop Selected Ohjects | Create Selected Ohjects |

Figure 4-5 « Database Object Maintenance Dialog Box

Note ¢ CIMS Lab strongly recommends that you leave dbo. in the Object Prefix
box. This prefix sets the owner of the objects to dbo in SQL Server allowing any
authorized database user to view the objects.

2 In the Object Location list, click the location of the database objects that you want to
create or drop (i.e., the Standard or Custom folder).

3 In the Object Type list, click the object type (Index, Stored Procedure, or View) or
accept the default (All).

4 Select the object(s) that you want to create or drop. To select all object check boxes,
click Select All.

5 Click Create Selected Objects or Drop Selected Objects. A confirmation message
appears. Click Yes.

Note ¢ If the user ID that you are using to access the database does not have
sufficient system administration authority, you might not be able to create
database objects or to create objects with the appropriate permissions. In this
situation, a warning message appears recommending that you contact your
database administrator or CIMS Lab before continuing.

To confirm that an object exists in the database, make sure that Yes appears in the Exists
column for that object.
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Loading, Archiving, and Purging the Database

This section provides the procedures for loading, archiving, and purging the CIMS Server
database using the CIMS Server Administrator. You can also perform the functionality
described in this section via batch scripts.

Loading the Database

B 4-18

You can configure CIMS Server to automatically load process output files at the end of
processing (see CIMS Server Administrator Processing on page 5-17) or you can load the

process output files using the procedures in Loading from CIMS Server. In most cases, the
latter method is used for testing or debugging purposes only.

You can also load database files from CIMS Desktop and CIMS Mainframe Data
Collector and Chargeback System into the CIMS Server database.

Note * You may receive a warning message verifying that you want to overwrite data.
This probably means that you are loading duplicate data. You should delete the
previous load immediately after completing the current load (see Tracking the History
of Database Loads on page 4-26).

Loading from CIMS Server

This section describes how to load process output files into the CIMS Server database.
Note that this process is normally not required because the output files are automatically
loaded at the end of processing.

To load a database from CIMS Server:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » From CIMS Server. The CIMS Server File
Load dialog box appears as shown in example Figure 4-6.

== CIMS Server, File Load

Wigw

[ CIMS File Type ]

(* jdert: " CIMSACCT Detail CIMSBILL Detail " Summary

[ File Infarmeation |

File: Mame: |

Wiewy File Select File ...

Destination:  CIMSServer

Jv Use bulk load interface

Load Data | Close |

Figure 4-6 « CIMS Server File Load Dialog Box
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2 Complete the dialog box as follows:
e CIMS File Type. Click one of the following:

 Ident. This is the identification file that contains fields such as User ID,
department code, division code, server name, etc. These fields are used during
account code conversion to create your account code structure.

e CIMSACCT Detail. This file is created by CIMSACCT. It provides an account
code for each input file record processed. This file is used as an input into
CIMSBILL. You will rarely need to load this file.

e CIMSBILL Detail. This file is created by CIMSBILL. This file is loaded into the
database for use in the drill down reports. This file contains resource utilization
data.

The CIMSBILL Detail File differs from the CIMSACCT Detail File in that the
CIMSBILL Detail File reflects any proration, CPU normalization, or include/
exclude processing that was performed. The CIMSBILL Detail File also includes
accounting dates.

e Summary. This is a file created CIMSBILL that contains summarized usage
records with rates applied to them. You can load any number of summary files
individually.

For more information about these files, see Chapter 5, Processing Data.

¢ File Name. Enter the path of the database file that you want to load. To browse for
a file, click Select File. To view the file in Windows Notepad, click View File.

e Use Bulk Load Interface. Select this check box to perform a bulk load when
loading the database. This option is recommended because it increases the speed
of loads. A disadvantage is that if there is an error in the data, a generic rather than
specific error message appears. In this case, clear this check box and reload to view
the specific error message.

3 Click Load Data.
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Loading from CIMS MVS (0S/390)

Note * You should only load a database from a CIMS mainframe summary file if you are
instructed to do so by CIMS Lab. This method should only be used if you have run

CIMS Mainframe Data Collector and Chargeback System prior to version 11.5; it is
not a standard procedure. Loading the mainframe summary file eliminates all drill

down reporting capabilities of that loaded file.

This section describes how to load database files from CIMS Mainframe Data Collector

and Chargeback System into the CIMS Server database.

To load a database from CIMS Mainframe Data Collector and Chargeback System:

1 In the CIMS Server Administrator main window, click Chargeback

Administration » Database Loading » From CIMS MVS.

The CIMS MVS File Load dialog box appears as shown in example Figure 4-7.

&t CIMS MVS File Load

Wigw

[ CIMS File Type ]

@ iiert! " Rate

[ File Infarmeation |

™ Summary

File: Mame: |

Destination:  CMSServer

Wiewy File Select File ...

Load Data | Close |

Figure 4-7 « CIMS MVS File Load Dialog Box

2 Complete the dialog box as follows:

e CIMS File Type. Click one of the following:

¢ Client. The Client file from CIMS Mainframe Data Collector and Chargeback
System. The Client file contains the formal descriptions for each client
represented by your account code structure. For more information, see Working
with Clients on page 3-16. It is recommended that you maintain the Client file in one

location on the CIMS Server server, not the mainframe.
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¢ Rate. The Rate file from CIMS Mainframe Data Collector and Chargeback
System. The Rate file is a list of all rates that have been defined for your
installation. CIMS Server uses each rate to calculate a cost for each resource
being reported. For more information, see Working with Rates on page 3-9. It is
recommended that you maintain the Rate file in one location on the CIMS Server
server, not the mainframe.

e Summary. This is a file created by the CIMS Mainframe Data Collector and
Chargeback System version of CIMSBILL that contains summarized usage
records. You can load any number of Summary files individually. Note that if you
load the CIMS mainframe summary file, end users will lose all drill down reporting
capabilities.

¢ Enter the path of the database file that you want to load. To browse for a file, click
Select File. To view the file in Windows Notepad, click View File.

3 Click Load Data.

Loading from CIMS Desktop

This section describes how to load CIMS Desktop database files into the CIMS Server
database.

To load a database from CIMS Desktop:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » From CIMS Desktop.

The CIMS Desktop Table Load dialog box appears as shown in example Figure 4-8.
Wigw

[ CIMS Desktop Takle Type |

" Client " Rate ™ Summary

[ CIMS Desktop Database |

Filename: |

Select MDB File ...
UzeriD: Pazsword:

Destination:  CIMSServer

Load Data Cancel

Figure 4-8 « CIMS Desktop Table Load Dialog Box
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2 Complete the dialog box as follows:
e CIMS Desktop Table Type. Click one of the following:

¢ Client. The client file from CIMS Desktop. The Client file contains the formal
descriptions for each client represented by your account code structure. For
more information, see Working with Clients on page 3-16.

¢ Rate. The Rate file from CIMS Desktop. The Rate file is a list of all rates that have
been defined for your installation. CIMS Server uses each rate to calculate a cost
for each resource being reported. For more information, see Working with Rates
on page 3-9.

e Summary. This is a file created by the CIMS Desktop version of CIMSBILL that
contains summarized usage records. You can load any number of Summary files
individually. Note that if you load the summary file from CIMS Desktop, end users
will lose all drill down reporting capabilities.

* File Name. Enter the path of the database file that you want to load. To browse for
a file, click Select MDB File.

3 Click Load Data.
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Archiving, Purging, and Restoring Database Loads

You can archive, purge, and restore database loads. Archive, purge, and restore are

defined as follows:

m Archive. Saves selected CIMS Summary, CIMSBILL Detail, CIMS Ident, and/or
CIMSACCT Detail loads in a format that you can reload (restore) into the database.
Archiving does not remove the load from the database.

m Purge. Deletes selected loads from the database.

B Restore. Reloads selected purged loads into the database. To use this feature, the

loads must be archived.

You can archive loads, archive and purge loads, or purge loads without archiving them.
To view a history of the loads that have been archived or purged (deleted), see Tracking

the History of Database Loads on page 4-26.

To archive database loads:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Load Archiving & Purging.

The Load Archive dialog box appears as shown in example Figure 4-9.

2= Load Archive

v Show Archived Loads

irchive ] Restore | Purge |
[ Matching Loads - 9]

Wiew
[ Loads Fitter]
EndDeteRenge:  [Use Al Dates =] || o | |
Load Types: ¥ Summary W CIMSBILL Detail v Idert ¥ CIMSACCT Detail
Saurce Fils Location: [ -] Apply Fiters

Losd D Losd Type Source

000000020 CIMSBILL Detail

C:\Program FilesW IMSLak\Sample Processes 053900810t txt

000000021 Ident CiProgram FilesWCIMSLabiSample Processest0S3900dent fd
000000013 Summary
000000014 CIMSBILL Detail

000000015 Idernt

C:\Program FilesyCIMSL: ple Proce LBl
C:\Program FilesWIMSLabiSample Processes MSIS-Web BillDetail td
C\Program FilesCIMSLakiSample Processes MSIS-WWebident td

000000010 Summsry

Archive Storage Path: C\Program Files'CIMSLabbAdminiArchivetdCIMS Server
Select Al |

ammary bt 3

C\Program FilesWCIMSLakiSample Processes\CIMSWINEvertLogBillSummary txt - 38

000000011 CIMSBILL Detail — C:\Program FilesiCIMSLabnSample Processes\CIMSWInEyertLogBillDetail 3
000000012 Ident CWProgram Files'CIMSLakiSample Processes(CIMSWInEvertLogildent txt 3r
< »

Archive ‘

[ Purge loads after archiving

Ready.

Cloze

Figure 4-9 « Load Archive Dialog Box

CIMS Server Administrator's Guide

4-23 N1



B Database Administration
Loading, Archiving, and Purging the Database

2 Inthe Loads Filter area, set the following filters. These filters determine the loads that
appear on the Archive tab. For example, you can select only CIMSBILL Detail loads
or only those loads with end dates that are in a certain date range.

e End Date Range. Loads are selected by the end date stored in the CIMS Load
Tracking table. Click Use All Dates, Use Specific Dates, or a date keyword to select
loads with end dates that fall within the specified date range. For example, if you
click Current Month, loads with end dates in the current month are selected. If
you select Use Specific Dates, enter the dates in the from/to boxes.

e Load Type. Select the check box or boxes for the load types that you want to
archive. These are the loads created by CIMS Processing Engine. For more
information, see Chapter 5, Processing Data.

e Source File Location. Click All to select loads from all applicable process
definitions or click a specific process definition (see CIMS Server Administrator
Processing on page 5-17).

¢ Show archived loads. Select this check box to show loads that have been archived.
This filter appears only when the Archive tab is active.

3 Click Apply Filters to retrieve the loads that match the filter criteria. (Note that you
need to click Apply Filters each time that you change the filter settings.)

4 If you want to purge the loads after they are archived, select the Purge loads after
archiving check box.

5 On the Archive tab, click the load or loads that you want to archive or click Select All,
and then click Archive.

The archived loads are stored in a Zip file in the folder specified on the Archiving tab of
the Configuration dialog box (see Database Load Archive Settings on page 3-54). The
naming convention for the Zip file is CIMSArchive_StartDate_EndDate_
SequenceNumber. zip.

Important! ¢ Ifyou initialize a database, you should delete any archived files for that
database. Errors can occur if you try to reload these files to the originating database
or another database.
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To purge database loads:

Important! < Purging removes database loads from the database. If the loads are not
archived before they are purged, you cannot restore the loads to the database.

To purge loads automatically after they are archived, click the Purge loads after
archiving check box on the Archive tab.

To purge loads independently of archiving:

1 Setand apply the filters for the loads that you want to purge as described in To archive
database loads: on page 4-23.

2 On the Purge tab, click the load or loads that you want to purge or click Select All,
and then click Purge.

To restore database loads:

1 Setand apply the filters for the loads that you want to restore as described in To archive
database loads: on page 4-23.

2 On the Restore tab, click the individual load or loads that you want to restore or click
Select All, and then click Restore.
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Tracking the History of Database Loads

You can track the history of CIMS Summary, CIMSBILL Detail, CIMS Ident, and
CIMSACCT Detail files that have been loaded to and/or deleted from the database.

To track loads:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Load Tracking.

The Load Tracking dialog box appears as shown in example Figure 4-10.

=49 Load Tracking

View  Edit

Fiters Loads ]

Matching Loads: 9

Load ID | Load Type

9 Summary 3 14 00 :

20 CIMSBILL Detail  ©S5390 3MEB2004  3M802004 580 302202004 10:45:18 &AM
| Ident Q5380 3MEB2004  3M802004 216 32202004 10:45:18 &AM
13 Summary MSIS-ieh 3MEB2004  3M802004 6 32202004 10:4217 &AM
14 CIMSBILL Detail  MSIS-Veh 3MEB2004  3M802004 278 32202004 10:4217 &AM
15 Ident MSIS-ieh 3MEB2004  3M802004 1958 32202004 10:42:18 &AM
10 Summary CIMSWinEventLog  3M8/2004 34852004 2 32202004 10:42:10 &AM
(A CIMSBILL Detail  CIMSWinEventLog 31572004 3018/2004 6 32202004 10:42:11 AW
12 Ident CIMSWinEventLog  3M8/2004 34852004 18 32202004 10:42:11 &AM

£ >

Delete Load Select Al | Wiewy Load |

Close

Figure 4-10 « Load Tracking Dialog Box

2 Use the Loads tab to track the files that have been loaded to the database. This tab
provides information such as the type of file loaded, the start and end dates in the
files, the date the files were loaded to the database, and whether the files have been
archived. You can delete and view loads as follows:

¢ Delete Load. To remove a load or loads from the database, click the load(s) or
click Select All to select all loads, and then click Delete Load.

¢ Delete Load Entry. To remove a deleted load or loads from the database, click the
load(s), and then click Delete Load Entry. Deleted loads appear when using the
Show deleted loads filter on the Filters tab.

e Select All. To select all loads, click Select All.

e View Load. To view a load, click the load, and then click View Load.
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3 Use the Filters tab to determine the loads that appear on the Loads tab. For example,
you can choose to track only CIMSBILL Detail File loads or only files that were loaded
during a certain date range.

Load Type. Select the check box or boxes for the load types that you want to view.
These are the loads created by CIMS Processing Engine. For more information, see
Chapter 5, Processing Data.

Source File Location. Click All to view loads from all applicable process
definitions or click a specific process definition (see CIMS Server Administrator
Processing on page 5-17).

End Date Range. Loads are selected by the accounting end date of the data in the
loads. (Note that CIMSACCT Detail loads are selected by the usage end date.)
Click Show All Dates, Use Specific Dates, or a date keyword to select loads with
end dates that fall within the specified date range. If you select Use Specific Dates,
enter the dates in the from/to boxes.

Date Loaded Range. Click Show All Dates, Use Specific Dates, or a date keyword
to select loads that were loaded within the specified date range.

Show deleted loads. Select this check box to view loads that have been deleted.

Apply Filters. Click this button to view the loads that match the filter criteria.
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Profiling the Database and Tables

You can view profiles of the database and tables. These profiles provide detailed

attributes of the data.

To view praofiles of a database or table:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Profiler.

The Database Profiler dialog box appears.

2 Under Database, you can navigate to view attributes of the database. Under Tables,
you can navigate to a specific table and view Dates (created or modified), Columns,
Indexes, or Properties information. See Figure 4-11.

an Database Profiler

+- Connection
+--SGL Server Details
= Tables (41]
+- CIMECalendar
= CIMSClient
+- Dates
+--Columns (14)
= Indexes (3]
+ P __CIMSClient__G7FEGS14
+o D _CLNT_ACCTHAME
+ D _CLMT_ALTCODE
Properties (1)
CIMSClientBudget
CIMSClientContact
CIMSCliertContacthlumber
CIMSConfig
CIMSConfigdoccountLevel
CIMSConfigOptions
CIMSCPUNormalization
CIMSDetail
CIMSDetaillcent
CliSHeadline

Performance Monitar

F- - - F-F-E - - - E -

v

Refresh | Close |

Figure 4-11 - Database Profiler Dialog Box
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Upgrading the Database

Important! ¢ Back up the database or make sure that it has recently been backed up
before you upgrade the database.

The new version or release of CIMS Server might contain a new database version. In this
case, you will receive notification that a database upgrade is available when you start
CIMS Server Administrator. Click Yes, and then click Upgrade Database. If you have
more than one database, you will receive this notification each time that you select a
database that is not the latest version.

You can also click System Administration » Database » Upgrade Database to view the
status of and/or upgrade a database.

Note « CIMS Lab strongly recommends that you leave dbo. in the Object Prefix box
of the Upgrade Database dialog box. This prefix sets the owner of CIMS Server
database objects to dbo in SQL Server allowing any authorized database user to view
the objects.
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This chapter provides an overview of the data processing cycle and components and
describes how to use CIMS Server Administrator to set processing options.
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About Processing Data

CIMS Server processes IT resource usage data from any application, system, or operating
system on any platform. The primary method for loading this data into CIMS Server is
the CIMS Server Resource File. The records in this file contain a header, start and end date
and time, shift code, and multiple identifiers and resources (for the record layout, see
page B-2).

Note ¢ Although the CIMS External Transaction File is also supported, CIMS Lab
recommends that you use the more flexible and efficient CIMS Server Resource File.

The CIMS Data Collector(s) that you are using to collect your system data automate the
data processing cycle (see CIMS Data Collectors on page 1-5). The collectors convert usage
metering files created by your system into CIMS Server Resource Files. The collectors
then process the data in the files and load the resulting output files into the database
using the CIMS Processing Engine components CIMSACCT.d11, CIMSBILL.d11,
CIMSSORT.d11, CIMSAdminlLib.d11, and CIMSResr1.d11.

CIMS Server Administrator is used to set the processing settings required by the key
processing programs, CIMSACCT and CIMSBILL. These programs are responsible for
assigning accountability and cost for resources consumed, respectively. The process
settings for CIMSACCT and CIMSBILL are described in CIMS Server Administrator
Processing on page 5-17.

Although not intended for daily processing, you can also process CIMS Server Resource
Files using CIMS Server Administrator. For example, you can use CIMS Server
Administrator to process the sample files that are provided with CIMS Server for
demonstration purposes or to process miscellaneous transactions that are not processed
by a CIMS Data Collector. To process files using CIMS Server Administrator, see
Processing Data Using CIMS Server Administrator on page 5-31.
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Data Processing Frequency

B 5-4

The preferred method of processing is to run the full data processing cycle as the data
becomes available. The data produced by the various operating systems (OS/390, UNIX,
Windows, Open VMS, etc.) and applications/databases (CICS, DB2, Oracle, IIS,
Exchange Server, etc.) are usually made available for processing on a daily basis. Other
feeds such as manpower accounting, voice telephone, dedicated lines, etc., are normally
produced on a monthly basis.

There are several advantages to running the full costing cycle on a daily or data
availability basis:

B The volume of data created makes it more practical to process daily. A single mid-
sized Proxy Server might produce millions of records each day. It is more efficient to
process these records each day of the month rather than try to run many millions of
records through the processing cycle at month end.

m [t is easier to catch processing errors when the data is reviewed on a daily basis. It is
more difficult to troubleshoot a problem when it is discovered at month end. If an
unusual increase in utilization is observed for a specific resource at month end, the
entire month’s records must be checked to determine when the increase first took
place.

Because there are fewer jobs, transactions, or records to review, the task of
determining what caused the utilization spike is much simpler if caught on the day
in which it occurred.

m [f the program CIMSBILL is run monthly, the start date is the first day of the month
and the end date is the last day of the month. Because of this date range, it is not
possible to view the CIMS Summary Records for a single day or week. The smallest
time range that may be used is the entire month.
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CIMS Processing Engine is composed of COM objects. Each object performs particular
functions in the processing cycle. Table 5-1 describes the CIMS Processing Engine COM
objects in the order that they appear in the processing cycle and the output files created
by the objects as applicable.

CIMS Processing Engine

For a description of the properties and methods of these objects, refer to the CIMS Data

Collectors for Microsoft Windows Installation and User Guide.

COM Object

Description

Output Files

CIMSACCT.d11

CIMSSORT.dT11

CIMSBILL.dT1

Performs account code conversion,
shift determination, date selection,
and identifier extraction on the data
contained in the CIMS Server
Resource File or other input file. The
input file could be the CIMSACCT
Detail File previously produced by
CIMSACCT.

For more information about
CIMSACCT, including a description
if its input and output files, see
page 5-6.

Converts the CIMSACCT Detail file
and produces a sorted version that is
ready to be processed by CIMSBILL.

For more information about
CIMSSORT, see page 5-10.

Processes the sorted CIMSACCT
Detail File from CIMSSORT and
performs shift processing, CPU
normalization, proration, and
include/exclude processing and
creates files that contain the billing
information used to generate
invoices and reports.

For more information about
CIMSBILL, including a description
of its input and output files, see
page 5-10.

CIMS Ident. This file is
loaded into the
database.

CIMSACCT Detail. This
file is input into
CIMSSORT or can be
reprocessed through
CIMSACCT.

Sorted CIMSACCT
Detail. This file is input
into CIMSBILL.

CIMSBILL Detail. This
file is loaded into the
database or can be

reprocessed through
CIMSBILL.

CIMS Summary. This
fileis loaded into the
database or can be
reprocessed through
CIMSACCT.

Table 5-1 « CIMS Processing Engine Components
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COM Object Description Output Files

CIMSAdminLib.d11 Containsthe class CCIMSCBSLoad that
loads the output files from
CIMSACCT and CIMSBILL into the
database.

For more information about
CIMSAdminLib, see page 5-14.

CIMSResrl.dl11 Supports CIMSACCT and
CIMSBILL.

Table 5-1 + CIMS Processing Engine Components (Continued)

CIMSACCT

CIMSACCT is the first data processing program that is executed. CIMSACCT processes
the records in the input file (see CIMSACCT Input on page 5-7) and performs the
following:

m Identifier extraction and account code conversion. CIMSACCT extracts the
identifiers from the input file records and creates the CIMS Ident File, which is loaded
into the database. It also uses specified identifiers to build the account code and
perform account code conversion if required. For more information, see Setting Up
Account Codes and Performing Account Code Conversion on page 5-33.

m Date selection. CIMSACCT selects the input file records to be processed based on the
specified date range. For more information, see Date Selection on page 5-22.

m Shift determination. CIMSACCT can use the shift code from the input file records or
recalculate the shift using the start date/time in the records. For more information, see
Shifts Subtab on page 5-24.

CIMSACCT produces the CIMSACCT Detail File, which contains records that are
properly formatted for input into CIMSBILL.

Reprocessing CIMSACCT and CIMSBILL Output Files

You can reprocess the CIMSACCT Detail File and the CIMS Summary File from
CIMSBILL through CIMSACCT. This is usually done to reprocess data for further account
code conversion. To reprocess these files during the data collection process, you need to
modify the ProcCIMS.wsf script. For assistance, contact CIMS Lab (see Contacting
Technical Support on page 6-7).
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CIMSACCT Input

Table 5-2 lists the input and processing files used by CIMSACCT. These files are in the
process definition subfolders in the Processes folder.

The file names in Table 5-2 are the default names. Because these file names are
referenced in the scripts used by CIMS Server, CIMS Lab recommends that you use these
default file names. If you change the file names, you need to change the file names in the
applicable scripts.

File Type File Name Description

Input Files (CIMSACCT can process usage data from any of the following sources)

CIMS Server CurrentCSR.txt  This is the most commonly used file for

Resource File processing data through CIMS Server. This
file format is produced by all CIMS products
for importing data into CIMS Server.

To view the CIMS Server Resource File file
layout, see CIMS Server Resource File on

page B-2.
CIMS External User determined Although the CIMS External Transaction File
Transaction File is supported, CIMS Lab recommends that

you use the CIMS Server Resource File for
input into CIMS Server. This format is more
flexible and efficient than the CIMS External
Transaction File.

CIMSACCT Detail.txt This file is the output from a previous run of
Detail File CIMSACCT.

This file provides an account code for each
input file record. This file is input into the
CIMSSORT process.

When used as input into CIMSACCT, this
file is used primarily in the reprocessing of
data for date selection or further account
code conversion.

The records within this file are also referred
to as maintenance or 991 records.

CIMS Summary File BillSummary.txt This fileis the output from a previous run of
CIMSBILL. When used as input into
CIMSACCT, this file is used primarily for
reprocessing data for further account code
conversion.

Table 5-2 + CIMSACCT Input
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File Type File Name Description

Processing Files

Control File AcctCntl.txt This file contains the CIMSACCT control
statements (see CIMSACCT Control
Statements on page D-3).

Account Code AcctTabl.txt This optional file contains the account code

Conversion Table conversion table (see Creating an Account

B 5-8

Code Conversion Table on page 5-38).

Process Control File ProcessCntl.txt This file contains the processing statements
used by CIMS Server Administrator (see
Processing Control Statements on page D-27).

Table 5-2 « CIMSACCT Input (Continued)
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CIMSACCT Output

Table 5-3 lists the CIMSACCT output files. These files are in the process definition
subfolders in the Processes folder.

The file names in Table 5-3 are the default names. Because these file names are
referenced in the scripts used by CIMS Server, CIMS Lab recommends that you use these
default file names. If you change the file names, you need to change the file names in the
applicable scripts.

File Type File Name Description

CIMSACCT Detail.txt This file provides an account code for each

Detail File input file record. This file is input into
CIMSSORT.

CIMS Ident File Ident.txt This file contains all the identifiers (such as

as user ID, jobname, department code,
server name, etc.) that are contained in the
input records. These identifiers are used
during account code conversion to create
your target account code structure.

This file is loaded into the database.

CIMSACCT AcctMsg.txt This file contains processing messages
Message File related to CIMSACCT.
CIMSACCT AcctResults.txt This file contains the CIMSACCT processing
Results File results.
Exception File AcctExcp- This is an optional file in CIMS Server
yyyymmndd. txt Resource File format that contains all
(if the input file  records that did not match during account
1s Processed code conversion. These files can be
using the reprocessed through the processing cycle as
ProcCIMS.wsf described in About Exception File Processing
script) on page 5-14.
or To produce this file, you must have

Exception.txt  exception file processing enabled (see
(if the input file ~ P38€ 5-35).

is Processed Note that if the input file was processed
using CIMS through CIMS Server Administrator, you
Server should rename the output exception file so

Administrator)  that it is not overwritten if subsequent files
are created.

Windows Message Events are written to the Windows Event

Events Viewer when the CIMSACCT process starts
and ends and when and warnings or errors
are encountered while processing.

Table 5-3 « CIMSACCT Output
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CIMSSORT

CIMSBILL

B 5-10

CIMSSORT converts the CIMSACCT Detail File and produces a sorted version that is
ready to be processed by CIMSBILL.

CIMSSORT also combines multiple files into one file. For example, you can use
CIMSSORT to combine CIMSACCT output from three different data input types into one
file. To use this function, you need to create the CTextFileMergeSort object rather than
CTextFileSort in the ProcCIMS.wsf script. For more information, contact CIMS Lab (see
Contacting Technical Support on page 6-7).

The cost of information services, and which departments are using the services, is of
considerable interest to an organization. When users are made aware of the costs and are
held financially responsible for those costs, they are more likely to use the resources in
a prudent manner. CIMS Server provides comprehensive computer center billing
through the program CIMSBILL.

The primary function of CIMSBILL is to perform cost extensions within CIMS Server and
to summarize cost and resource utilization by account code. CIMSBILL uses the rate
table assigned to the client (see Working with Clients on page 3-16) to determine the
amount to be charged for each resource consumed. It is possible to have a unique rate
table for each client.

There are specific rules that CIMSBILL follows when charging resource consumption:

m If a resource has a corresponding entry with a monetary amount in the rate table, the
number of resource units are multiplied by this amount. The result appears in the
CIMS Summary Records.

m If a resource has a corresponding entry with no or zero currency amount in the rate
table, a zero cost appears in the CIMS Summary Records for that resource.

m If a resource does not have a corresponding entry in the rate table, the data for that
resource does not appear in the CIMS Summary Records.

m If none of the resources in the CIMSBILL input file have a corresponding entry in the
rate table, the CIMS Summary File will contain no records. If the Load Summary
records check box is selected in CIMS Server Administrator (see page 5-19), the CIMS
Ident File, CIMSBILL Detail File, and CIMS Summary File are not loaded to the
database—the process fails and a failure message is issued. You must have at least one
rate code from the input file in the rate table to produce CIMS Summary Records.

If the Load Summary records check box is not selected, the CIMS Ident File and
CIMSBILL Detail File load to the database if the Load Ident records and Load
CIMSBILL Detail records check boxes are selected.
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In addition to standard costing, CIMSBILL also performs the following:

B Processes non-standard costs such as miscellaneous, recurring, and credit
transactions. For more information about creating and using transactions, refer to the
CIMS Server Web Reporting User’s Guide.

m Performs proration. See Prorating Resources on page 5-43.
m Performs CPU Normalization. See Normalizing CPU Values on page 5-49.

m Performs include/exclude processing. See Include/Exclude Processing on page 5-52.
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CIMSBILL Input

Table 5-4 lists the input and processing files used by CIMSBILL. These files are in the
process definition subfolders in the Processes folder.

The file names in Table 5-4 are the default names. Because these file names are
referenced in the scripts used by CIMS Server, CIMS Lab recommends that you use these
default file names. If you change the file names, you need to change the file names in the
applicable scripts.

File Type File Name Description

Input File

CIMSSORT/ Detail.txt This is the sorted Detail File from
CIMSACCT Detail CIMSACCT.

File

CIMSBILL Detail File BillDetail.txt  This fileis the output from a previous run of
CIMSBILL. When used as input into
CIMSBILL, this file is used primarily for
performing additional proration functions.

To reprocess this file during the data
collection process, you need to modify the
ProcCIMS.wsf script. For assistance, contact
CIMS Lab (see Contacting Technical Support
on page 6-7).

CIMS Summary File BillSummary.txt This fileis the output from a previous run of
CIMSBILL. When used as input into
CIMSBILL, this file is used primarily for
performing additional proration functions.

To reprocess this file during the data
collection process, you need to modify the
ProcCIMS.wsf script. For assistance, contact
CIMS Lab (see Contacting Technical Support
on page 6-7).

Processing Files

Control File BillCntl.txt This file contains the CIMSBILL control
statements (see CIMSBILL Control Statements
on page D-14).

Process Control File ProcessCntl.txt This file contains the processing statements
used by CIMS Server Administrator (see
Processing Control Statements on page D-27).

Proration Table User determined This optional file contains the proration
table (see To create a proration table: on
page 5-44).

Table 5-4 « CIMSBILL Input
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CIMSBILL Output

Table 5-5 lists the CIMSBILL output files. These files are in the process definition
subfolders in the Processes folder.

The file names in Table 5-5 are the default names. Because these file names are
referenced in the scripts used by CIMS Server, CIMS Lab recommends that you use these
default file names. If you change the file names, you need to change the file names in the
applicable scripts.

File Type File Name Description

CIMSBILL Detail File BillDetail.txt This file is loaded into the database for use
in drill down reports. This file contains
resource utilization data.

The CIMSBILL Detail File differs from the
CIMSACCT Detail File in that the CIMSBILL
Detail File reflects any proration, CPU
normalization, or include/exclude
processing that was performed. The
CIMSBILL Detail File also includes
accounting dates.

CIMS Summary File BillSummary.txt This file is loaded into the database for use
in producing reports. This file contains both
resource utilization and cost data.

Prorate Report ProrateRep.txt  This is an optional report that contains the
original record and all subsequently-
generated prorated records. To enable this
report, see page 5-43.

CIMSBILL BillMsg.txt This file contains processing messages
Message File related to CIMSBILL.

CIMSBILL BillResults.txt This file that contains the CIMSBILL
Results File processing results.

Windows Message Events are written to the Windows Event
Events Viewer when the CIMSBILL process starts

and ends and when and warnings or errors
are encountered while processing.

Table 5-5  CIMSBILL Output
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CIMSAdminLib

CIMSAdminLib is the central controlling library for all Windows-based CIMS Server
functions. It contains all the COM objects used to manipulate CIMS data. These objects
are called from CIMS Server Administrator and Windows Script Host (.wsf) scripts used
by CIMS Data Collectors and CIMS Server.

CIMSAdminLib contains the class CCIMSCBSLoad that loads the output files from
CIMSACCT and CIMSBILL into the database.

Account Codes and Account Code Conversion

Within chargeback and resource accounting, an account code uniquely identifies an
individual, billing, or reporting entity. The actual definition of what the account code
represents depends on how CIMS Server is used. For example, an account code can
represent an organization, a department in an organization, or an individual.

A key feature of CIMSACCT is its ability to convert the identifier values in the CIMS
Server Resource Files into account codes. In some cases, the identifier value in the CIMS
Server Resource File is the actual account code. However, in most cases, the identifier
value represents the source of the consumed resources (i.e., a user ID, IP address, server
name, jobname, transaction ID, terminal ID, etc.).

CIMSACCT uses an account code conversion table to convert identifier values into an
account code. For example, an IP address of 10.26.12.255 is converted to the account
code for Human Resources while an address of 10.26.12.260is converted to the account
code for Accounts Payable. These departments can then be charged for the consumption
of the resources associated with their IP addresses.

For the steps required to set up account code conversion, see page 5-33. For an example
of these steps, see page 5-40.

About Exception File Processing

B 5-14

During account code conversion, CIMSACCT might encounter input file records that do
not match any entry in the account code conversion table. CIMSACCT includes an
optional exception file processing feature that automatically identifies and removes
unmatched records so that they can be reprocessed with the correct accounting
information.

When this feature is enabled, all unmatched records are output to an exception file in the
process definition subfolder. You can use the exception file to identify the information
that needs to be corrected, either in the records in the exception file or in the account
code conversion table, and then reprocess the exception file.

To enable the exception file processing feature, see Setting the Account Code Conversion
Options on page 5-35. For assistance in processing exception files, contact CIMS Lab (see
Contacting Technical Support on page 6-7).
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Accounting Dates

CIMS Server input records contain a usage start date and end date that specify the date
range in which the resources in the record were consumed. CIMSBILL uses the usage end
date to calculate accounting start and end dates, which are used for billing and reporting.
The accounting start and end dates may be the same as or different than the usage end
dates (see How Accounting Dates are Calculated).

The accounting start and end dates are stored in the following fields in the CIMSBILL
output files:

m CIMSBILL Detail File. The accounting dates are in the ACCOUNTING-START-DATE and
ACCOUNTING-END-DATE fields (starting positions 159 and 168, respectively).

m CIMS Summary File. The accounting dates are in the AccountingFromDate and
AccountingToDate fields (starting positions 167 and 175, respectively). The Period
and Year fields also reflect the accounting end dates. (These fields are at starting
positions 282 and 284, respectively.) For example, if the end date is 20040916 and the
date falls within the 9th period in the CIMS Calendar table, the Period field would
contain 09 and the Year field 2004.

About the Close Date

You can set an optional close date for processing input file records. Records that contain
usage end dates before or after this date are processed as described in How Accounting
Dates are Calculated. The close date can be a specific date or a day of the month (the first,
fifteenth, thirtieth, etc.). To set a system-wide close date, see page 3-44.To set close dates
for an individual process definition or definitions, see page 5-26.

How Accounting Dates are Calculated

The accounting dates are calculated according to the usage end dates and the close date
(see About the Close Date). The accounting dates and usage end date are always the same
in the following situations:

m If no close date is set.

m If both the CIMSBILL run date and the usage end date are in the same period (as set
in the CIMS Calendar table), regardless of the close date.

m If the CIMSBILL run date is prior to the close date and the usage end date is in the
previous period.

m If the CIMSBILL run date and the usage end date are after the close date.
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The accounting dates and usage end date are different in the following situations:

m If the CIMSBILL run date is after the close date, but the usage end date is prior to the
close date, the accounting dates are set to the previous day from the day CIMSBILL
was run.

For example, if the first of each month is your close date and you process an input file
with a usage end date of 20030930 (September 30) on October 15, the accounting start
and end dates will be 20031014 (October 14).

m [f the CIMSBILL run date is prior to the close date and the usage end date is in a period
prior to the previous period, the accounting dates are set to the last day of the previous
period.

For example, assume that the periods in the CIMS Calendar table are defined as the
first day of the month to the last day of the month and that the fifteenth of each
month is your close date. If you process an input file with a usage end date of
20030827 (August 27) on November 1, the accounting start and end dates will be
20031031 (October 31). October 31 is the last day of the previous period.
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CIMS Server Administrator Processing

In CIMS Server Administrator, you can set processing definitions that instruct CIMS
Server how to execute processing jobs for different types of input resource data. A process
definition is a folder that contains the files required to process usage data from a
particular source such as a database, operating system, or application.

The settings that you select for the process definition are stored in the AcctCnt1.txt,
Bi11Cnt1.txt, and ProcessCntl.txt files in the process definition folder. AcctCnt1.txt
and Bil11Cntl.txt contain the CIMSACCT and CIMSBILL control statements,
respectively. (For a list of these statements, see page D-3 and page D-14).
ProcessCntl.txt contains process settings used by CIMS Server Administrator (see
page D-27).

You can edit these files using a text editor or through CIMS Server Administrator. For
example, if you select the Perform Account Code Conversion check box in CIMS Server
Administrator (see page 5-35), the control statement ACCOUNT CODE CONVERSION is
automatically added to the AcctCntl.txt file.

Adding Process Definitions

When you add a process definition, CIMS Server Administrator builds a folder within the
process definition path (see Processing Settings on page 3-44) and creates the necessary
process definition files within this new folder. The folder shares the name of the process
definition.

To add a process definition:

1 In the main CIMS Server Administrator window, click Chargeback
Administration » Processing » Process Definitions. The Process Definitions List
Maintenance dialog box appears as shown in example Figure 5-1.

= Process Definitions List Maintenance

View

Pracess Definitions ~

CIMSWINEvertlog
CIMEWINPrint
CIMSWInPracess
DBSpace
MSExchance
MSExchangehbs
MSIS-teh
MSSaL2000
OE380
OS390CICE
OS380082
DS380D1sk
OS3A05MFE
Transactions
Universal
UnixDB2
UnixDB2Starage
UnixFs

UnixORA

| nise B 0 howrac,

Program Files1CMSLabiSample Processesi

v

Add | Remaove

Exclit ‘ Rename Process ‘

Close

Figure 5-1 « Process Definitions List Maintenance Dialog Box
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4

Click Add.

Type a name for the process definition in the Add New Process Definition dialog box,
and then click OK.

The Edit Process Definition dialog box appears.

Edit the new process definition as needed (see Setting Process Definition Options).

To remove or rename a process definition, click the definition in the Process Definitions
Maintenance List dialog box and click Remove or Rename.

Setting Process Definition Options

B 5-18

The Edit Process Definition dialog box includes a number of tabs and subtabs that
contain settings for the process definition. The main tabs are:

Process Options

CIMS Account Options
CIMS Bill Options
Process Results

Versions

The following sections describe the options that are available on these tabs by subtab.
Where applicable, the correlating control or processing statement for each option is also
provided.
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Process Options Tab
This tab contains the following subtabs: General, Processing, and Database.

General Subtab

This subtab displays the name and path of the process definition. You can also use this
tab to add a description of the process definition.

Setting Correlating Control File and Statement

Process Definition Path None

The path for the process definition folders.
The use of a UNC path is recommended
(e.g., \\CIMS-SRVI\D$\CIMS\Processes).

Process Name None

The process name. This name is also shared
by the folder that contains the process
definition files.

Process Description File: ProcessCntl.txt
Type an optional short description of the Statement:

rocess definition. o o
p Description description

Processing Subtab

Use this subtab to specify the processing options such as processing programs that you
want to run and the output files that you want to load to the database.

Setting Correlating Control File and Statement

Run CIMS Account File: ProcessCntl.txt

Select this check box to instruct the system  Statement:
to run CIMSACCT as part of this process. RUNCIMSACCt Yes/No

Run CIMS Bill File: ProcessCntl.txt

Select this check box to instruct the system  Statement:
to run CIMSBILL as part of this process. RUNCIMSBi11 Yes/No

Remove output files before processing File: ProcessCntl.txt

Select this check box if you want to delete  Statement:
previous output files from the process
definition folder. This ensures that old data
is not loaded into the database. This check
box should be selected unless you are
running CIMSBILL or database loads only.

RemoveFilesBeforeProcessing Yes/No
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B 5-20

Setting

Archive process files

Select this check box to archive previous
output files before processing. Archived files
contain a date in the file name. Archived
files for the same date are indicated by a
number (1, 2, 3...) at the end of the file
name. Note that if you select this option,
you can potentially have a large number of
archived files in the process definition
folder.

Note: This option is not related to the
archive database loads feature described in
Archiving, Purging, and Restoring Database
Loads on page 4-23.

Load Ident records

Select this check box to load CIMS Ident
Files from CIMSACCT into the database.

Load Summary records

Select this check box to load CIMS Summary
Files from CIMSBILL into the database.

Load CIMSBILL Detail records

Select this check box to load CIMSBILL
Detail Files into the database.

Load CIMSACCT Detail records

Select this check box to load the CIMSACCT
Detail Files into the database. Consult CIMS
Lab before using this option (see Contacting
Technical Support on page 6-7).

Use bulk load interface

Select this check box to perform a bulk load
when loading the database. This option is
recommended because it increases the speed
of loads. A disadvantage is that if there is an
error in the data, a generic rather than
specific error message appears. In this case,
clear this check box and reprocess to view
the specific error message.

Correlating Control File and Statement

File: ProcessCntl.txt

Statement:
ArchiveProcessFiles Yes/No

File: ProcessCntl.txt

Statement:
AutolLoadIdentFile Yes/No

File: ProcessCntl.txt

Statement:
AutoLoadSummaryFile Yes/No

File: ProcessCntl.txt

Statement:
AutolLoadDetailFile Yes/No

File: ProcessCntl.txt

Statement:
AutolLoadResourceFile Yes/No

File: ProcessCntl.txt

Statement:
UseBulkLoadInterface Yes/No
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Database Subtab

Use this subtab to select the data source for the database in which you want to load the
output produced by CIMS Processing Engine.

Setting Correlating Control File and Statement
Data Source Name File: ProcessCntl.txt
Enter the name of the source of data. To Statement:

select another data source, click Browse. DSN name

Note that you will receive a warning if you

select a data source other than the data

source selected in the Select ODBC Data

Source dialog box. In most cases, you will

not need to process data using another data

source.

Database User ID/Password File: ProcessCnt1.txt

Type the user ID and password necessary for Statements:
the system to access the data source. For

. . . . DSNUID user ID
security purposes, this password is stored in
an encrypted format. DSNPWD password

Automatically generate ODBC INF file File: ProcessCntl.txt

from above parameters
Statement:

Leave this check box selected (the default). . arate0DBCINF Yes/No
This file is required by the Fujitsu COBOL

Workstation Run-time program required by

CIMS Processing Engine.
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CIMS Account Options Tab

This tab contains the following subtabs: General, Files, Account Codes, Shifts, and

Trace.

General Subtab

Use this subtab to specify general CIMSACCT settings such as the record type and date

range for the input records to be processed.

Setting

Correlating Control File and Statement

Process Type

Click the input record type to be processed
(CIMS Server Resource Records, External
Trans Records, CIMS Maintenance Records,
from CIMSACCT, or CIMS Summary
Records).

Date Selection

Click the date range for records to be
processed by CIMSACCT. Records are
selected by the end date in the record (the
accounting end date for CIMS Summary
Records and the usage end date for all other
record types). Click one of the following:

® No Date Selection

m Use Specific Dates. Enter the dates in the
Start and End Date boxes

® Run Date (Today). Selects records based
on the run date

m Previous Day to Current Day. Selects
records based on the run date and the run
date less one day

m Current Week. Selects records based on
the run week (Sat-Sun)

B Current Month. Selects records based on
the run month

B Previous Day. Selects records based on
the run date, less one day

B Previous Week. Selects records based on
the previous week (Sat-Sun)

B Previous Month. Selects records based on
the previous month.

File: AcctCntl.txt

Statement:

Process record type (see page D-11)

File: AcctCntl.txt

Statement:

DATE SELECTION YYYYMMDD YYYYMMDD/
keyword (see page D-6)
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Setting Correlating Control File and Statement

B Current Period from Calendar. Selects
records based on the current period from
the CIMS Calendar table.

B Previous Period from Calendar. Selects
records based on the previous period
from the CIMS Calendar table.

For example, if you click Current Month,
records with end dates in the current month
are processed.

Include Fields File: AcctCntl.txt

These fields allow you to move identifiers ~ Statement:
into an area that can be later used by

. . INCLUDE FIELD D-10
CIMSBILL for include/exclude processing. CL (see page )
For a complete description of this option
and include/exclude processing, see Include/
Exclude Processing on page 5-52.

Files Subtab
Use this subtab to define the CIMSACCT input and output files.

Setting Correlating Control File and Statement

Input File File: ProcessCnt1.txt

Enter the input file to be processed by Statement:
CIMSACCT. To select another file, click
Browse. To edit the file in Windows
Notepad, click Edit.

AcctInputFile filename

Output Files File: ProcessCntl.txt

The names of the CIMSACCT output files Statement:
(CIMSACCT Detail, CIMS Ident and
Exception). CIMSACCT writes these files to ) ]
the path listed above the file names. CIMS ~ AcctOutputlidentFile f7lename

Lab recommends that you use the default ~ AcctOutputExceptionFile filename
file names.

AcctOutputDetailFile f7ilename

Eliminate Duplicates None

If the input file contains duplicate
identifiers, selecting this check box
eliminates the duplicate identifiers from the
CIMS Ident File. Consult CIMS Lab before
using this option (see Contacting Technical
Support on page 6-7).
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B 5-24

Account Codes Subtab

This subtab allows you to build the account code from the identifiers in the input file
and to convert the account code if needed. For a description of the options on this subtab
and an explanation of account codes and account code conversion, see Setting Up Account
Codes and Performing Account Code Conversion on page 5-33.

Shifts Subtab

You can use the shift codes contained in the input record, or you can use this subtab to
recalculate the shift codes based on the start date and time in the input record.

For each shift, enter number and a time for the end of the shift. You can enter up to nine
shifts per day. For the related AcctCnt1.txt control statement, see page D-11.

To enable CIMSBILL to process shift codes, you need to select the Use Shift Codes check
box on the CIMS Bill Options/General subtab (see page 5-26).

Note * CIMSACCT will not recalculate the shift codes for CIMS Server Resource Files
produced by CIMS Mainframe Data Collector and Chargeback System. CIMS
mainframe records are aggregated using the shift code as one of the aggregation
points. Therefore, the time in the aggregated record is not representative of every
record within the aggregation. For more information, refer to the CIMS Mainframe
Data Collector and Chargeback System User Guide.
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Trace Subtab

Note ° By default, tracing is disabled. Consult CIMS Lab before using one of the
CIMSACCT trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSACCT Message File,
AcctMsg.txt:

B General processing. This is information related to CIMSACCT processing of the
information in the account, define, and move fields.

B Account code conversion. This is information related to the account code
conversion, including the information in the account, define, and move fields and
the account code conversion table, and the number of unmatched records (if

applicable).
Setting Correlating Control File and Statement
Trace flag File: AcctCntl.txt
Click Tracing Disabled, Y — Trace General Statement:
Processipg, or A — Trace Account Code TEST A or Y (see page D-12)
Conversion.
Check for bad file input None

Select this check box to validate each
identifier. Some systems may pass data in
identifier fields that are not valid ASCII
display characters. This can cause
unexpected results during processing. By
pre-validating the data, the system verifies
that the data passes through CIMS Server
successfully.

Note: This option slows down the
processing of CIMSACCT. Consult CIMS
Lab before using this option (see Contacting
Technical Support on page 6-7).
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CIMS Bill Options Tab

This tab contains the following subtabs: General, Files, Define Fields, Include/Exclude
Records, Proration, Client, and Trace:

General Subtab

Use this subtab to specify general CIMSBILL settings such as the record type and date
range for the input and output records, to set the close date if other than the system close
date, and enable other options such as CPU normalization and shift code processing.

Setting Correlating Control File and Statement

Process Type File: Bi11Cnt1.txt

The input record type to be processed (CIMS = Statement:
Detail Records or CIMS Summary Records).  ppocpss precord type (see page D-23)

Default Close Day File: Bi11Cnt1.txt

This option allows you to override the Statement:

system-wide close date set on the _ D-1
Processing tab of the Configuration dialog DEFAULT CLOSE DAY = rin (see page 8)
box (see page 3-44). Consult CIMS Lab
before using this option (see Contacting
Technical Support on page 6-7).

For more information about the close date,
see page 5-15.
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Setting Correlating Control File and Statement
Input—Date Selection File: Bi11Cnt1.txt

Click the date range for records to be Statement:

processed by CIMSBILL. Records are DATE SELECTION YYYYMMDD YYYYMMDD/

selected by the end date in the record (the
usage end date for CIMSACCT Detail
Records and the accounting end date for all
other record types). Click one of the
following:

keyword (see page D-17)

® No Date Selection

m Use Specific Dates. Enter the dates in the
Start and End Date boxes

B Run Date (Today). Selects records based
on the run date

B Previous Day to Current Day. Selects
records based on the run date and the run
date less one day

B Current Week. Selects records based on
the run week (Sat-Sun)

m Current Month. Selects records based on
the run month

m Previous Day. Selects records based on
the run date, less one day

B Previous Week. Selects records based on
the previous week (Sat-Sun)

B Previous Month. Selects records based on
the previous month

B Current Period from Calendar. Selects
records based on the current period from
the CIMS Calendar table.

B Previous Period from Calendar. Selects
records based on the previous period
from the CIMS Calendar table.

For example, if you click Current Month,
records with end dates in the current month
are processed.
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Setting

Output-Summary Date Range

This setting is used to determine the
accounting dates in the CIMSBILL output
files. To ensure that the accounting dates are
calculated correctly, CIMS Lab strongly
recommends that you use the default
keyword, Auto. This setting enables CIMS
Server to calculate the accounting dates as
described in Accounting Dates. Consult CIMS
Lab before changing this setting.

Back Load Data

When this check box is selected, the close
dateisignored. The accounting dates created
by CIMSBILL are the same as the usage end
date regardless of the close date.

Normalize CPU Values

Select this check box to normalize the
processing speeds of computers on the
system (see Normalizing CPU Values on
page 5-49).

Use Shift Codes

Select this check box to instruct CIMSBILL to
use the shift character specified in the
CIMSACCT Detail Record and apply the
appropriate rate shift value.

Correlating Control File and Statement

None

File: Bi11Cntl.txt

Statement:
BACKLOAD DATA (see page D-16)

File: Bi11Cnt1.txt

Statement:
NORMALIZE CPU VALUES (see page D-22)

File: Bi11Cnt1.txt

Statement:
USE SHIFT CODES (see page D-26)

Files Subtab

Use this subtab to define the CIMSBILL input and output files.

Setting Correlating Control File and Statement

Input File File: ProcessCnt1.txt

The input file to be processed by CIMSBILL. ~Statement:
To select another file, click Browse. To edit

BilllnputFile filename
the file in Windows Notepad, click Edit. P

Output Files File: ProcessCntl.txt

The names of the CIMSBILL output files
(CIMSBILL Detail and CIMS Summary).
CIMSBILL writes these files to the path listed
above the file names. CIMS Lab
recommends that you use the default file
names.

Statement:
BillDetailFile filename

Bi11SummaryFile filename
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Define Fields Subtab and Include/Exclude Records Subtab

These subtabs are used together to define data that you would like to include or exclude
for CIMSBILL processing. This is useful if there is certain data that your organization does
not want to report on. For a description of how to use these tabs, see Include/Exclude
Processing on page 5-52.

Proration Subtab

This subtab allows you to charge resources to more than one account. For a description
of the options on this subtab and how to use proration, see Prorating Resources on
page 5-43.

Client Subtab

CIMSBILL requires an account code structure to add new clients to the CIMS Client table
(see page 5-26) and to determine the applicable rate table for a client if the rate table is
other than STANDARD.

Use this tab to enable the optional client add and search features and to define the
account code structure for the clients. For more information about the account code
structure, see Setting Up the Account Code Structure.

Setting Correlating Control File and Statement

Enable client search File: Bi11Cnt1.txt

Select this check box to enable CIMSBILL to Statement:

search the CIMS Client table for the rate

table associated with a client. If this check CLIENT SEARCH ON (see page D-16)
box is not selected, the STANDARD rate

table is used for all clients.

Add new clients to Client table File: Bi11Cnt1.txt

Select this check box to instruct CIMSBILL to  Statement:

insert corresponding client entries in the i
CIMS Client table for all clients that have a DYNAMIC CLIENT ADD ON (see page D-21)
resource usage charge, but are not entered in

the table.

The inserted client entries will not include
descriptions or contacts.

Note: This option can quickly fill up the
CIMS Client table. Use this option with
caution.

Account Code Search Fields File: Bi11Cnt1.txt

Use these fields to specify the client account Statement:
code structure. In the Account Structure

- DEFINE (see page D-19
box, click the account code structure that (see pag )
you want to use, and then click Populate
Fields. The account code structure appears
in Fields 1-9.
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Trace Subtab

Note ¢ By default, tracing is disabled. Consult CIMS Lab before using one of the
CIMSBILL trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSBILL Message File,
Bil1Msg.txt:

m Date processing. Includes the CIMSBILL run date, the input file usage end date(s),
and accounting start and end dates.

m Rate processing. Includes rate code information from the rate code tables that are
used during processing.

B General processing. Includes options selected, high-low date calculation, and other
general processing messages.

m Client processing. Includes information related to the clients that are processed.

Setting Correlating Control File and Statement

Trace flag File: Bi11Cnt1.txt

Click Tracing Disabled, D - Trace Date Statement:

Processing, R — Trace Rate Processing, D-2
Y - Trace General Processing, or Z — Trace TEST D, R, ¥, or Z (see page 0)
Client Processing.
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Process Results Tab
This tab contains the following subtabs: CIMS Account, CIMS Bill, and Event Viewer:

CIMS Account and CIMS Bill Subtabs

B View Message File. Select this check box to view the most recent version of the
CIMSACCT/CIMSBILL Message File.

m View Results File. Click this to view the CIMSACCT/CIMSBILL Results File, which
describes results of the most recent CIMSACCT/CIMSBILL processing.

m View Detail File. Select this check box to view the CIMSACCT/CIMSBILL Detail File.
m View Ident File (CIMSACCT only). Click this to view the CIMS Ident File.

m View Exception File (CIMSACCT only). Click this to view the exception file. This
button is unavailable if no exception file is available.

B View Summary File (CIMSBILL only). Click this to view the CIMS Summary File.

B View Proration Report (CIMSBILL only). Click this to view the proration report.
This button is unavailable if no proration report is available

m Use External Viewer. When you select this check box and then click one of the
preceding buttons, the files open in Windows Notepad.

m Word Wrap. Select this check box to enable word wrap for the displayed files.

m Copy to Clipboard. Click this to copy the contents of the currently displayed file to
the Windows clipboard

Event Viewer Subtab

m Show Process Events. Click this to view all process events in the Event Viewer (see
page 5-32)

m Show All CIMS Events. Click this to view all CIMS Server-related events in the Event
Viewer

m Start Windows Event Viewer. Click this to open the Windows Event Viewer and view
system-wide events

Versions Tab

This tab provides the version number and path for CIMSACCT, CIMSBILL, and
CIMSORT.

Processing Data Using CIMS Server Administrator

To process data using CIMS Server Administrator, click the process definition that you
want to process, and then click Process. You can also click Process in the Edit Process
Definition dialog box for the definition.
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Viewing Events

B 5-32

CIMS Server Administrator enables you to view system events related to CIMS Server and
the processing of CIMS data. This is helpful if you want to see details about a processing
job and any associated problems with it. To view these events:

In the main CIMS Server Administrator window, click Chargeback
Administration » Processing » Event Viewer. The Event Viewer dialog box appears.

Wigw

Machine: I [LoCAL) j

=0l x|

Processing

B

11l/z/2001
Ident File Load Process ID: Z00111021411Z2¢
lo/z3/2001
E‘ % Summary File Load Process ID: Z00L11022160711

; o Information: 3:07:11 PM: Load Parameters
€3 1 foruation: 3:07:17 PM: Load Results
Detail File Load Process ID: Z00110231&0700
Ident File Load Process ID: Z0011023160649
CIMEEILL Process ID: Z00Ll10Z3160644Z7
CIMS Sort Process ID: Z0011023160643
CIMEACCT Process ID: Z00L10Z316064Z68
Summary File Load Process ID: Z0O0110Z3160&EZ0

Event Message:

Process: Summary File Load
Process Id: 20011023160711
Load Results

Mumber of Records Loaded: 1534
Source System: Server

Source Feed: CIMS

Load Tracking IC: 217

Lo

vyincowes Event Wiewer | Close |

Figure 5-2 « Event Viewer Dialog Box

2 Click any event to view the event message at the bottom of the dialog box. To view

Windows system-wide events, click Windows Event Viewer.

Note * To refresh the list of events in the Event Viewer dialog box, press <F5>.
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Setting Up Account Codes and Performing Account Code
Conversion

This section describes the account codes structure and how to define and convert the
account code.

Defining the Account Code Structure

One of the first steps in implementing CIMS Server is deciding on a final account code
structure. The structure is the chargeback hierarchy for the organization. The levels of this
hierarchy are arranged from highest to lowest level within the account code. The account
code can consist of up to 128 characters.

For example, your final account code structure could consist of:
DDDCCcccuuuuuuuu

D = Division (three characters) (highest level)

C = Cost Center (four characters)

U = User (eight characters) (lowest level)

The next step is to set the account code structure in CIMS Server Administrator, see
Setting Up the Account Code Structure on page 3-3.

Once you have set up the account code structure, you can create an account code
conversion table to convert the identifier values in the input file into an account code
that fits within the final hierarchy pattern.
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Defining the Account Code

The account code is derived from an identifier or identifiers in the input file. In CIMS
Server Administrator, you need to specify the identifier(s) that you want to use to define
the account code as follows:

m If the input file contains an Account_Code identifier, the Account_Code identifier value
is automatically used to define the account code. If this value fits your account code
hierarchy, you can use the value as your account code. If this value does not meet your
account code requirements, you can convert the value to the appropriate account
code.

m If the input file meets any of the following criteria, you need to specify an identifier
or identifiers that you want to use to define the account code:

¢ The input file does not contain an Account_Code identifier.

¢ The input file contains an Account_Code identifier, but you want to use other
identifiers instead.

e The input file contains an Account_Code identifier and other identifiers that you
want to use. In this case, you must define the Account_Code identifier in addition
to the other identifiers.

If the identifier values fits your account code hierarchy, you can use the value as your
account code. However, in most cases you will need to convert this value to the
appropriate account code.

The identifiers that you use (either via the Account_Code identifier values or the
identifiers that you specify) are referred to as the account code input field. For an
example of how to define an account code input field, see Figure 5-3 on page 5-41.

To define the account code input field:

Note ¢ You do not need to define the account code input field if the input file
contains the Account_Code identifier and you are using only it to define your account
code.

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Account Options tab.
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4 Complete the Account Codes subtab as follows:

e Account Fields. Define the identifier(s) that you want to use for the account code
input field beginning at Field 0 and continuing sequentially as needed.

If you want to use the full value for an identifier, use an offset of 1 and the length
of the longest identifier value. For example, if the longest identifier value is 7
characters, type 1 as the offset and 7 as the length.

If you want to use a portion of the identifier value, use the offset position at which
you want to start the value and the corresponding length. For example, if you want
to start the 7-character identifier value at the second character, type 2 as the offset
and 6 as the length. You could also select a shorter length if you wanted to further
reduce the identifier value length.

You can define up to 10 account fields (Field 0 - Field 9). Each account field value
can be a maximum of 255 characters. The overall length of all account fields added
together cannot exceed 500 characters.

The corresponding control statement in the AcctCnt1.txt file is ACCOUNT FIELD
(see page D-5).

* Convert account fields to uppercase during processing. Select this check box to
convert lowercase account code input field values to uppercase values in the
resulting account code. For example, the value ddic would be converted to DDIC.
By using this option, CIMSACCT account code processing becomes case-
insensitive and makes defining account conversion tables much easier.

The corresponding control statements in the AcctCnt1.txt file is UPPERCASE
ACCOUNT FIELDS (see page D-13).

Setting the Account Code Conversion Options

To perform account conversion, regardless of whether you are using the Account_Code
identifier or another identifier, you need to set the conversion options described in this
section and create an account code conversion table as described on page 5-38. Account
codes are assigned by matching identifier values in the input file records to the values in
the account code conversion table.

For an example of how to set the account code conversion options, see Figure 5-3 on
page 5-41.

To set the account code conversion options:
Complete the Account Codes subtab as follows.

B Perform Account Code Conversion. If this check box is selected, the account code
conversion occurs as defined by the following Define Field and Move Field settings
and the account code conversion table:

The corresponding control statement in the AcctCnt1.txt file is ACCOUNT CODE
CONVERSION (see page D-5).
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B 5-36

m Define Fields. Use this area to specify the offset and length of account code input

field value that you want to use for conversion. Begin at Field 0 and continue
sequentially as needed. Note that if you created the account code input field using
account fields as described in To define the account code input field: on page 5-34, the
define fields correlate to the account field values, not to the original identifier values
in the input file.

For example, if you defined the following two identifiers as account fields, the
resulting account code input field value would be JJJJJJUUUUUUU, where J represents
the Jobname identifier and U represents the User identifier.

e Account Field 0—Jobname offset 2, length 6
e Account Field 1—User offset 1, length 7

You would set the Define Field 0 to offset 1, length 6 and Define Field 1 to offset 7,
length 7. You could also select a shorter length if you wanted to further reduce the
define field value.

You can define up to 10 define fields (Field 0 - Field 9). Each define field value can
be a maximum of 8 characters.

The corresponding control statement in the AcctCnt1.txt file is DEFINE FIELD (see
page D-7).

Move Fields. Use this optional setting to include either the define field(s) value or a
literal in the output account code.

If you specify a define field as the move field, the define field value will be included
in the account code. For example, if the define field represents the Jobname value DDIC,
DDIC will appear in the at the beginning, end, or within the account code as specified
in the account code conversion table.

If you specify a literal, the literal value will be included in the account code. For
example, if the type a literal value of A/P, A/P will appear in the at the beginning, end,
or within the account code as specified in the account code conversion table.

For an example of how move fields are used, see Account Code Conversion Example on
page 5-40.

Begin at Field 0 and continue sequentially as needed. You can define up to 10 move
fields (Field O - Field 9). Each move field value can be a maximum of 128 characters.

Note ¢ Although each move field can be up to 128 characters, keep in mind that
the total output account code, including any literals and move field values, cannot
exceed 128 bytes.

The corresponding control statement in the AcctCnt1.txt file is DEFINE MOVEFLD (see
page D-8).
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m Conversion Table. This is the file name for the account code conversion table. If the
table is located in the definition folder for the process, the file name appears without
the path. If the table is located in a location other than the process definition folder
(e.g., you are using the same table for multiple processes and have the table in a
central location), the file path appears.

To select a table, click Browse. To edit the table, click Edit. To create a table, see
Creating an Account Code Conversion Table on page 5-38.

The corresponding control statement in the ProcessCnt1.txt file is
ACCTCODECONVERSIONTABLE f77ename.

m Enable Exception Processing. Select this check box to enable exception file
processing. This instructs the system to write all non-matched records to an exception
file. If this check box is not selected, the records that are not matched are written to
the CIMSACCT Detail File with the unconverted account code input field value.

If you enable exception processing, do not include a default account code as the last
entry in the account code conversion table (e.g., ", ,DEFAULTCODE"). If a default
account number is used, records will not be written to the exception file.

The corresponding control statement in the AcctCnt1.txt file is EXCEPTION FILE
PROCESSING ON (see page D-9).

CIMS Server Administrator's Guide 5-37 N



B Processing Data

Setting Up Account Codes and Performing Account Code Conversion

Creating an Account Code Conversion Table

The account code conversion table contains the definitions required to convert the
identifier values defined by the account code input field to user-defined output account
codes. For an example of how to create the account code conversion table, see Figure 5-4
on page 5-42.

Consider the following when creating the account code conversion table:

B 5-38

The account code conversion table is case-sensitive. For convenience, you can enter
uppercase values in the table and then select the Convert account fields to uppercase
during processing check box on the Account Codes subtab (see To define the account
code input field:). This is especially helpful it you are using one account code
conversion table for multiple process definitions. This ensures that account code
input field values that are lowercase or mixed case are processed.

Each record in the table can be up to 306 characters (89 for the low identifier, 89 for
the high identifier, and 128 for the new account code). Note that the low and high
identifiers must be entered in fields of 8 bytes each, up to 10 fields, delimited by
commas. See the explanation for Step 2 under To create an account code conversion
table: on page 5-39.

Each 8-character low and high identifier field is compared to the corresponding
account code input field values. If the compares are true, the account code is assigned.

The low identifier fields are padded with x'00” and the high value fields are padded
with X'FF'.

The high identifier field is set equal to the low field plus the high padding when the
high identifier field value is null.

You can include a default account code as the last entry in the account code
conversion table by leaving the low and high identifier fields empty (e.g.,

", ,DEFAULTCODE"). In this case, all records that contain identifier values that do not
match an entry in the account code conversion table will be matched to the default
code.

If you do not include a default account code, input file records that contain identifier
values that do not match an entry in the account code conversion table are written to
the CIMSACCT Detail File with the unconverted account code input field value.

If you want unmatched records to go to an exception file for reprocessing at a later
time, you need select the Enable Exception Processing check box on the Account
Codes subtab (see page 5-35). If you enable exception file processing, make sure that
you have not included a default account code entry in the account code conversion
table.
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m If the PRINT ACCOUNT NO-MATCH statement is included in the AcctCnt1.txt file, a
message is printed in the CIMSACCT Message File showing the identifier values from
the input file that were not matched during account code conversion. If this statement
is not present, only the total number of unmatched records is provided. The system
prints up to 1000 messages.

B The number of definition entries that you can enter in the table is limited only by the
memory available to CIMSACCT.

To create an account code conversion table:

1 In the Conversion Table box, type a name for the table in the format f77ename.txt,
and then click Edit. CIMS Lab recommends that you name this file AcctTab1.txt as
referenced in the ProcCIMS.wsf script.

2 In the Account Code Conversion Table Maintenance dialog box, click Add Entry and
type the following for each account code input field value that you want to convert.

e The low and high identifier value that you want to use for conversion. You can
enter up to 10 fields of 8 bytes each for the low and high identifiers. Each field
must be delimited by a colon (:).

For example, if you type AA as the low identifier and CC as the high identifier, all
account codes that begin with characters greater than or equal to AA or less than
or equal to CC are converted to the specified account code. If you type
AAAAAAAA:BB as the low identifier and CCCCCCCC:DD as the high identifier, all
account codes that begin with characters greater than or equal to AAAAAAAABB or
less than or equal to CCCCCCCCDD are converted to the specified account code.

The asterisk (*) and the question mark (?) characters can be used as wildcard
characters for both the low and high identifiers. Note that using the wildcard
characters can degrade performance; use them only when needed.

If you do not set a high value, the value is equal to the low value by default.
e The account code value that you want to convert to (maximum of 128 characters).

3 To set additional account code conversion entries, click Insert Row. Click OK when
you are finished.

By default, the table is saved to the process definition folder. But you can move the table
to any location.
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Account Code Conversion Example

B 5-40

Note ¢ This section provides examples to supplement the preceding sections. Please
refer to these sections for more detailed information.

Assume that you want to use the User identifier values in an input file to define your
account code and that your account code is in the following structure:

DDDcCcccuuuuuuuu
D = Division (three characters) (highest level)
C = Cost Center (four characters)

U = User (eight characters) (lowest level)

The following table shows the User identifier values that are in the input file records and
the corresponding account code that you want to convert the value to.

User

Identifier Division Cost Center User

Value from Final Account Account Account
Input File Account Code Code Code Code

DDIC = FINACTGDDIC = FIN ACTG DDIC

SAP = [ISDDEVPSAP = ISD DEVP SAP
SAPCOMM = OPSMKTGSAPCOMM = OPS MKTG SAPCOMM
SAPSYS = MISPRODSAPSYS = MIS PROD SAPSYS
TEAM718 = MISTESTTEAM718 = MIS TEST TEAM718
TEAMF99 = OPSTESTTEAMF99 = OPS TEST TEAMF99

To convert the User identifier values to the final account code, you would complete the
steps in the following sections.
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Define the Account Code and Conversion Options for CIMSACCT

In this example, the User identifier is entered for an offset of 1 and length of 7 because

you want to use the entire identifier value and the longest values (SAPCOMM, TEAM718, and
TEAMF99) are 7 characters.

For account code conversion, you need to define the value from the account field at the
full 7-character length. Because you also want to include the account field value at the
end of the account code, you need to define a move field for the value.

=ns Edit Process Definition "SAP

Wigw
Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions

General ] Filez  Accournt Codes l Shifts ] Trace ]

Account Fields
Identifier Offzet Lencth M
Field 0 USER 1 T
Fieldl 1
Field 2
Field 3 2
Insert Entry | Remove Ertry

[v Convert account fields to uppercase during processing

Account Code Conversion
[v Perform &ccount Code Conversion

Define Fields: tdove Fields:
Offzet Length | # Offzet Length | Literal .

Field 0 1 7 Field 0 1 7

Fieldl 1 Fieldl 1

Field 2 Field 2

Field 3 & Field 3 &
—_ InsertErtry | Remove Entry Insert Entry | Remove Ertry
Carvversion Table:  |acctTabl tut Browse .. Edlt ..

[v Enable Exception Processing

Process Ok | Cancel | Apply |

Figure 5-3 « Defining the Account Code and Conversion Options Example
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Create the Account Code Conversion Table

The account code conversion table contains the following entries. Note that the high
identification code is not needed in this example because the low and high identification
codes are the same.

The @0 at the end of the account code value specifies that the move field defined in the
previous step will be included at the end of the account code. For example, the resulting
account code for the first table entry would be FINACTGDDIC. If you placed the @0 at the
beginning of the account code value, the resulting account code would be DDIC<three
spaces>FINACTG. You could place the @) anywhere in the account code.

4% Account Code Conversion, Table Maintenance

Tools

Account Table: C\Program FileshWCIMSLABSample ProcessestSAPACCt Tabl txd

Low Identification Code High Identification Code |Account Code Walue
DLDIC FINACTGEO
SAP ISDDEVPREO
SAPCOM OPSMETGEO
SAPETE MISPRODEO
TEAM71E MISTESTEO
TEAMF23 OPSTESTREO

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 5-4 « Creating the Account Code Conversion Table Example

If you had additional move fields defined, they would be represented by @1, @2, @3, etc.
For example, if you had used another identifier for account conversion in addition to
User and had defined move fields for each (move field 0 and move field 1), @1 FINACTG@0
would place the value for move field 1 a the beginning of the account code and the value
for move field 0 at the end of the account code.

Process the CIMS Server Resource File

The converted account codes appear in the CIMSACCT Detail, CIMSBILL Detail, and
CIMS Summary Files.
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Prorating Resources

Proration is taking the overall or individual costs incurred by an account and distributing
that cost across multiple accounts at a specified percentage. CIMS Server provides a very
efficient method of defining which resources should be split among one or more
accounts and the responsible percentage for each account.

A common use of proration is the equitable allocation of overhead costs across the user
community. An application or system that is normally assigned to the overhead category
tends to be one that does not produce metering data to the end user or account level, or
the processing of such data is considered too expensive to be practical at the end user or
account level.

For example, you have an application that controls print in a centralized environment.
To prorate the costs associated with this application among multiple accounts you need
to do the following:

B Assign the print program resource utilization and cost to a non-billable overhead
account.

m Set the proration options for CIMSBILL.

m Create a proration table assigning the percentage of print program costs for the non-
billable account to the accounts that you want to bill.

To set the proration options:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Bill Options tab.
4 On the Proration subtab, set the following options:

¢ Proration Type. Click type of proration to be performed: Resources or Money. For
a description of each option including its advantages and disadvantages, see
Prorating Resources vs. Prorating Money on page 5-48.

The corresponding control statements in the Bi11Cnt1.txt file are PRORATE MONEY
(see page D-23) and PRORATE RESOURCES (see page D-24).

¢ Match Length. The level of the account code that you want to match for proration.
For example, if you type 5, accounts AAABB, AAABBBB, and AAABBCC are
prorated. If you type 7, only accounts AAABBBB and AAABBCC are prorated.

This is included in the PRORATE MONEY or PRORATE RESOURCES statement in the
Bi11Cnt1.txt file. For example, PRORATE RESOURCES 5 where 5 is the match length.
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Proration Table. This is the file name for the proration table. If the table is located
in the definition folder for the process, the file name appears without the path. If
the table is located in a location other than the process definition folder (e.g., you
are using the same table for multiple processes and have the table in a central
location), the file path appears.

To select a table, click Browse. To edit the table, click Edit. To create a table, see To
create a proration table:.

The corresponding control statement in the ProcessCnt1.txt fileis Bi11MultFile
filename

Print Proration Report. Select this check box to create a proration report as part
of the process. The report will reside in the process definition folder.

The corresponding control statement in the Bi11Cnt1.txt file is PRINT PRORATE
REPORT (see page D-25).

To create a proration table:

1

3

4

In the Proration Table box, type a name for the table in the format f77ename. txt, and
then click Edit.

In the Proration Table Maintenance dialog box, click Add Entry and type the
following for each account that you want to prorate to.

The original account code that you want to prorate from.
The account code that you want to prorate to.

The percentage that you want to prorate to the account code.

Note * You can prorate resource costs at any percentage. The prorate
percentage can be less than or greater than 100 percent.

The individual rate code(s) that you want to prorate or A11 to prorate all rate codes.

To set additional proration entries, click Insert Row.

Click OK when you are finished.

By default, the table is saved to the process definition folder. But you can move the table
to any location.
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Proration Table Examples

Assume that you want to split all resources used by overhead account code AAABB
among three different accounts: AA1, AA2, and AA3. AA1 on average uses about 50

percent of the resources assigned to the AAABB account, AA2 uses about 30 percent, and
AA3 uses about 20%.

Complete the Proration Table Maintenance dialog box as shown in Figure 5-5.

@44 Praration Table Maintenance

Proration Table:  CProgram Files'CIMSLABSample ProcessesiGeorgeipurple txd

Original Account Code Mewy Account Code Percentage Rate Code
AALBE A1 a0 All
AALBE A2 30 All
AALBB A3 20 All

4| i ] >

Adld Entry Remove Entry In=ert Entry |

Figure 5-5 « Proration Example 1
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You can also split individual resources among multiple accounts. Using the preceding
example, assume that the only resources from account AAABB that you want to prorate

are represented by the rate codes Z001 and Z002. Create the proration table as shown in
example Figure 5-6.

@44 Praration Table Maintenance

Proration Table:  CProgram Files'CIMSLABSample ProcessesiGeorgeipurple txd

Original Account Code Mewy Account Code Percentage Rate Code
AALBE A1 a0 Zoo1
AALBE A2 30 Zoo1
AALBE A3 20 Zoo1
AALBE 21 a0 ooz
AALBE A2 30 ooz
AALBB A3 20 o0z

1l | >

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 5-6 « Proration Example 2

In this example, all resources other than Z001 and Z002 would still be charged to the
AAABB account.
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If you want to charge account AAABB for a portion of the resources used, for example
you want to charge account AAABB 40 percent and account AACCC 60 percent for all
resources, create the proration table as shown in example Figure 5-7.

@4 Proration Table Maintenance

Proration Table:  CProgram Files'CIMSLABSample ProcessesiGeorgeipurple txd

Original Account Code Mewy Account Code Percentage Rate Code
AALBE AALBE B0 All
28058 AALCC 40 Al

4| ! ] >

Add Entry iRemove Entry | Insert Entry |

OK Cancel |

L

Figure 5-7 « Proration Example 3
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Prorating Resources vs. Prorating Money

B 5-48

In CIMS Server Administrator, you can set the option to prorate on resources or on
money. Both options display the same prorated units and charges in Web reports.
However, you cannot drill down on resource units by identifier if you prorate by money.
The following describes the advantages and disadvantages of prorating resources and
prorating money:

Prorating resources. The CIMSACCT Detail File from CIMSSORT is prorated before
CIMSBILL applies rates and figures money and a new CIMSACCT Detail File is built with
all the prorated resources. The new CIMSACCT Detail File is then used in the CIMSBILL
process.

An advantage of prorating resources is that the CIMSBILL Detail Records match the
records in the CIMS Summary File. Therefore, users can drill down on resource units by
identifier when viewing invoices in CIMS Server Web Reporting. A disadvantage is that
the CIMSBILL Detail File can contain a potentially large number or records.

Prorating money. The CIMS Summary file is prorated just before CIMSBILL ends. A new
CIMS Summary File is built with the prorated values.

An advantage of prorating money is that the CIMSBILL Detail File contains fewer records
than it would if you prorated by resources. A disadvantage is that the CIMSBILL Detail
Records do not match the CIMS Summary Records and drilling down by identifier will
not produce accurate data.
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Normalizing CPU Values

Computers within an organization have different processing speeds. This speed
difference might cause users to request that their work be run on the faster machine to
reduce costs. This situation could lead to heavy workloads on the faster computers while
the slower units stand idle. To avoid this problem, you can normalize the processing
speeds to more evenly charge for CPU utilization. That is, you can assign a percentage of
the original CPU time used by a system rather than the actual time to be used during the
billing process.

For example, your organization has two OS/390 systems, AL90 and AL95. System AL95
is 20 percent faster than AL90. If you use AL95 as the base system, use a factor of .80 to
normalize AL9O0 to reflect the speed of AL95.

Note * Due to the disparity between the way different operating systems capture
performance statistics, it is not desirable to normalize the processor times between
platforms (e.g., 0S/390 to UNIX or UNIX to Windows).

To perform normalization, you need to do the following:

m Select the CPU Value option for the rate code or codes for which you want to perform
normalization.

m Set the normalization factor for the applicable system or systems.
m Select the Normalize CPU Values option for the process definition.

To set the rate code as a CPU value:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

2 In the Rate Code Maintenance List dialog box, click the rate code that you want to set
as a CPU value, (for example, OS/390 CPU Minutes [Z003]), and then click Edit.

3 Select CPU Value check box, and then click OK.

Note - If this item is not checked, the rate code value will not be normalized
during CIMSBILL processing.
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To set the normalization factor by system:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » CPU Normalization.

2 Click Add in the CPU Normalization Maintenance List dialog box.
3 Enter the following:

e System ID. The name of the system. For OS/390, this is the four-character System
Model ID, for UNTX and Windows, it is the computer name. Note that the input
file must contain an identifier named System_ID to identify the system name for
CIMSBILL.

e Work ID. The subsystem name. This is any other system value that can narrow the
normalization (i.e., the CICS region name, the DB2 plan name, the Oracle
instance, etc.). Note that the input file must contain an identifier named Work_ID
to identify the subsystem name for CIMSBILL.

e Factor. This is the actual normalization factor. In the example at the beginning of
this section, this would be .80.

4 Click OK.

An example of a configured CPU Normalization Maintenance List dialog is shown
Figure 5-8.

an5 CPL Normalization List Maintenance

Wigw

System ID | Application or Subsystem | Mormalization Factor

| o | |

Figure 5-8 « CPU Normalization Maintenance List Dialog Box

To edit or remove a factor, click the factor, and then click Edit or Remove. Note that you
cannot change the System or Work ID when you edit the factor.
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To set the CPU normalization option for the process definition:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Bill Options tab.
4 On the General subtab, select the Normalize CPU Values check box.

The corresponding control statement in the Bi11Cnt1.txt file is NORMALIZE CPU
VALUES (see page D-22).

About Ghost Machines

Many organizations attempt to perform normalization against a “ghost machine”. This
is the factor applied to all the processors in the enterprise today, using as a base the speed
of the slowest machine running in the environment. In an attempt to keep costing
philosophy as simple as possible, the old technology “ghost” system is kept as the
baseline for processor speed. This concept worked well when processor speeds were
relatively constant. However, as processor speeds continue to increase, it becomes
difficult to relate the higher CPU speeds of today’s computers to older technology. CIMS
Lab recommends that processor speed factors be restricted to those multipliers and
divisors applicable to the existing environment.
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Include/Exclude Processing

By default, CIMSBILL processes all records within the input CIMSACCT Detail file.
However, you might want to process only certain records or you might want to exclude
certain records. This is useful if there is data that your organization does not want to
report on.

You can exclude records by date using the date selection option in CIMS Server
Administrator. See page 5-22 to set this option for CIMSACCT and page 5-26 to set this
option for CIMSBILL.

You can also include or exclude records by identifier values in the records. For example,
you might want to exclude all records that contain a particular Jobname identifier value.

To include or exclude records by identifier values, you need to do the following in CIMS
Server Administrator:

m Define identifier fields that you want to use.

If the input record identifier fields that you want to include or exclude are other than
System_ID, Work_ID, or Account_Code, you need to define identifier fields that you
want to use. The values for these defined identifiers are stored consecutively
beginning at starting position 301 of the CIMSACCT Detail File (see page B-5 for the
file layout).

If you want to include or exclude System_ID or Work_ID identifier fields, you do not
need to define the fields. The values for these identifiers are always stored at starting
positions 57 and 90 (respectively) of the CIMSACCT Detail File.

If you want to include or exclude the Account_Code identifier field, you do not need
to define the field unless the account code has been converted. If the account code
has been converted, the code (stored in position 163 of the CIMSACCT Detail File)
will not match the Account_Code identifier value in the input record. You need to
define the field so that the original identifier value is used.

B Define the identifier fields for CIMSBILL.

m Specify whether you want CIMSBILL to include or exclude the defined fields.
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To define the input record identifier fields that you want to include or exclude:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Account Options tab.

4 On the General subtab, enter the following in the Include Fields area beginning at
Field 0:

e The identifier name that you want to use to include or exclude records. For
example Jobname, Server, User, etc.

¢ The offset position at which you want to start the identifier value that you want to
include or exclude. If you want to start the identifier value at the first character of
the value, type 1. If you want to start the identifier at the second character, type 2,
etc. For example, you could start the eight-character Jobname identifier value
DFMALEQ? at position 1, which specifies the full value or at any other position such
as position 4, which specifies just ALEQ2. This would specify that only those records
with Jobname identifier values that contain ALEO? are included or excluded from
processing.

¢ The length of the identifier value. This can be the entire length of the identifier
value starting at the offset position, or a shorter length. Using the preceding
example of ALEOZ, you might want just ALE. In this case, you would type a length
of 3.

Note ° The overall length of all include fields added together can not exceed
60 characters.

The corresponding control statement in the AcctCnt1.txt file is INCLUDE FIELD (see
page D-10).

If you want to specify more than one identifier for include/exclude processing repeat
these steps for each identifier. However, consult CIMS Lab (see Contacting Technical
Support on page 6-7) before doing this to determine if it is necessary.

To insert a row, click the row that you want to add the row above and then click Insert
Row. To remove a row, click the row that you want to remove, and then click Remove
Row.
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To define the identifier fields for CIMSBILL:
1 Click the CIMS Bill Options tab.

2 On the Define Fields subtab, click Add Entry and enter the following for each field
that you specified on the CIMS Account Options » General subtab (see page 5-53).

e Atwo-character ID for the identifier. You will use this ID to specify the records that
you want to include or exclude (see To include or exclude the defined fields in
CIMSBILL Processing).

* The offset position at which you want to start the identifier value that you want to
include or exclude. Unlike the offset position 1 through x that you specified for
CIMSACCT processing, this is the position in the CIMSACCT Detail File in which
the identifier value begins. As with the offset position used by CIMSACCT, you can
specify any offset position within the identifier value. For example, if the Jobname
identifier value DFM begins at position 301, you can set the offset at 302 to specify
just FM. This would specify that only those records with Jobname identifier values
that contain FM are included or excluded from processing.

e The length of the identifier value. This can be the entire length of the identifier
value starting at the offset position, or a shorter length.

e An optional description of the field.
The corresponding control statement in the Bi11Cnt1.txt file is Define (see page D-19).

To insert a field, click the field that you want to add the field above and then click Insert
Entry. To remove a field, click the field that you want to remove, and then click Remove
Entry. To add a field to the end of the field list, click Add Entry.

To include or exclude the defined fields in CIMSBILL Processing

On the Include/Exclude Records subtab, click Add Entry and enter the following for
each field that you specified on the CIMS Bill Options » Define Fields subtab:

m Click Include or Exclude.
m Click the identifier ID that you created in To define the identifier fields for CIMSBILL:.

m In the Low Value and High Value fields, type the range for the identifier values that
you want to include or exclude. For example, if you want to include only those
identifiers that start with ALI type ALI in both fields. If you want identifiers that start
with ALI and ALE, type ALE as the low value and ALT as the high value.

The corresponding control statements in the Bi11Cnt1.txt file are EXCLUDE (see
page D-21) and INCLUDE (see page D-22).

To insert entry, click the entry that you want to add the entry above and then click Add
Entry. To remove an entry, click the entry that you want to remove, and then click
Remove Entry. To add an entry, click Add Entry.
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Assume that you have a CIMS Server Resource File from a OS/390 system with the
following identifiers:

..System_ID,

..System_ID

..System_ID,

...System_ID
...System_ID
...System_ID

..System_ID

..System_ID,

..System_ID

ALIJ

ALIJ

ALLJ

,Work_ID
LALTJ,

Work_ID

,Work_ID
LALTJ,
JALTJ,
LALTJ,
JALTJ,

Work_ID
Work_ID
Work_ID
Work_ID

,Work_ID
LALTJ,

Work_ID

JJESZ,
LJESZ,
JJESZ,
JJESZ,
JJESZ,
JJESZ,
LJESZ,
LJESZ,
JJESZ,

Account_Code,ALI09999,
Account_Code,ALI09999,
Account_Code,ALI09999,
Account_Code,ALE09999,
Account_Code,ALE09999,
Account_Code,ALE09999,
Account_Code,ALU09999,
Account_Code,ALU09999,
Account_Code,ALU09999,

Include/Exclude Processing

Jobname,BKMALIOL,
Jobname, BKMALIOZ,
Jobname,BKMALIO3,
Jobname, DFMALEOQL,
Jobname, DFMALEQZ,
Jobname, DFMALEOQ3,
Jobname, LCHALUOT,
Jobname, LCHALUOZ,
Jobname, LCHALUO3,

Start_date,
Start_date,
Start_date,
Start_date,
Start_date,
Start_date,
Start_date,
Start_date,
Start_date,

20030714. ..
20030715. ..
20030716. ..
20030714. ..
20030715. ..
20030716. ..
20030714. ..
20030715. ..
20030716. ..

You want to exclude those records that contain DFM in the Jobname identifier value. Define
the identifier field as shown in Figures 5-9.

=ns Edit Process Definition '05390°

Wigw

General l Files ] Account Codes] Shifts ] Trace ]

Process Type: |CIMS Server Resource Records j

Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions

Inzsert Row | Remove Row

Date Selection
_ strtoate [T s |
Keyword: |N0 Date Selection j aR
Endl Diate:
Include Fields
Identifier Offzet Lencth M
Field 0 JOBMAME 1 3
Fieldl 1
Field 2
Field 3 2

Process

Cancel

Apply

Figure 5-9 « Edit Process Definition—Include Fields

In this example, only the first three characters of the Jobname identifier value are required.
Therefore, the offset is 1 and the length is 3.
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Next you need to define the identifier field for CIMSBILL as shown in example
Figure 5-10.

=42 Edit Process Definition "05390"

Wigw

Process Options I CIMS Account Optionz  CIMS Bill Options | Process Results I “ersions I

General I Filez= Define Figlds | Include f Exclude Recordsl Prorationl Client Search I Trace I

-~ Define Includes Exclude Fields

|Identifier | Offset |Length | Description
A1 301 3

Adld Entry Remove Entry In=ert Entry

Process | Ok I Cancel Apply |

% |

Figure 5-10 « Edit Process Definition—Define Fields Subtab

In this example, the Jobname identifier value is assigned the ID A1 and begins in position
301 of the CIMSACCT Detail File (the starting position for include/exclude identifier
values).
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Next you need define DFM as the exclude identifier value as shown in example

Include/Exclude Processing

Figure 5-11. Records that contain DFMas the first three characters of the Jobname identifier

value will not be processed.

@ Edit Process Definition ‘05390

Wigw
Process Options I CIMS Account Optionz  CIMS Bill Options | Process Results I “ersions I

General I Files I Define Fields  Include [ Exclude Records | Proraﬁonl Client Search I Trace I

~ Define Includel Exclude Records

[idertifier  [Low value | High value

I IncludeExclude

21 DFt DFt

Adld Entry Remove Entry In=ert Entry

Process | OK I

Cancel Apply |

% |

Figure 5-11 < Edit Process Definition—Include/Exclude Records Subtab
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Rebilling Rate Codes After Changing Rate Code Values
and/or Conversion Factors

B 5-58

You can recalculate rate codes that you previously processed and loaded into the CIMS
Server database using a different rate value and/or resource conversion factor without
reprocessing the data. That is, if you change the rate value and/or resource conversion
factor for a rate code in the CIMS Rate table, you can update the rate value and
conversion factor and recalculate the money value directly in the CIMS Summary table.
(For more information about the rate code value and resource conversion factor, see
Working with Rates on page 3-9.)

CIMS Lab provides the following scripts to perform this process:

B Rebill.wsf. This script updates the rate code value and recalculates the money value
for a rate code or codes in the CIMS Summary table. If you have not changed the
resource conversion factor for a rate code or codes, you do not need to run
ResourceConversion.wsf.

m ResourceConversion.wsf. This script updates the rate code resource conversion factor
in the CIMS Summary table. You need to run the Rebi11.wsf script after running this
script to recalculate the money value for the rate code.

Important! « Consult CIMS Lab before using the ResourceConversion.wsf script
(see Contacting Technical Support on page 6-7). If you run this script more than once
for the same rate code or codes, the resource units that are converted are the units
that were converted previously, not the original units. For example, if the
conversion factor for a rate code is Divide by 60 and the resource units are 120,
the resource unit value after calculating once is 2, after calculating twice it is.033
(2+60), etc.

This scenario is not applicable to the Rebil1.wsf script—you can run this script
multiple times for the same rate code or codes.

For the parameters required for these scripts, see page C-11.
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Troubleshooting and
Additional Information

This chapter describes problems you may encounter while setting up and using the CIMS
Server system and how to solve them. If you cannot find the answer to your question
here, please feel free to contact CIMS Lab (see Contacting Technical Support on page 6-7).
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General data processing problems .. ... .. e 6-2
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Data Processing Problems

General data processing problems
You can use the following tools to diagnose general data processing problems:

m Check the Process Results tab for the process definition (Chargeback
Administration » Processing » Process Definitions). This tab provides message and
results files for both CIMSACCT and CIMSBILL. These files provide information
about errors encountered during processing. Also, click Show All CIMS Events on the
Event Viewer subtab and check for unusual messages.

B When processing data using CIMS Server Administrator, check the status bar in the
lower left corner of the Edit Process Definition dialog box to note the point in the
processing cycle that the error occurs.

B Check the Load Tracking dialog box (Chargeback Administration » Database
Loading » Load Tracking) to see of any database loads have completed.

For database problems:

m Enable the Simple recovery model for SQL Server (see Setting the Database Recovery
Model on page 4-4) to decrease the size of the SQL Server log files.

B View the messages in the SQL Server log (Program Files » Microsoft SQL
Server » MSSQL » Log.

When account codes are converted using CIMSACCT, some records seem
to be lost

Records that do not match any account code entries in the account code conversion table
are written to CIMSACCT Detail File with the unconverted account code. If you want
unmatched records to go to an exception file for reprocessing at a later time, you must
enable exception processing in CIMS Server Administrator (see Setting the Account Code
Conversion Options on page 5-35).
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System Problems

A prompt for the Windows installation CD appears while using CIMS
Server Administrator

In most cases, Windows is calling for dependencies that are not essential for you to run
the application properly. Click Cancel when these messages appear.

Visit the Microsoft Web site and download all updates for your version of Windows and
Microsoft Office (if you use Office). These updates should include the necessary
dependent files.

If problems persist, contact CIMS Lab (see Contacting Technical Support on page 6-7).

Performance of the CIMS Server system is slow

This could be caused by a number of things, including excessive network usage,
problems with the network, excessive CIMS Server usage, etc.

It is also possible that the database you are using has become so large that it is difficult
for the server housing the data to adequately store and access it. In this case, consider
archiving certain data or upgrading the machine. You can also off load non-essential or
non-CIMS-related processing to other machines.

Performance might also be affected by computer-related problems (see the following
problem).

Computer “locks up”, provides unexpected results, or seems to run very
slowly

There could be some type of memory problem. Close CIMS Server Administrator and
any other Windows applications. Reopen CIMS Server Administrator as the only
Windows application and see if the problem corrects itself. If that fails to correct it, close
Windows and then restart it. Open CIMS Server Administrator again and see if the same
results occur.

The computer might not have enough memory to process. Try running the application
on a computer with more memory (preferably 256 MB or more).
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Web Reporting Problems

Users cannot access the CIMS Server Web Reporting site

Verify that the users have appropriate network permissions and are using Internet
Explorer 5.5 or later or Netscape Navigator 4.7 or later

The CIMS Server Web Reporting site is not opening properly or has
problems starting

The following are possible solutions:
B RestartIIS:
e Click Start » Run, type iisreset /restart, and then click OK.

Or

¢ In the CIMS Server Administrator main window click System
Administration » Reporting » Restart IIS Service. Click Stop Service and Start
Service, or click Windows Services Message to open the Services window and
restart IIS.

m Check the security settings on the computer running the Web server (see Set the User
Authentication Method for the CIMS Server Web Reporting Web Site on page 2-36).

m Install Service Pack 1.0 or later for Microsoft SQL Server.

Users are having problems viewing reports correctly
Change the viewer used to view reports. For more information, see Defining Users on
page 3-25 and Web Settings on page 3-49.

Old or sample data appears in reports

One or more old loads have not been removed from the database. Unload the old data.
For more information, see Tracking the History of Database Loads on page 4-26.

The report headers and data do not appear in the report when using the
Crystal Report ActiveX viewer

You may not have administrative privileges to allow the Crystal Report ActiveX viewer to
be automatically downloaded and installed on the computer on which you are trying to
run the report. Use the Crystal Java or HTML viewer instead.
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Cannot drill down in Web reports

Certain items do not have any additional information available. If you place the cursor
on an item and the cursor icon becomes a magnifying glass or a hand, you can drill
down. If it does not, there is no detailed information available about the item.

When using Netscape Navigator, cannot run reports or continually
prompted for ID and password

The following are possible solutions:

m To allow the Netscape Java viewer to work, make sure that the security on the Web
site is set to anonymous and that the user name is correct (i.e., IUSR_computername
where computername is the name of the computer where the Web server is running).

® Windows 95/98 computers might have problems running the Java or HTML viewer
especially if the computer has a small amount of RAM.

An error messages appears when running reports
If one of the following appears when you try to run a report:

B Atime-out message that appears immediately

W -2147192179 An error has occurred on the server in attempting to access the
data source.

In CIMS Server Administrator, click System Administration » Database » Database

Object Manager. Add any database objects that do not exist in the database (i.e., Exists

= No). If this does not solve the problem, drop all objects and then create them again (see

Viewing Tables on page 4-15).

To view the detailed error message, run the report directly from Crystal Reports (not the
Web).
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An error message appears when using ActiveX Data Objects (ADO) or
ODBC to open a database connection in an ASP page

When you use ActiveX Data Objects (ADO) or ODBC to open a database connection in
an ASP page, you may receive the following error message:

Microsoft OLE DB Provider for ODBC Drivers error '80004005' [Microsoft]
[ODBC Driver Manager] Data source name not found and no default driver specified.

Solution

Note * Make sure that you have completed the steps in Set the Home Directory for the
CIMS Server Web Reporting Web Site on page 2-35 and Set the User Authentication Method
for the CIMS Server Web Reporting Web Site on page 2-36 before continuing with this
solution.

The Windows 2000/2003 user account that is used to process the request for the ASP
page does not have sufficient permissions to read the registry key that stores the specified
ODBC Driver's configuration information. The Driver parameter in a DSN-less
connection string specifies the ODBC driver that is used to establish the database
connection.

Grant the Windows 2000 user account Read access to the specified ODBC Driver registry
key as follows:

1 Determine which account is used to process the request for the ASP page.

2 From the Start menu, click Run, type regedt32.exe, and then click OK to start
Registry Editor.

3 In the HKEY_LOCAL_MACHINE window, browse to the
HKLM\SOFTWARE\ODBC\ODBCINST.INI key. The ODBCINST.INI key contains a
subkey for each ODBC Driver that is installed on the server.

4 Click the Driver registry key for the Driver that is specified in the ADO connection
string.

5 From the Security menu, click Permissions.

6 Add the user account that you identified in Step 1 to the list of users who can access
this key, and select the Read check box for this user.

7 Click Apply, and then close Registry Editor.

This information was taken from the Microsoft Knowledge Base Article—Q306345.
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Executing Stored Procedures to Debug CIMS Server

WARNING - Because some stored procedures update data, you should use care when
executing procedures for debugging. If you are unsure as to whether you should use this
feature, consult CIMS Lab (see Contacting Technical Support on page 6-7).

You can execute stored procedures from CIMS Server Administrator for debugging
purposes. To execute a stored procedure:

1 In the CIMS Server Administrator main window, click System Administration »
Database » Execute Stored Procedure.

The Stored Procedure Execute dialog box appears.

2 On the Stored Procedures tab, click the stored procedure that you want to run, enter
the parameters for the procedure, and then click Execute.

When the stored procedure has finished running, the results appear on the Results tab.

Contacting Technical Support

The CIMS Lab Technical Support department is here to answer your questions on any
aspect of CIMS Lab products.

CIMS Lab technical support can be reached in the following ways:

m Telephone: (800) 283-4267 in USA and Canada; 916-783-8525 International
B Email: support@cimslab.com

m Fax request: (916) 783-2090

International customers may contact one of our authorized international partners.
Contact CIMS Lab for more information.

In addition, customers may visit the Customer Area on our Web site for product
downloads, updates, technical documentation, and password information. We are on
the Web at http://www.cimslab.com.
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About Installing Crystal Reports Developer 8.5

Note ¢ CIMS Lab provides Crystal Reports 9 Advanced Edition with Crystal
Enterprise 9 Report Application Server Edition. If you are using Crystal Reports 9, the
following information is not applicable. For information about installing Crystal
Reports 9, refer to Installing Crystal Reports on page 2-12.

To install Crystal Reports 8.5, follow the instructions in the Installation Wizard. CIMS
Lab recommends that you select the Typical installation.

If you are installing Crystal Reports 8.5 on a computer with Internet Explorer 6.0
installed, follow the instructions on the Business Objects Web site (http://
support.businessobjects.com/library/kbase/articles/c2010291.asp) to use the Help
system.

Crystal Reports 8.5 requires that you set security permissions for certain folders. For
more information, contact CIMS Lab technical support (see Contacting Technical Support
on page 6-7).

Important! * You need to install the ActiveX patch for Crystal Reports provided on
the CIMS Lab FTP site (ftp://ftp.cimslab.com) and CIMS Product CD. The path on
both the FTP site and CIMS Product CD is CIMSServer\CrystalPatches\Crystal
Decisions ActiveX Viewer Patch.exe).

CIMS Server Administrator's Guide


ftp://ftp.cimslab.com
http://support.businessobjects.com/library/kbase/articles/c2010291.asp
http://support.businessobjects.com/library/kbase/articles/c2010291.asp

Database Tables

This appendix describes the layout of all database tables used by CIMS Server and
provides Entity Relationship Diagrams (ERDs) for the tables in the CIMS Server
database.

CIMS Audit Client TabIe ... ...vuiiiiiiiiiiiieiiiiiieieiiiieieieeesesencneeeescacasencnons A-3
CIMS Audit Client Contact Table ......cccvuiiiiiiiiiiiiiiiieieitieieiriecieieneneseseceenes A-4
CIMS Audit Client Contact Number Table .........ccciiiiiiiiiiiiiiiiiiiiieneieieneneennnns A-6
CIMS Audit Rate Table .......ccciiuiniuiiiiiiiiiiiiiiieieiiieeieiecseseseecesencacenenens A-8
CIMS Audit Transaction Table ........cociuiiiiiiiiiiiiiiiiiieieieieneieccneneneneneenes A-10
CIMS Calendar Table .......ovitiuiuiurieieieieneneenensasncsesesesssscssasasscssscnacnes A-13
CIMS Client Table .....cuvutiiiiiiiiieieieieerereneneneeesesessescncncncssscsesacassones A-14
CIMS Client Budget Table .......c.couiiiiiiiiiiiiiiiiieiiiiiieieneieeeenencecesencncnnns A-15
CIMS ClientContact Table .......coouiiiiiiiiiiiiiiiiieieieieiieieneicesenccesencncncnns A-16
CIMS Client Contact NumberTable .........coviiiiiiiiiiiiiieiiiiiiiiiieneneneneneenes A-17
CIMS CoNfigTabIe ...vuvniniiiiiiiiiiiiiiiiiieieiieieteeneesesencesesencacasescncncans A-18
CIMS Config Options Table .......ouiuiniiiiiiiiiiiiiiieieieieieereneieneneneseseescscnes A-20
CIMS Config Account Level Table ........c.couiiiiiiiieiiiiniiieiiiieneieieecenencncnnens A-21
CIMS CPU Normalization Table ..........cciiiiiiiiiiiiiiiieieiiiiieeecieneneneneneenes A-21
CIMSDetaill Table .....ouiininiiiiiiiiiiitiiiiiieieieeeiesenenseescasesescsenencncans A-22
CIMSDetail Ident Table .......coouiuiiiiiiiiiieiiiiiieieieieeieneicesesencecesencncnnns A-23
CIMSHeadline Table ........ovtiiiiiniiiiieieieieieeeeeeesesesesscscscncncscncsssscnes A-23
CIMSIdent Table .......cc.cvuiiiiiieiurneneieneneneerenenenencscsesscssssasnssssssanacnes A-24
CIMS InpSrcCategory Table .......couiiiiiiiiiiiiiiiiiiiiitieititieeeteenenencncnenannes A-24
CIMS InpSrcCategorySource Table .......c.ouvuiniiiiiiiiiiieieieieneietecncncacnenennes A-24
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CIMS InpSrcMachineList Table ........c.coiiiiiiiuiiiiiiiitiiiesssescnrererecessssssasns A-24
CIMSLanguage Table .........ciiiuiiiiiiiieiieieeieiueseesesscsscscescsssacssssacscenns A-25
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CIMSRAateTable .......coviiiiieieinirirrereeieneiesesasacecacecsesssssasasasassssasanns A-28
CIMSRate Group Table .........cciiiuiiiiiiiiiiieieeieieeieeneescsssccscssssssscsscnces A-31
CIMS Rate Identifiers Table ..........cociiuiiiiiiiiiiiiiiiiiiiiiiieieieiceienenencanenes A-31
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CIMS Audit Client Table

CIMS Audit Client Table

If auditing is enabled, this table tracks changes made to the CIMS Client table. To enable
auditing of the CIMS Client table, see page 3-53.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMS Client table

(see page A-14).
Field Name

TransType

DateTimeChanged

UserlID

0TdAccountCode
NewAccountCode

0TdATtAccountCode

NewATtAccountCode

O0TdAccountName
NewAccountName

OldLoadTrackingUID

NewlLoadTrackingUID

OldRateTable
NewRateTable

0ldInvoiceContact

CIMS Server Administrator's Guide

Key Type

char(1)

datetime

char(30)

char(128)
char(128)

char(128)

char(128)

varchar(255)
varchar(255)

int

int

char(8)
char(8)

int

Field Description

The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

The date and time that the
change was made.

The Windows user ID of the user
who made the change.

The old client account code.
The new client account code.

The old alternate client account
code.

The new alternate client account
code.

The old client name.
The new client name.

The old load tracking unique
identifier for the client.

The new load tracking unique
identifier for the client.

The old rate table for the client.
The new rate table for the client.

The old index number for the
contact name that appears on
the invoice.
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CIMS Audit Client Contact Table

Field Name Field Description

NewInvoiceContact int The new index number for the
contact name that appears on
the invoice.

0ldActionCodel- char(1) The old action codes—see the
0ldActionCode8 ActionCode field description for
the CIMS Client table.
NewActionCodel- char(1) The new action codes—see the
NewActionCode8 ActionCode field description for

the CIMS Client table.

CIMS Audit Client Contact Table

If auditing is enabled, this table tracks changes made to the CIMS Client Contact table.
To enable auditing of the CIMS Client Contact table, see page 3-53.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMS Client Contact
table (see page A-16).

Field Name Key Type Field Description

TransType char(1) The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

DateTimeChanged datetime The date and time that the
change was made.

Userld char(30) The Windows user ID of the user
who made the change.

OldLoadTrackingUID int The old load tracking unique
identifier for the client.

NewlLoadTrackingUID int The new load tracking unique
identifier for the client.

OldAccountCode char(128) The old client account code.

NewAccountCode char(128) The new client account code.

OldContactIdx int The old index number for the
contact.
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CIMS Audit Client Contact Table

Field Name Field Description
NewContactIdx int The new index number for the
contact.
OldAddressLinel- varchar(255)  The old address line by line
0ldAddressLineb number.
NewAddressLinel- varchar(255)  The new address line by line
NewAddressLine5 number.
OldContactName varchar(255)  The old contact name.
NewContactName varchar(255)  The new contact name.
OldDepartment varchar(255)  The old contact department.
NewDepartment varchar(255)  The new contact department.
OldOffice varchar(255)  The old contact office.
NewOffice varchar(255)  The new contact office.
OldComments varchar(255)  The old contact comments.
NewComments varchar(255) The new contact comments.
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CIMS Audit Client Contact Number Table

CIMS Audit Client Contact Number Table

If auditing is enabled, this table tracks changes made to the CIMS Client Contact
Number table. To enable auditing of the CIMS Client Contact Number table, see

page 3-53.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMS Client Contact

Number table (see page A-17).

Field Name

TransType

DateTimeChanged

UserlID

O0ldLoadTrackingUID

NewlLoadTrackingUID

OTdAccountCode
NewAccountCode
01dContactldx
NewContactldx

O0TdNumberIdx

NewNumberIdx

O1dNumberDescription

NewNumberDescription

Key Type

char(1)

datetime

char(30)

int

int

char(128)
char(128)
int
int

int

int

varchar(255)

varchar(255)

Field Description

The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

The date and time that the
change was made.

The Windows user ID of the user
who made the change.

The old load tracking unique
identifier for the client.

The new load tracking unique
identifier for the client.

The old client account code.
The new client account code.
The old contact index number.
The new contact index number.

The old index number for the
contact number or e-mail
address.

The new index number for the
contact number or e-mail
address.

The old contact number
description.

The new contact number
description.
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CIMS Audit Client Contact Number Table

Field Name Key Type Field Description
OTdNumberValue varchar(255)  The old contact number.
NewNumberVaTue varchar(255) The new contact number.
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CIMS Audit Rate Table

CIMS Audit Rate Table

If auditing is enabled, this table tracks changes made to the CIMS Rate table. To enable
auditing of the CIMS Rate table, see page 3-53.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMS Rate table (see

page A-28).

Field Name Key Type Field Description

TransType char(1) The type of change that was
made to the table:
m U =update to existing data
m [ = addition of new data
m D =deletion of data

DateTimeChanged datetime The date and time that the
change was made.

Userld char(30) The Windows user ID of the user
who made the change.

0ldLoadTrackingUID int The old load tracking unique
identifier for the rate code.

NewLoadTrackingUID int The new load tracking unique
identifier for the rate code.

OldRateTable char(8) The old rate table for the rate
code.

NewRateTable char(8) The new rate table for the rate
code.

OldRateCode char(8) The old rate code.

NewRateCode char(8) The new rate code.

OldRateIndex int The old index number for the
rate code.

NewRateIndex int The new index number for the
rate code.

OldRateValue decimal(18,8) The old per unit value for the
rate code.

NewRateValue decimal(18,8) The new per unit value for the
rate code.

OldResourceValue decimal(19,4) Deprecated.
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Field Name

CIMS Audit Rate Table

Field Description

NewResourceValue

0ldDiscountDollars

NewDiscountDollars

O1dDiscount
NewDiscount
01dDiscountIndex
NewDiscountIndex
OldDescription
NewDescription

OldFactor

NewFactor

OldRateValuel -
OldRateValuell

NewRateValuel -
NewRateValuell

OldEffDate

NewEffDate

0ldTermDate

NewTermDate

0ldComments

NewComments
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decimal(19,4)
decimal(19,4)
decimal(19,4)
decimal(7,4)
decimal(7,4)
int

int
varchar(255)
varchar(255)

numeric

numeric

char(1)

char(1)

datetime

datetime

datetime

datetime

varchar(255)

varchar(255)

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

The old rate code description.
The new rate code description.

The old resource conversion
factor.

The new resource conversion
factor.

The old rate values—see the
RateValue field descriptions for
the CIMS Rate table.

The new rate values—see the
RateValue field descriptions for
the CIMS Rate table.

The old effective date for the rate
code. For future use.

The new effective date for the
rate code. For future use.

The old end date for the rate
code. For future use.

The new end date for the rate
code. For future use.

The old comments for the rate
code.

The new comments for the rate
code.

A-9 H



H Database Tables

CIMS Audit Transaction Table

CIMS Audit Transaction Table

If auditing is enabled, this table tracks changes made to the CIMS Transaction table. To
enable auditing of the CIMS Transaction table, see page 3-53.

B A-10

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMS Transaction

table (see page A-41).

Field Name

TransType

DateTimeChanged

Userld

0ldTransactionUID

NewlLoadTrackingUID

0TdAccountCode

NewAccountCode

OldTransactionType

NewTransactionType

01dShiftCode
NewShiftCode
O0ldRateCode

Key Type

char(1)

datetime

char(30)

char(32)

char(32)

char(128)

char(128)

char(1)

char(1)

char(1)
char(1)
char(8)

Field Description

The type of change that was
made to the table:

m U =update to existing
data or transaction
marked as deleted

m | = addition of new data

The date and time that the
change was made.

The user ID of the user who
made the change (usually
the Windows user ID or the
SQL Server login ID).

The old unique identifier for
the transaction.

The new unique identifier
for the transaction.

The old account code for the
transaction.

The new account code for
the transaction.

The old transaction type—
see the TransactionType
field description for the
CIMS Transaction table.

The old transaction type—
see the TransactionType
field description for the
CIMS Transaction table.

The old shift code.
The new shift code.

The old rate code.

CIMS Server Administrator's Guide



Database Tables H

CIMS Audit Transaction Table

Field Name Field Description
NewRateCode char(8) The new rate code.
OldResourceAmount decimal(18,5) The old resource amount for

the transaction.

NewResourceAmount decimal(18,5) The new resource amount
for the transaction.

01dFrequencyl-01dFrequency? Int The old frequency number—
see the Frequency field
descriptions for the CIMS
Transaction table.

NewFrequencyl-NewFrequency? Int The new frequency
number—see the Frequency
field descriptions for the
CIMS Transaction table.

01dFromDate datetime The old from date.
NewFromDate datetime The new from date.
0ldToDate datetime The old to date.
NewToDate datetime The new to date.
0ldDateTimeSent datetime The old date and time sent.
NewDateTimeSent datetime The new date and time sent.
01dDateTimeModified datetime The old date and time
modified.
NewDateTimeModified datetime The new date and time
modified.
0ldDateTimeEntered datetime The old date and time
entered.
NewDateTimeEntered datetime The new date and time
entered.
OldDateTimeStartProcessing datetime The old processing start date
and time.
NewDateTimeStartProcessing datetime The new processing start
date and time.
OldDateTimeStopProcessing datetime The old processing end date
and time.
NewDateTimeStopProcessing datetime The new processing end date
and time.
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CIMS Audit Transaction Table

Field Name

Field Description

0ldUserID

NewUserID

0ldDateTimeDeleted

NewDateTimeDeleted

OldNote

NewNote

B A-12

char(8)

char(8)

datetime

datetime

varchar(255)

varchar(255)

The old CIMS Server Web
Reporting user ID of the user
who made the change.

The new CIMS Server Web
Reporting user ID of the user
who made the change.

The old date and time that
the transaction was deleted.

The new date and time that
the transaction was deleted.

The old note for the
transaction.

The new note for the
transaction.
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CIMS Calendar Table
CIMS Calendar Table
This table defines the billing periods for a billing organization.
Field Name Key Type Field Description
Year PKa int The calendar year.
Period PKa int The calendar period (1 - 13).
PeriodBeginDate datetime The beginning date of the
period
PeriodEndDate datetime The ending date of the period
CloseDate datetime The processing close date.

a. PK = Primary Key
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CIMS Client Table

CIMS Client Table

This is the primary table for storing client information. All other client tables are related

to this table.

Field Name
AccountCode

AltAcctCode

AccountName

LoadTrackingUID

RateTable

InvoiceContact

ActionCodel - ActionCode8

a. PK = Primary Key

B A-14

Key Type

PKa

char(128)

char(128)

varchar(255)

int

char(8)

int

char(1)

Field Description
The account code for the client.

The alternate account code for
the client (optional).

The client name.

A unique identifier that tracks
the client when loaded to the
database from alocation outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The rate table for the client.

The index number for the client
contact name that appears on
the invoice.

These user-defined codes are
strictly for reporting purposes
and can be used in the custom
reporting process for selecting
data. CIMS Server does not use
action codes.
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CIMS Client Budget Table

CIMS Client Budget Table

This table stores budget and actual information for amounts and resource units by
account code, date, and rate code.

Field Name

LoadTrackingUID

AccountCode

RateCode

Year
Period

BudgetAmt

ActualAmt

BudgetUnits

ActualUnits

a. PK = Primary Key
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Key Type

int
PKa char(128)
PKa char(8)
PKa int
PKa int

decimal(19,4)

decimal(19,4)

decimal(18,5)
decimal(18,5)

Field Description

A unique identifier that tracks
the client when loaded to the
database from alocation outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The account code for the client.

A valid rate code for an
individual resource budget or
TOTAL for an overall account
budget.

The budget year.
The budget period (0 - 13).

The budget monetary amount
for the period.

Deprecated. The actual amount
is in the CIMS Summary table.

The budget units for the period.

Deprecated. The actual units
consumed are in the CIMS
Summary table.
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CIMS Client Contact Table

CIMS Client Contact Table

This table stores client contacts.

Field Name Key Type Field Description

LoadTrackingUID int A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback

System.

AccountCode PKa char(128) The account code for the client.

ContactlIdx PKa int The index number for the
contact.

AddressLinel varchar(255)  Address Line 1

AddressLine2 varchar(255)  Address Line 2

AddressLine3 varchar(255)  Address Line 3

AddressLine4 varchar(255)  Address Line 4

AddressLineb varchar(255)  Address Line 5

ContactName varchar(255)  The name of the client contact.

Department varchar(255)  The contact department.

Office varchar(255)  The contact office.

Comments varchar(255) Comments related to the
contact.

a. PK = Primary Key
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CIMS Client Contact Number Table

This table stores numbers (phone, fax, etc.) and e-mail addresses for contacts.

Field Name Key Type Field Description

LoadTrackingUID int A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback

System.

AccountCode PKa char(128) The account code for the client.

ContactlIdx PKa int The index number for the
contact.

NumberIdx PKa int The index number for the
contact number or e-mail
address.

NumberDescription varchar(255)  The type of number (VOICE, FAX,
EMAIL, etc.)

NumberValue varchar(255)  The contact number or e-mail
address.

a. PK = Primary Key

CIMS Server Administrator's Guide A-17 R



B Database Tables
CIMS Config Table

CIMS Config Table

This table defines configuration options that have a GUI option in CIMS Server
Administrator. One CIMS Config record is allowed per CIMS Server database.

Field Name Key Type Field Description
OrgName varchar(255)  The organization name
AddressLinel varchar(255)  Address Line 1
AddressLine2 varchar(255)  Address Line 2
AddressLine3 varchar(255)  Address Line 3
AddressLine4 varchar(255)  Address Line 4
InvoiceNo int Deprecated. This is stored in the
CIMS Config Options table.
InvoiceNumberType char(1) Deprecated.
Usel3Periods char(1) Indicates whether 13 periods are
used:
m Y (Yes)
m N (No)
UseCalender char(1) Indicates whether the CIMS
calendar is used:
m Y (Yes)
m N (No)
ReportAccessSecurity char(1) Indicates whether report security
is used:
m Y (Yes)
m N (No)
LocationStandardReports varchar(255)  The path to the CIMS standard
reports.
LocationCustomReports varchar(255)  The path to custom reports.
LocationSavedReports varchar(255)  The path to published reports.
DatabaseVersion char(7) The CIMS Server database
version number.
LastProcessUID int Used by CIMSACCT and
CIMSBILL.
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Field Name

CIMS Config Table

Field Description

CustomReportGrouplID

CustomSpreadsheetGrouplID

SessionTimeoutMinutes

AccountParameterSelecti
onlLevel

DefaultCrystalViewer

DBConnectionTimeout

WebCustomSite

WebBGCoTor

WebCSSLocation

WebImagelLocation

WebMenuVertStartPos

LastReportingDate
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int

int

int

int

int

int

char(1)

varchar(32)

varchar(255)

varchar(255)

int

datetime

The unique identifier for the
default report group for user-
defined Web reports.

The unique identifier for the
default report group for user-
defined Web spreadsheets.

The number of minutes before a
CIMS Server Web Reporting
session expires and a new login
is required.

In CIMS Server Web Reporting,
this setting determines the level
of account codes that appear in
the Starting Account Code and
Ending Account Code
parameter lists.

The unique identifier for the
browser viewer used to view
Crystal Reports.

The maximum number of
seconds that a database may
respond to a query before timing
out

Indicates the Web site to be
used:

m D (Default)
m C(Custom)

The hexadecimal number for
the background color of a
custom Web site.

The path to the CSS for a custom
Web site.

The path to the images for a
custom Web site.

The start position (in pixels) for
the menu of a custom Web site.

The last reporting date for
reports that end users who do
not have administrative
privileges can view.
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CIMS Config Options Table

CIMS Config Options Table

This table defines configuration options that the administrator can add manually in
CIMS Server Administrator.

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

PropertyValue varchar(255)  The value for the configuration
option.

PropertyType int The data type of the

configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMS Config Account Level Table

This table defines the account code structure.

Field Name Key Type Field Description

AccountStructureName char(32) The account code structure
name (e.g., Standard).

StartPosition int The starting offset position
for the account code.

AccountlLevel int The account code level.

AccountlLength int The length of the account
code level.

AccountDescription varchar(255) A description of the account
code level.

CIMS CPU Normalization Table

The table allows for differences in CPU speed.

Field Name Key Type Field Description

SystemID pPKa char(32) The system identifier for the
computer that you want to
normalize. For OS/390, this
is the four-character System
Model ID. For UNIX and
Windows, it is the computer
name.

WorkID PKa char(32) The subystem name (e.g.,
CICS region name, DB2 plan
name, Oracle instance, etc.).

Factor decimal(10,4) The normalization factor.

a. PK = Primary Key
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CIMS Detail Table

This is table stores the information contained in the CIMSBILL Detail File. The table
contains the resource information collected from the records in the input file. Each
record in this table represents a single resource used/time period. This is the most
granular form of the resource data stored in the database.

Field Name

Key Type

Field Description

LoadTrackingUID

DetailUID

Detailline

AccountCode

Aggregate

StartDate
EndDate
ShiftCode

AuditCode

SourceSystem

RateCode

ResourceUnits

AccountingStartDate

AccountingEndDate

B A-22

int

int

int

char(128)

int

datetime
datetime
char(1)
varchar(255)

char(8)

char(8)

decimal(18,5)

datetime

datetime

The load tracking unique
identifier from the CIMS Load
Tracking table.

The unique identifier that tracks
the CIMSBILL Detail load.

The number of the record in the
input file that contains the
resource (i.e., 1 if it is the first
record, 2 if it is the second
record, etc.).

The account code.

A count of the number of
original input records that have
been aggregated into this record.

The resource usage start date.
The resource usage end date.
The resource usage shift code.

The audit code (CIMS External
Transaction Records only).

The system identifier for this
resource.

The rate code of this resource.

The quantity of the resource
used.

The accounting start date.

The accounting end date.
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CIMS Detail Ident Table

This is table stores the information contained in the CIMS Ident File. The table contains
the identifier information collected from the records in the input file.

Field Name Key Type Field Description

LoadTrackingUID int The load tracking unique
identifier from the CIMS
Load Tracking table.

DetailUID PKa int The unique identifier that
tracks the CIMSBILL Detail
load.

Detailline PKa int The number of the record in

the input file that contains
the identifier (i.e., 1 if it is

the first record, 2 if it is the
second record, etc.).

IdentNumber PKa int The number of the identifier
as it appears in the input file
record (i.e., 1 if it is the first
identifier, 2 if it is the second
identifier, etc.)

IdentValue varchar(255)  The value of the identifier.

a. PK = Primary Key

CIMS Headline Table

This table defines the headlines that appear on the CIMS Server Web Reporting home

page.

Field Name Key Key Field Description

HeadlineUID PKa int The sequential UID that
tracks the headline.

HeadlineDate datetime The date that the headline
was created.

Headline varchar(255)  The headline text.

HeadlinelLink varchar(255)  The URL for the headline

link.

a. PK = Primary Key
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CIMS Ident Table

This table stores all identifiers contained in the input files processed. As an input file is
processed, its identifiers are added to this table. This table will continue to store
identifiers even if the identifiers are no longer used by records loaded in the database. To
delete unused identifiers if needed, see Maintaining Identifiers on page 3-40.

Field Name Key Type Field Description

IdentNumber PKa int A sequential number
assigned to the identifier.

IdentName varchar(32) A short name for the
identifier.
IdentDescription varchar(255) A full description of the

identifier name (optional).

IdentActiveFlag char(1) Indicates whether Active or
Inactive has been selected for
custom reports:

m Blank (Active)

m I (Inactive)

IdentReportFlag char(1) User-defined report flag.

a. PK = Primary Key

CIMS InpSrcCategory Table

This table is for future use.

CIMS InpSrcCategorySource Table

This table is for future use.

CIMS InpSrcMachinelList Table

This table is for future use.
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CIMS Language Table

This table is for future use. It is intended to display GUI options (menus, links, etc.) in
CIMS Server Web Reporting in the required language.

Field Name

StringName

ENG
SPA
FRA
DuUT
ITA
GER
FIN
SWE
JPN
POR

OTH

a. PK = Primary Key
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Key Type

PKa

varchar(80)

varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)

varchar(255)

Field Description

The tag name in the Web
reporting ASP page.

The GUI option in English.
The GUI option in Spanish.
The GUI option in French.
The GUI option in Dutch.
The GUI option in Italian.
The GUI option in German.
The GUI option in Finnish.
The GUI option in Swedish.
The GUI option in Japanese.

The GUI option in
Portuguese.

The GUI option in another
language.
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CIMS Load Tracking Table

B A-26

This table records the loading of any data to the database. This enables database loads to

be deleted if required.

Field Name

LoadTrackingUID

FileType

FileName

Dateloaded

DateDeleted

TotalRecslLoaded

StartDate

EndDate

SourceSystem

SourceFeed

Key Type

PKa

int

char(8)

varchar(255)

datetime

datetime

int

datetime

datetime

varchar(32)

varchar(32)

Field Description

The unique identifier for the
database load.

The type of file processed:

B Summary
m Detail (CIMSBILL Detail)
m Ident

B Resource (CIMSACCT
Detail)

The path and name of the
file that was processed

The date and time the input
file was processed by
CIMSACCT.

The date and time the load
was removed from the
database.

The number of records
loaded.

The accounting start date for
CIMS Summary, CIMS
Detail, and CIMS Ident
Records. The usage end date
for Resource Records.

The accounting end date for
CIMS Summary, CIMS
Detail, and CIMS Ident
Records. The usage end date
for Resource Records.

The name of the computer
that produced the data.

The system that produced
the data (e.g., IIS, Exchange,
0S§/390, etc.)
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Field Name Key Type Field Description

DateArchived datetime The date and time that the
load was archived.

Archivelocation varchar(255)  The location of the archived
load.

a. PK = Primary Key
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CIMS Rate Table

This table stores the rate codes and rates for resource usage.

Field Name Key Type Field Description

LoadTrackingUID int The unique identifier that
tracks the rate when loaded
to the database from a
location outside of CIMS
Server. For example, from

CIMS Mainframe Data
Collector and Chargeback
System.

RateTable pPKa char(8) The name of the rate table
that contains the rate code.

RateCode PKa char(8) The code for the rate.

RateIndex int The index number for the
rate code.

RateValue decimal(18,8) The per unit value for the
rate code.

ResourceValue decimal(19,4) Deprecated.

DiscountDollars decimal(19,4) Deprecated.

Discount decimal(7,4)  Deprecated.

DiscountIndex int Deprecated.

Description varchar(255) A description of the rate
code.

Factor decimal(15,8) A user-defined resource

conversion factor value for
the resource unit value in
reports.

RateValuel char(1) Indicates whether four
decimal positions are used
in the rate value in reports:

m  (Four digits are used)

m Blank (Eight digits are
used [the default])
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Field Name Key Type Field Description

RateValueZ char(1) Indicates whether the rate is
per resource unit or per
thousand units in reports:

m M (Per thousand units)

m Blank (Per unit)

RateValue3 char(1) Indicates the resource
conversion factor for the
resource unit value in
reports.

m 1 (Divide total resource
value by 60)

m 2 (Divide total resource
value by 3600)

m 3 (Divide total resource
value by 1000)

m 4 (Multiply total resource
value by 60)

m 5 (Divide total resource
value by 60000)

m {f (Multiple total resource
value by user-defined
number in Factor field.)

m Blank (No conversion
factor)

RateValue4 char(1) Indicates whether the rate
code is included in zero cost
calculations:

B N (The rate will not be
included in zero cost
calculations)

m Blank (The rate will be
included in zero cost
calculations)

For more information about
zero cost calculations, see
page 3-11.
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Field Name Key Type Field Description

RateValueb char(1) Indicates the number of
decimal digits that appear in
the resource units value in
reports:

m 1-5(1 through 5 digits)
m Blank (2 digits, the

default)
RateValue6b char(1) For future use.
RateValue’ char(1) Indicates the whether the

resource units for the rate
code are considered a
monetary amount rather
than units if utilization:

m $ (flatfee)
m Blank (not flat fee)

RateValue8 char(1) User-defined report flag.

RateValue9 char(1) For future use.

RateValuelO char(1) User-defined report flag.

RateValuell char(1) Indicates whether the rate
should be included in CPU
normalization:
m Y (Yes)
m N(No)

EffDate datetime The effective date for the rate
code.

TermDate datetime The end date for the rate
code.

Comments varchar(255)  Comments for the rate code.

a. PK = Primary Key
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CIMS Rate Group Table
This table defines the rate groups.
Field Name Key Type Field Description
RateGroup PKa int A sequential number

assigned to the rate group.

ParentUID int For future use.

GroupTitle char(32) The rate group title.

GroupTitlelong varchar(255) A description of the rate
group.

a. PK = Primary Key

CIMS Rate Identifiers Table

This table correlates rate codes to identifiers to enable drill down on the units consumed
for a resource by identifier.

Field Name Key Type Field Description
RateCode PKa char(8) The rate code.
IdentNumber PKa int A sequential number

assigned to the identifier for
the rate code.

a. PK = Primary Key
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CIMS Rate Shift Table

This table defines the optional rate shifts for rate codes.

Field Name Key Type Field Description

RateTable pKa char(8) The name of the rate table.

RateCode pKa char(8) The rate code.

ShiftCode PKa char(1) The shift code.

RateValue decimal(18,8) The rate value for the shift.

Description varchar(255) A description of the shift
(Swing, Night, etc.).

RateValuel char(1) For future use.

RateValue? char(1) For future use.

RateValue3 char(1) For future use.

RateValue4 char(1) For future use.

RateValueb char(1) For future use.

RateValue6 char(1) For future use.

RateValue7 char(1) For future use.

RateValue8 char(1) For future use.

RateValue9 char(1) For future use.

RateValuelO char(1) For future use.

RateValuell char(1) For future use.

EffDate datetime The effective date for the rate
code.

TermDate datetime The end date for the rate
code.

Comments varchar(255)  For future use.

a. PK = Primary Key

H A-32 CIMS Server Administrator's Guide



Database Tables H
CIMS Rate To Rate Group Table

CIMS Rate To Rate Group Table

This table correlates rate codes to rate groups.

Field Name Key Type Field Description
RateCode pKa char(8) The rate code.
RateGroup PKa int A sequential number

assigned to the rate group.

a. PK = Primary Key

CIMS Report

This table stores information about the reports used for CIMS Server Web Reporting.
These reports are entered in the Report List Maintenance dialog box (see Working with
Reports on page 3-34).

Field Name Key Type Field Description

ReportID PKa int The unique identifier for the
report.

ReportName char(32) The name of the report

ReportFile varchar(255)  The .rpt file name for the

report. Also, the executable
for all reports (except user-
defined reports).

ReportDescription varchar(255) A description of the report.

UserID char(8) For a user-defined reports,
the CIMS Server Web
Reporting user ID of the
person who created the
report.

ReportTemplateFile varchar(255)  The .rpt file to be used as
the executable for user
defined reports.

a. PK = Primary Key
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CIMS Report Custom Fields Table

This table stores the values for the user-defined reports that can be stored in the database
and supplied to the report automatically at run time.

Field Name Key Type Field Description

ReportID PKa int The unique identifier for the
report.

RateCode char(8) The rate code

ReportPosition PKa int The position within the

report where the values are
used beginning with 1 and
continuing sequentially.

DecimalPlaces int The number of decimal
places to display for the
resource usage amount in

reports.
a. PK = Primary Key
CIMS Report Group Table
This table stores information about report groups.
Field Name Key Type Field Description
ReportGroupID PKa int The unique identifier for the
report group
ReportGroupName char(32) The report group name
ReportGroupDesc varchar(255) A description of the report
group.

a. PK = Primary Key
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CIMS Report Start Table

This table defines the order in which reports appear in CIMS Server Web Reporting,.

Field Name Key Type Field Description

ReportStartID int A unique identifier for the
start group.

ReportStartGroup int A sequential number that is

assigned to the start group.
The number is dependent on
the order in which the group
was created.

CIMS Report To Report Group Table

This table relates reports to report groups.

Field Name Key Type Field Description

MemberID PKa int The unique identifier of the
report.

MemberType pKa char(1) m R(Report)
m G (Graph)

ReportGroupld PKa int The unique identifier for the
report group.

Sequence int The order of the report in the

report group list.

a. PK = Primary Key
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CIMS Resource Utilization

This is table stores the resource information contained in the CIMSACCT Detail File. In
most cases, you will not need to load the data in CIMSACCT Detail File to the database.

Field Name

LoadTrackingUID

DetailUID

DetaillLine

AccountCode

Aggregate

StartDate
EndDate

ShiftCode

AuditCode

SourceSystem

RateCode

ResourceUnits

B A-36

Key Type

int

int

int

char(128)

int

datetime
datetime

char(1)

varchar(255)

char(8)

char(8)

decimal(18,5)

Field Description

The load tracking unique
identifier from the CIMS
Load Tracking table.

The unique identifier that
tracks the CIMSACCT Detail
load.

The number of the record in
the input file that contains
theresource (i.e., 1ifitisthe
first record, 2 if it is the
second record, etc.)

The account code.

A count of the number of
original input records that
have been aggregated into
this record.

The resource usage start date.
The resource usage end date.

The resource usage shift
code.

The audit code (CIMS
External Transaction Records
only).

The system identifier for this
resource.

The rate code of this
resource.

The quantity of the resource
used.
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CIMS Summary Table

This is table stores the information contained in the CIMS Summary File created by
CIMSBILL. This table contains both resource utilization and cost data for reports. Note
the Bi11F1ag fields reflect the flags that were set in the CIMS Rate Table at the time that

CIMSBILL was run.

Field Name

Key Type

Field Description

LoadTrackingUID

Year
Period

Shift

AccountCode

LenLevell

LenLevel?2
LenLevel3
LenLeveld

RateTable

RateCode

StartDate

EndDate
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int

int
int

char(1)

char(128)

int

int
int
int

char(8)

char(8)

datetime

datetime

The load tracking unique
identifier from the CIMS
Load Tracking table.

The resource usage year.
The resource usage period

The resource usage shift
code.

The account code.

Values are the following:

m 0—The record was created
from a Detail Record.

B 1—The record was by
created by reprocessing a
CIMS Summary Record.

B 2—The record was by
created by processing a
Summary Record twice. If
the Summary Record was
processed more than
twice, the value would be
3,4,5, etc.

A value of 0.
A value of 0.
A value of 0.

The name of the rate table
that contains the rate code.

The rate code for the
resource.

The accounting start date.

The accounting end date.
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B A-38

Field Name

BillFlagl

BillFlag?

BiT1Flag3

BillFlag4

char(1)

char(1)

char(1)

char(1)

Field Description

Indicates whether four
decimal positions are used
in the rate value in reports:

m F (Four digits are used)

m Blank (Eight digits are
used [the default])

Indicates whether the rate is
per resource unit or per
thousand units in reports:

m M (Per thousand units)

m Blank (Per unit)

Indicates the resource
conversion factor for the
resource unit value in
reports:

m 1 (Divide total resource
value by 60)

m 2 (Divide total resource
value by 3600)

m 3 (Divide total resource
value by 1000)

m 4 (Multiply total resource
value by 60)

m 5 (Divide total resource
value by 60000)

m {f (Multiple total resource
value by user-defined
number in Factor field.)

Indicates whether the rate
code is included in zero cost
calculations:

B N (The rate will not be
included in zero cost
calculations)

m Blank (The rate will be
included in zero cost
calculations)

For more information about
zero cost calculations, see
page 3-11.
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Field Name Field Description

Bil1Flagb char(1) Indicates the number of
decimal digits that appear in
the resource units value in
reports:

m 1-5(1 through 5 digits)
m Blank (2 digits, the

default)
Bil11Flag6 char(1) For future use.
BillFlag7 char(1) Indicates the whether the

resource units for the rate
code are considered a
monetary amount rather
than units if utilization:

m $ (flatfee)
m Blank (not flat fee)

BillFlag8 char(1) User-defined report flag.
Bil1F1ag9 char(1) For future use.
RateValue decimal(18,8) Per unit charge for this rate.
Resourcelnits decimal(18,5) The total units for this rate.
BreakID int Deprecated.
MoneyValue decimal(19,4) The total currency units for
this rate.
UsageStartDate datetime The resource usage start date.
UsageEndDate datetime The resource usage end date.
RunDate datetime The date and time that
CIMSBILL was run.
Bil1FTagl0 char(1) User-defined report flag.
Bil1Flagll char(1) Indicates whether the rate
should be included in CPU
normalization:
m Y (Yes)
m N(No)

a. PK = Primary Key
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CIMS Summary Daily Table

The stores the data in the CIMS Summary table at a monthly rather than daily level. The
fields are the same as the CIMS Summary table.

For more information about converting daily records to monthly records, see
ConvertSummaryDailyToMonthly.wsf on page C-5.

CIMS Summary To Detail Table

This table is used to upgrade to CIMS Server 3.2. This table will be removed for future
CIMS Server releases.

Field Name Key Type Field Description

SummaryLoadTrackingUID PKa int The load tracking unique
identifier from the CIMS
Load Tracking table.

DetailUID PKa int The unique identifier that
tracks the CIMSBILL Detail
load.

StartDate datetime The accounting start date.

EndDate datetime The accounting end date.

DetailConverted char(1) Indicates whether the

CIMSBILL Detail Records
have been converted:

Y (Yes)
Null (No)

SummaryConverted char(1) Indicates whether the CIMS
Summary Records have been
converted:

Y (Yes)
Null (No)

a. PK = Primary Key
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CIMS Transaction Table

This table stores miscellaneous, recurring, and credit transactions. For more information
about creating and using transactions, refer to the CIMS Server Web Reporting User’s

Guide.

Field Name

Key Type

Field Description

TransactionUID

AccountCode

TransactionType

ShiftCode

RateCode

ResourceAmount

Frequencyl
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char(32)

char(128)

char(1)

char(1)

char(8)

decimal(18,5)

int

The unique identifier for the
transaction.

The account code for the
transaction.

The transaction type:
m M (Miscellaneous
m R(Recurring)

m C (Credit)

The shift code for the
transaction.

The rate code for the
transaction.

The amount of the
transaction.

Applicable only to recurring
transactions. The frequency
that the transaction should
occur (every month, every 6
months, etc.). Frequency is
based on the calendar year
(January-December)

® 1 (monthly)

2 (every other month)

3 (every quarter)

4 (every four months)

6 (every six months)

12 (once a year)
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Field Name Key Type Field Description

Frequency?2 int Applicable only to recurring
transactions. The period in
which the transaction
should be processed. This
value corresponds to the
value in the Frequencyl field.
For example, if the value in
the Frequencyl field is 6, a
value of 1 in this field
indicates the first month of a
6 month period (January or
July).

FromDate/ToDate datetime Applicable only to
miscellaneous and credit
transactions. The date range
that the transaction
occurred.

DateTimeSent datetime The date and time that the

transaction was exported to a
flat file.

DateTimeModified datetime The date and time that the

transaction was last
modified.

DateTimeEntered datetime The date and time that the
transaction was created.

DateTimeStartProcessing datetime Applicable only to recurring
transactions. The first day
that the transaction will be
processed.

DateTimeStopProcessing datetime Applicable only to recurring
transactions. The last day
that the transaction will be
processed.

UserID char(8) The CIMS Server Web
Reporting user ID of the
person who entered the

transaction.
DateTimeDeleted datetime The date and time that the
transaction was deleted.
Note varchar(255) A description of the
transaction.

a. PK = Primary Key
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CIMS User Table
CIMS User Table
This table tracks users of the CIMS Server system.
Field Name Key Type Field Description
UserID pPKa char(8) The CIMS Server Web
Reporting user ID.

Password int A hash of the user password.
SessionID int A unique session identifier
UserFulTName varchar(255)  The full name of the user
UserFlagl char(1) Indicates whether full report

path for published reports is
displayed on Favorites page
in CIMS Server Web
Reporting:

m Y (Yes)
m N (No)

UserFlag? char(1) Indicates whether full report
path for published reports is
displayed on Published

Reports page in CIMS Server
Web Reporting:

m Y (Yes)
m N (No)

CrystalViewer int The unique identifier for the
browser viewer used to view
Crystal Reports.

DomainUserName varchar(255) The Windows domain and
user name for the CIMS
Server Web Reporting user.

a. PK = Primary Key
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CIMS User Config Options Table

This table stores the user configuration options entered in the User Configuration
Options List Maintenance dialog box (see Defining Users on page 3-25).

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

UserID PKa char(8) The CIMS Server Web Reporting
user ID.

PropertyValue varchar(255)  The value for the configuration
option.

PropertyType int The data type of the

configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMS User Favorites Table

This table stores information regarding the CIMS Server Web Reporting users favorite
reports. For more information about favorite reports, refer to the CIMS Server Web
Reporting User’s Guide.

Field Name Key Type Field Description

UserID char(8) The CIMS Server Web
Reporting user ID.

FavoriteReportGroup int The unique identifier for the
report group that the favorite
report belongs to.

FavoriteReport int The unique identifier for the
favorite report.

DisplayOrder int The order in which the
favorite report is displayed.

CIMS User Group Table

This table relates users to user groups.

Field Name Key Type Field Description
GroupID pKa char(8) The user group ID.
GroupFulTName varchar(255)  The full name of the group.
TransactionSecurity char(1) Indicates whether group has
transaction maintenance
privilege:
9 (Yes)
0 (No)
RateSecurity char(1) For future use.
ClientSecurity char(1) For future use.
GroupType char(1) Type of user:
1 (Client)
9 (Admin)
AccountStructureName char(32) The name of the account
code structure used by the
user group.

a. PK = Primary Key
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CIMS User Group Account Code Table

This tables defines user the account codes that users within a user group can view.

Field Name Key Type Field Description
GroupID pKa char(8) The user group ID.
AccountCode PKa char(128) The client account code that

can be viewed. If the group
has access to all clients, this
field is blank.

a. PK = Primary Key

CIMS User Group Config Options Table

This table stores the user configuration options entered in the Group Configuration
Options List Maintenance dialog box (see Defining User Groups on page 3-29).

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

GrouplID PKa char(8) The CIMS Server Web Reporting
user group ID.

PropertyValue varchar(255)  The value for the configuration
option.

PropertyType int The data type of the

configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMS User Group Report Table

This tables defines the reports that users within a user group can view. If a group has
access to all reports, it is not included in this table.

Field Name Key Type Field Description

GroupID PKa char(8) The CIMS Server Web
Reporting user group ID.

ReportID PKa int The unique identifier of the
report.

ReportExecute char(1) Permission for users in this
group to run the report:

m Y (Yes)
m N (No)

a. PK = Primary Key
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B A-48

This section provides Entity Relationship Diagrams (ERDs) for most of the tables in the
CIMS Server database. (Tables that do not have explicit relationships are not shown.)

These diagrams show the following:

m The relationships of the client, report, and user tables

B The relationship of the CIMS Transaction and CIMS Summary tables to other tables
The following conventions are used in these diagrams:

B PK = Primary Key

m Bold = A required field

B A double arrow equals a one-to-many relationship. For example, one client can have
many budgets (i.e., budgets for multiple resources).

Note that some tables are shown in more than one diagram.
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Summary-related Tables

Database Entity Relationship Diagrams

The ERD in Figure A-1 shows the relationship of the CIMS Summary table to other

tables.

CIMSSummary CIMSDetail
LoadTrackingUID [ pp| | LoadTrackingUID
Year DetailUID
Period DetailLine
Shift AccountCode
AccountCode Aggregate
LenLevell StartDate
LenLevel2 En_dDate
LenLevel3 Sh|ﬂ_Code
LenLeveld CIMSRate AuditCode
RateTable SourceSystem
RateCode PK |RateTable L RateCode
StartDate PK |RateCode il | ResourceUnits
EndDate AccountingStartDate
BillFlag1 LoadTrackingUID AccountingEndDate
BillFlag2 Ratelndex i
BillFlag3 RateValue &
BillFlagd ResourceValue
BillFlag5 DiscountDollars CIMSIdent i
BillFlagh Discount
BillFlag7 o -~ Discountindex PK |identNumber CIMSDetailldent
BillFlags Description
BillFlagd Factor IdentName_ ol | PK jlul
RateValue RateValue1 IdentDescription % "7 PK | DetailLine
ResourceUnits RateValue? IdentActiveFlag PK | IdentNumber
Breakld RateValuel IdentReportFlag :
MoneyValue RateValued LoadTrackingUID
UsageStartDate RateValues dentValue
UsageEndDate RateValueG
RunDate RateValue7?
BillFlag10 RateValued
BillFlag11 RateValued _
ry RateValue10 CIMSRateShift
4 RateValuel1 - oo | PK |RateTable
EffDate i L
PK |RateCode
TermDate PK | ShiftCode.
Comments =2niit.oce
A RateValue
Description
+ RateValue1
\ RateValue2
CIMSClient RateValue3
RateValued
PK | AccountCode RateValue5
RateValueb
AltAcctCode RateValueT
fCC?;”T'“NEFE uID Y CIMSRateG RateValuet
ateGrou
RZTeTarzlcemg CIMSRateToRateGroup E 331953:“9?0
- PK | RateGroup alevalue
Inw_|ceContact PK |RateCode RateValue11
ActionCode1 PK |RateGroup -t - ParentUID EffDate
ActionCode2 - TermDate
- GroupTitle
ActionCode3 ; Comments
ActionCoded GroupTitleLong

ActionCodes
ActionCodeb
ActionCode?
ActionCode8

Figure A-1 « Summary-related Tables ERD
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Client Tables

The ERD in Figure A-2 shows the relationships of the client tables.

CIMSClient
PK | AccountCode CIMSClientBudget
PK | AccountCode
AltAcctCode PK |RateCode
AccountMame PK |Year
LoadTrackingUID PK |Period
RateTahle -t -
InvoiceContact LoadTrackingUID
ActionCodel BudgetAmt
ActionCode2 ActualAmt
ActionCode3 BudgetUnits
ActionCoded Actuallnits
ActionCodes
ActionCodeb
ActionCode?
ActionCode8
A
k4
h
CIMSClientContact CIMSClientContactMumber
PK | AccountCode PK | AccountCode
PK | Contactldx PK | Contactldx
-= pp PK | Humberldz
LoadTrackingUID
Addresslinel LoadTrackingUID
AddressLine2 MNurberDescription
AddressLined MNumbervalue
AddressLined
AddressLines
ContactMarme
Department
Office
Comments

Figure A-2 « Client Tables ERD
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The ERD in Figure A-3 shows the relationships of the user tables.

CIMSUser

PK | UserlD

Password
SessionlD
UserFullMName
UserFlag1
UserFlag2
CrystalViewer
DomainUserMName

|

Y
h 4

CIMSUserFavarites

UserlD

FavoriteReportGroup
FavoriteReport
DisplayQrder

Y
4

CIMSUserGroup

PK

CrouplD

GroupFullMame
TransactionSecurity
RateSecurity
ClientSecurity
GroupType
AccountStructureName

¥
h 4

CIMSUserGroupReport

PK | GrouplD
PK | ReportlD

ReportExecute

Figure A-3 « User Tables ERD
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CIMSUserGroupAccountCode
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PK

GrouplD
AccountCode
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Report Tables

The ERD in Figure A-4 shows the relationships of the report tables.

B A-52

CIMSReportCustamFields

PK
PK

BeportlD
ReportPosition

RateCode
DecimalPlaces

Y

CIMSReport

PK

ReportlD

ReportNarme
ReportFile
ReportDescription
UserlD
ReportTemplateFile

f 3

Figure A-4  Report Tables ERD

k.

F

b

4

A
&

CIMSReportToReportGroup

PK
PK
PK

MemberlD

MemberType
BeportGrouplD,

Sequence

F
4

h
h

Y

CIMSReportGraup

PK

ReportGrouplD

ReportGroupMame
ReportGroupDesc
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Database Entity Relationship Diagrams

The ERD in Figure A-5 shows the relationship of the CIMS Transaction table to the CIMS
Client and CIMS Rate tables.

Figure A-5  Transaction-related Tables ERD
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CIMSTransaction

PK

TransactionUID

AccountCode
TransactionType
ShiftCode
RateCode
ResourceAmount
Frequency1
Frequency2
FromDate

ToDate
DateTimeSent
DateTimeModified
DateTimeEntered

DateTimeStartProcessing
DateTimeStopProcessing

UserlD
DateTimeDeleted
Mote

CIMSClient

PK

AccountCode

A

f 3

¥
h

AltAcctCode
AccountMame
LoadTrackingUID
RateTable
InvoiceContact
ActionCode1
ActionCode2
ActionCode3
ActionCoded
ActionCodes
ActionCodeb
ActionCode?
ActionCoded

¥

CIMSRate

PK

RateTable
RateCode

Ratelndex
RateValue
ResourceValue
DiscountDallars
Discount
Discountindex
Description
Factor
RateValue1
RateValue2
RateValue3
RateValued
RateValues
RateValue6
RateValue7?
RateValued
RateValued
RateValue10
RateValue11
EffDate
TermDate
Comments

LoadTrackingUID
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This appendix describes the layout of key files used by CIMS Server.

CIMS Server ReSOUNCE FIle ....uuueteiiiiiiiiiiieeeeeeeeeeeeeesesesssscececccccsnsnsnnnanan B-2
CIMS External Transaction File . .....viineiiiieitiiieeeereeeeeeeeeeesnceeennssenonsccannns B-4
CIMSACCT Detail FIlE . oiiiiiiiiiiiiiieeeeeeeeeeneeeeeeeeecesssssssssccsccaccssnnssnsanns B-5
CIMS IAENE FIlE . v et iitiiiieeiietteieeeeeseneeeenaeeesnsscesoasecssscecsnnscannnsaannnnn B-6
CIMSBILL Detail FIl . oo it iiitiiiieiiiieeiieeeeeeeeeeeeseeeeeonseecsssceesnsscesnnseannnnn B-7
CIMSBILL Detail File Version 200306 . ...ttt e B-7
CIMSBILL Detail File Version 200106 ... ...ttt e B-9
CIMSSUMMANY FIlE «.cuvtiniiiiiiiiiii ittt ittt iiiittieitneenenencecnsencncncnns B-11
Summary File Version 200306 . .. ...ttt B-11
Summary File Version 200106 ... ........ ittt e e B-13
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CIMS Server Resource File

CIMS Server Resource File

H B-2

The primary method for input into CIMS Server is the CIMS Server Resource (CSR) File.
This file contains CIMS Server Resource Records. The CSR file is produced by the CIMS
Data Collectors for the Windows and UNIX operating systems.

The records in the CSR file contain two pieces of required information. The first is some
type of identifier of the data, like server name, job name, account code, etc. The second
piece of required information is resource usage like CPU time, input/outputs, pages

printed, etc. The CSR record can contain a very large number of identifiers and resources.

In the layout of the record, there is an eight-character header that identifies to the CIMS
system the source of the data. For example, the header for IIS records might be IIS. There
is no standard for this header and any unique combination of characters can be used.

These records are in a standard ASCII display format (no packed, binary or bit data) with
commas for delimiters and decimal points included in resource amounts. A negative sign
should precede the numeric data, with no sign when the data is positive. When the
Identifier data contains commas, there must be double quotes around the Identifier
character data.

The following table describes the fields in the CIMS Server Resource Record.
Pos. Field Name Length Type Description
1 Header 8 Character  Defines the source of data. For

example, DB2 data from OS/
390 contains a header of

S390DB2.
2 Start Date of 8 Number Date in format YYYYMMDD.
Usage
3 End Date of Usage 8 Number Date in format YYYYMMDD.
4 Start Time of 8 Character  Time in format HH:MM:SS.
Usage
5 End Time of Usage 8 Character  Time in format HH:MM:SS.
6 Shift Code 1 Character  Alphanumeric code denoting
time of day usage occurred.
Allows billing different rates by
shift. If you do not want to
charge by shift, the field should
be blank.
U Number of 2 Number Number of identifiers in the
Identifiers following fields.
8 Identifier Name 1 Variable Character = The name of the Identifier.
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Field Name

CIMS Server Resource File

Description

10

11

12

13

Identifier Value 1

Identifier Name 2

Identifier Value 2

Identifier Name x

Identifier Value x

Number of
Resources

Rate Code 1

Resource Value 1

Rate Code 2

Resource Value 2

Rate Code x

Resource Value x

Variable

Variable

Variable

Variable

Variable

Variable

Variable

Variable

Variable

Variable

Variable

Character

Character

Character

Character

Character

Number

Character

Number

Character

Number

Character

Number

Includes items such as database
name, server name, LAN ID,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

The name of the Identifier.

Includes items such as database
name, server name, LAN ID,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

The name of the Identifier.

Includes items such as database
name, server name, LAN ID,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

Number of resources being
tracked in the following fields.

The rate code for the resource.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

The rate code for the resource.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

The rate code for the resource.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

CIMS Server Administrator's Guide
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CIMS External Transaction File

Although the CIMS External Transaction File is supported, CIMS Lab recommends that
you use the CIMS Server Resource File for input into CIMS Server (see CIMS Server
Resource File on page B-2). The CIMS Server Resource File is more flexible and efficient

than the CIMS External Transaction Record.

The CIMS External Transaction File contains CIMS External Transaction Records. These

records are comma-delimited.

The following table describes the fields in the CIMS External Transaction Record.

Description

Field Name
1 TRANS 5 Character
2 Rate Code 8 Character
3 Start Date of 8 Number
Usage
4 End Date of Usage 8 Number
5 Resource Value Variable = Number
6 Account Code 32 Character
7 Audit Code 6 Character

Record header that identifies
the record as an External
Transaction record.

The rate code for the resource.

Date in format YYYYMMDD.

Date in format YYYYMMDD.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

The account code.

Optional and not used in
processing. This can be any code
that helps to identify the record
such as Employee Code, Service
Code, etc.

B B-4
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CIMSACCT Detail File

This file is created by CIMSACCT and contains all the resource data processed by the
CIMSACCT run. The CIMSACCT Detail File is basically the same as the CIMSBILL Detail
File (see page B-7), but without CPU normalization, proration, or include/exclude
processing applied to the resources.

The following is the file layout for the CIMSACCT Detail File.

Starting
Position Length Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detalil file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-ID 90 32 The work id where the record came

from (could be subsystem name,
could be oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
DETAIL-END-TIME 150 8 The end time of the record.
DETAIL-SHIFT 159 1 The shift code.

DETAIL-DOW 161 1 The day of week.
DETAIL-ACCOUNT-CODE 163 128 The account code.
DETAIL-AUDIT-CODE 292 8 The audit code.
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Starting
Position Description
DETAIL-INCLEXCL-AREA 301 60 Include/exclude data range.
DETAIL-RES-NUMBER 362 2 Number of resources being tracked
in the following fields.
DETAIL-RES-INFO 365 X Occurs 1 to 100 times depending
DETAIL-RES-NUMBER (see preceding).
DETAIL-RATE-CODE The resources rate code.
DETAIL-RESOURCE-VAL The resource value.
DETAIL-RESOURCE-SIGN This field is blank if the resource is
positive

and '-' if the resource is negative.

CIMS Ident File

This file is created by CIMSACCT and contains all the identifiers (such as user ID,
jobname, department code, server name, etc.) that are contained in the input records.
These identifiers are used during account code conversion to create your target account
code structure. This is a simple, comma-delimited file.

The following is the file layout for the CIMS Ident File.

Field Description

UNIQUE LOAD ID The unique ID for the load.

RECORD NUMBER The record number.

IDENTIFIER NAME The name of the identifier (e.g., Jobname).
IDENTIFIER VALUE The value for the identifier (e.g., ACPSJEFU).
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CIMSBILL Detail File

This file is created by CIMSBILL and is a key component of the drill down feature of
CIMS Server Web Reporting.

The CIMSBILL Detail File differs from the CIMSACCT Detail File in that the CIMSBILL
Detail File reflects any proration, CPU normalization, or include/exclude processing that
was performed. The CIMSBILL Detail File also includes accounting dates.

As of CIMS Server 3.2, Detail file version number 200306 is the current file. Version
number 200106 is deprecated. The version number is in the DETATL-EYE-CATCH field,
starting position 14.

CIMSBILL Detail File Version 200306

The following is the file layout for the current version of the CIMS Detail File as of CIMS

Server 3.2.
Starting
Position Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detail file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-1ID 90 32 The work id where the record came

from (could be subsystem name,
could be oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
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CIMSBILL Detail File

Starting

Position

Description

DETAIL-END-TIME

ACCOUNTING-START-DATE

ACCOUNTING-END-DATE

DETAIL-SHIFT

DETAIL-DOW

DETAIL-ACCOUNT-CODE

DETAIL-AUDIT-CODE

DETAIL-INCLEXCL-AREA

DETAIL-RES-NUMBER

DETAIL-RES-INFO

DETAIL-RATE-CODE

DETAIL-RESOURCE-VAL

DETAIL-RESOURCE-SIGN

150
159
168
177
179
181
310
319

380

383

128

60

The end time of the record.

The accounting period start date.
The accounting period end date.
The shift code.

The day of week.

The account code.

The audit code.

Include/exclude data range.

Number of resources being tracked in
the following fields.

Occurs 1 to 100 times depending
detail-res-number (see above).

The resources rate code.
The resource value.
This field is blank if the resource is

positive
and '-' if the resource is negative.

H B-8
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CIMSBILL Detail File Version 200106

This file is deprecated as of CIMS Server 3.2, see CIMSBILL Detail File Version 200306 on

page B-7.
Starting
Position  Length Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detail file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-ID 90 32 The work ID where the record came

from (could be subsystem name,
could be oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
DETAIL-END-TIME 150 8 The end time of the record.
DETAIL-SHIFT 159 1 The shift code.

DETAIL-DOW 161 1 The day of week.
DETAIL-ACCOUNT-CODE 163 128 The account code.
DETAIL-AUDIT-CODE 292 8 The audit code.
DETAIL-INCLEXCL-AREA 301 60 Include/exclude data range.
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Starting
Position Length Description
DETAIL-RES-NUMBER 362 2 Number of resources being tracked
in the following fields.
DETAIL-RES-INFO 365 X Occurs 1 to 100 times depending
detail-res-number (see preceding).
DETAIL-RATE-CODE The resources rate code.
DETAIL-RESOURCE-VAL The resource value.
DETAIL-RESOURCE-SIGN This field is blank if the resource is
positive
and "-" if the resource is negative.
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CIMS Summary File

This file is created by CIMSBILL and provides resource usage and cost data used for Web
reports or for input to other financial or resource accounting systems.

As of CIMS Server 3.2, Summary file version number 200306 is the current file. Version
number 200106 is deprecated. The version number is in the Release ID field, starting
position 262.

Summary File Version 200306

The following is the file layout for the current version of the CIMS Summary File as of
CIMS Server 3.2.

Field Start Position Length Type
“SUMMARY” 1 8 Character
Version 9 3 Numeric
Reserved 12 3 Numeric
Reserved 15 3 Numeric
Reserved 18 3 Numeric
AccountCode 21 128 Character
RateTable 149 8 Character
SourceSystem 157 1 Character
RateCode 158 8 Character
ShiftCode 166 1 Numeric
AccountingFromDate 167 8 Numeric
AccountingToDate 175 8 Numeric
BillFlag1 183 1 Character
BillFlag2 184 1 Character
BillFlag3 185 1 Character
BillFlag4 186 1 Character
BillFlag5 187 1 Character
BillFlag6 188 1 Character
BillFlag7 189 1 Character
BillFlag8 190 1 Character
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Start Position
BillFlag9 191 1 Character
BillFlag10 192 1 Character
BillFlag11 193 1 Character
RateValue 194 18 Numeric
ResourceUnits 212 18 Numeric
MoneyValue 230 18 Numeric
Breakld 248 1 Character
Conv Factor 249 13 Numeric
Release ID 262 6 Numeric
Date-Century 268 2 Numeric
Date-Year 270 2 Numeric
Date-Month 272 2 Numeric
Date-Day 274 2 Numeric
Time-HH 276 2 Numeric
Time-MM 278 2 Numeric
Time-SS 280 2 Numeric
Period 282 2 Numeric
Year 284 4 Numeric
UsageStartDate 288 8 Numeric
UsageEndDate 296 8 Numeric
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Summary File Version 200106

This file is deprecated as of CIMS Server 3.2, see Summary File Version 200306 on

page B-11.

Field Start Position Length Type
“SUMMARY” 1 8 Character
Version 9 3 Numeric
Reserved 12 3 Numeric
Reserved 15 3 Numeric
Reserved 18 3 Numeric
AccountCode 21 128 Character
RateTable 149 8 Character
SourceSystem 157 1 Character
RateCode 158 8 Character
ShiftCode 166 1 Numeric
FromDate 167 8 Date
ToDate 175 8 Date
BillFlag1 183 1 Character
BillFlag2 184 1 Character
BillFlag3 185 1 Character
BillFlag4 186 1 Character
BillFlag5 187 1 Character
BillFlag6 188 1 Character
BillFlag7 189 1 Character
BillFlag8 190 1 Character
BillFlag9 191 1 Character
RateValue 192 18 Numeric
ResourceUnits 210 18 Numeric
MoneyValue 228 18 Numeric
Breakld 246 1 Character

CIMS Server Administrator's Guide B-13 W



B File Layouts
CIMS Summary File

Start Position
Period 247 2 Character
Conv Factor 249 13 Numeric
Release ID 262 6 Numeric
Date-Century 268 2 Numeric
Date-Year 270 2 Numeric
Date-Month 272 2 Numeric
Date-Day 274 2 Numeric
Time-HH 276 2 Numeric
Time-MM 278 2 Numeric
Time-SS 280 2 Numeric
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This appendix describes of the scripts included in the CIMS Server installation. These
scripts are located in the following locations (if you installed CIMS Server in the default
location) :

m C:\Program Files\CIMSLab\Scripts
H ...\Scripts\Batch Reporting
m ... \Scripts\Client Load

B ... \Scripts\Desktop

Important! « Some scripts change or purge the data in your database. If you are
unsure whether you should use a particular script, consult CIMS Lab (see Contacting
Technical Support on page 6-7).

If you make changes to a script, make sure that you rename the file. Otherwise, the
file will be overwritten when you upgrade to a new version of CIMS Server.

RUNNING SCHIPES « oottt iiiiiiiiiiiiitieitieitteetenenenssesecscscncncnsnnns Cc-3
L 4 TS) = 1 5 o ] Cc-3
CIMIS LD WST .« o e C3
CIMSURIISIWSC .« oo e e e C3
CleanUpP.WSE . ... Cc3
ClientPropagate.Wst . . ... ... e C4
ConvertSummaryDailyToMonthly.wsf . ... .. . e C5
EXportClientTOMV S.WST . . .. e c-7
EXpOrtRateTOMV S WST . . o e c-8
FTP.wsc and FTPSample.wst . . . ... e e Cc-8
PrOCCIMI S W ST C-8
ProcCoONVENGINE.WST . ... o Cc-8
PurgeDetail. WSt . .. .. c9
Rebill.wsf and ResourceConversion.wsf .............. . i C10
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B C2

SampleMonthly. WS . ... e C12
SampleNightly. WS . ... e C12
SCANWST C12
SeNAMail WSt . o c13
SIS . o C13
Batch Reporting SCHPES ..o.vuiriniiiiiiiiiiiiiiiiiiiiiiiiiiiiieieieieieiecnencnenenanss C-14
BatCnReP Ot WSt . . .o e c14
Al ACAS ST L C-22
ClieNt Load SCHPES «.vuuiuiiiiiiiiiiiiiiiieieteteeieeotoseseseresossssssssesasesessssns C-24
LoadClientTableFromCSVFilewsf . ... ... .. i C24
DESKEOP SCHIPES «oiiiiiiiiiiiiiiiiiiiiitiitieieiiteeetetesessososasesesessssssasesasnss c-24
UnloadDesktop<Client/Rate/Summary>ForServer.wsf ........... ... ... ... oo io... C24
(010 SO o | - | 1T (] C-25
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Running Scripts

The scripts described in this chapter are run from command prompt.

General Scripts

The scripts described in this section are in C:\Program Files\CIMSLab\Scripts (if you
installed CIMS Server in the default location) .

CIMSLib.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

CIMSUtils.wsc

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

CleanUp.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.
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ClientPropagate.wsf

This script propagates account names and contact information of top level account codes
to lower level account codes that do not have account names. This script will not overwrite
existing account names.

For example, the account code AABBBBCCC contains three levels: the top level, two-digit
company code AA, the 6-digit division code AABBBB, and the 9-digit department code
AABBBBCCC. If account name for the account code AA is ABC Headquarters, the name
ABC Headquarters and any contact information will be assigned to account codes
AABBBB and AABBBBCCC.

ClientPropagate.wsf Script Parameters

The ClientPropagate.wsf script uses the following parameters. If needed, you can create
a batch script to run this script and pass the parameters.

Parameter Description/Values

Toplevellength The length of the top level account code. This account
code must have a valid account name.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

Table C-1 - ClientPropagate Script Parameters
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ConvertSummaryDailyToMonthly.wsf

Important! ¢ This script consolidates daily CIMS Summary records into a monthly
record. Consult CIMS Lab before using this script (see Contacting Technical Support on
page 6-7).

The ConvertSummaryDailyToMonthly.wsf script consolidates the daily data in your CIMS
Summary table so that data is stored at a monthly level. (For more information about
the CIMS Summary table, see Chapter 5, Processing Data and CIMS Summary Table on
page A-37). This script calls the CIMSSp_ConvertSummaryDailyToMonthly stored
procedure, which is built in the CIMS Server database. This stored procedure aggregates
the daily summary records and produces a monthly summary record with Monthly
Aggregation listed as the source file name in the CIMS Load Tracking table.

This consolidation process minimizes storage space used (there is typically a 90 percent
or greater reduction in Summary records) and decreases the time required to generate
monthly reports. A drawback to this consolidation is that you cannot run costed daily
reports against the CIMS Summary table.

Note ¢ The ConvertSummaryDailyToMonthly.wsf script is intended primarily to
improve reporting performance. To drastically reduce storage spaced used by the
database, you can run the PurgeDetail.wsf script (see PurgeDetail.wsf on page C-9).
This script purges data from the CIMS Detail and CIMS Detail Ident tables.

Before the monthly CIMS Summary aggregated data is created, daily data is copied from
the CIMS Summary table to the CIMS Summary Daily table for archival purposes. You
can then run daily summary reports against the CIMS Summary Daily table.
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ConvertSummaryDailyToMonthly.wsf Script Parameters

The ConvertSummaryDailyToMonthly.wsf script uses the following parameters. If needed,
you can create a batch script to run this script and pass the parameters.

Parameter Description/Values

StartDate and EndDate
(required)

DataSourceID, 0DBCUserID,
and ODBCPassword
(optional)

RemoveSummaryDaily
(optional)

The start and end dates of the date range that you want
to consolidate. Typically, the start date is the first day of
the month and the end date is the last day of the month.

The values are:

m preday (previous day)

m premon (previous month)
m rndate (current day)

®m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system'’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

See ODBC Parameters on page C-25.

If this parameter is set to true, the daily records that are
archived in the CIMS Summary Daily table for this date
range are purged. If this parameter is set to false, is left
blank, or is not included, the records are maintained in
the table.

Table C-2 < ConvertSummaryDailyToMonthly Script Parameters
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ConvertSummaryDailyToMonthly.wsf Script Considerations

m If an error occurs while processing the ConvertSummaryDailyToMonthly.wsf script, the
script will back out all database changes. You can then correct the error and run the
script again.

B You cannot run the script with an EndDate parameter greater than or equal to the
current day.

m CIMS Lab recommends that you run the script only once for a particular date range.
Although the script can be run multiple times against the same date range, the CIMS
Summary Daily table is updated only once. If there is new data in a daily CIMS
Summary table and you run the script a second time, the script will fail and the
update will be backed out of the database because the data in the CIMS Summary
Daily table does not match the data in the CIMS Summary table. In this situation, you
should run the script with the RemoveSummaryDaily parameter set to true and then
rerun the script with this parameter set to false.For more information, contact CIMS
Lab (see Contacting Technical Support on page 6-7).

m The script could run for more than an hour per month. A status does not appear while
the script is running.

ExportClientToMVS.wsf

This script creates a Client file that you can load into CIMS Mainframe Data Collector
and Chargeback System.

ExportClientToMVS.wsf Script Parameters

The ExportClientToMVS.wsf script uses the following parameters. If needed, you can
create a batch script to run this script and pass the parameters.

Parameter Description/Values

OutputFilename The name of the output Client file in a file name format
that OS/390 can read.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

Table C-3 « ExportClientToMVS Script Parameters
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ExportRateToMVS.wsf

This script creates a Rate file that you can load into CIMS Mainframe Data Collector and
Chargeback System.

ExportRateToMVS.wsf Script Parameters

The ExportRateToMVS.wsf script uses the following parameters.If needed, you can run the
script and pass the parameters from the ExportRateToMVS.bat script.

Parameter Description/Values

OutputFilename The name of the output Rate file in a file name format
that OS/390 can read.

CreateRateGroups If set to true, rate groups will be created. Warning: The
(optional) rate index will be renumbered if this is set to true.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword

(optional)

Table C-4 < ExportRateToMVS Script Parameters

FTP.wsc and FTPSample.wsf

These scripts assist in performing FTP transfers from a script.

ProcCIMS.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

ProcConvEngine.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.
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PurgeDetail.wsf

Important! ¢ This script permanently removes data from the CIMS Detail and CIMS
Detail Ident tables. Consult CIMS Lab before using this script (see Contacting Technical
Support on page 6-7).

The CIMS Detail and CIMS Detail Ident tables can accumulate a large amount of data.
To control the size of these tables, you can use the PurgeDetail.wsf script to control the
number of months of database loads that you want to maintain in the tables. For
example, if you specify six months, the data loaded to the database during the current
month and the preceding six months is maintained. All data loaded to the database with
load dates prior to the specified number of months is removed permanently, not archived.

PurgeDetail.wsf Script Parameters

Important! « Make sure that you have backed up your database before running the
PurgeDetail.wsf script.

The PurgeDetail.wsf script uses the following parameters. If needed, you can run the
script and pass the parameters from the PurgeDetail.bat script.

Parameter Description/Values

MonthsToKeep (required) The number of months of database loads that you want
to keep in the CIMS Detail and CIMS Detail Ident
tables. The current month is not counted in this
number. For example, if this parameter is set to 6, the
data for the current month and the preceding six
months is maintained. Data loaded to the database with
load dates prior to the six months is purged.

SkipConfirmation If this parameter is set to false, is left blank, or is not

(optional) included, a message appears and confirmation is
required before the script is run. If this parameter is set
to true, the confirmation message does not appear.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

Table C-5 « PurgeDetail Script Parameters
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Rebill.wsf and ResourceConversion.wsf

You can recalculate rate codes that you previously processed and loaded into the CIMS
Server database using a different rate value and/or resource conversion factor without
reprocessing the data. That is, if you change the rate value and/or resource conversion
factor for a rate code in the CIMS Rate table, you can update the rate value and
conversion factor and recalculate the money value directly in the CIMS Summary table.
(For more information about the rate code value and resource conversion factor, see
Working with Rates on page 3-9.)

CIMS Lab provides the following scripts to perform this process:

B C-10

Rebill.wsf. This script updates the rate code value and recalculates the money value
for a rate code or codes in the CIMS Summary table. If you have not changed the
resource conversion factor for a rate code or codes, you do not need to run
ResourceConversion.wsft.

ResourceConversion.wsf. This script updates the rate code resource conversion factor
in the CIMS Summary table. You need to run the Rebi11.wsf script after running this
script to recalculate the money value for the rate code.

Important! « Consult CIMS Lab before using the ResourceConversion.wsf script
(see Contacting Technical Support on page 6-7). If you run this script more than once
for the same rate code or codes, the resource units that are converted are the units
that were converted previously, not the original units. For example, if the
conversion factor for a rate code is Divide by 60 and the resource units are 120,
the resource unit value after calculating once is 2, after calculating twice it is .033
(2+60), etc.

This scenario is not applicable to the Rebil1.wsf script—you can run this script
multiple times for the same rate code or codes.
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Rebill.wsf and ResourceConversion.wsf Script Parameters

The Rebill.wsf and ResourceConversion.wsf scripts use the following parameters. If
needed, you can run these scripts and pass these parameters from the Rebi11.bat and
ResourceConversion.bat scripts.

Rebill.wsf Parameters

Parameter Description/Values

StartDate and EndDate These parameters specify the start date and end date in

(required) the CIMS Summary table for the rate codes that you
want to recalculate the money value for. Typically, the
start date is the first day of the month and the end date
is the last day of the month.

The values are:

m preday (previous day)

®m premon (previous month)
m rndate (current day)

®m curmon (current month)
B date in yyyymmdd format

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

RateCode (required) The rate code or codes that you want to recalculate. If
you want to recalculate all rate codes, set the parameter
to Al1, leave the parameter blank, or don’t include the
parameter.

RateTable (optional) The rate table for the rate code or codes. If this
parameter is left blank or is not included, the
STANDARD rate table is used.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

Table C-6 « Rebill.wsf Script Parameters
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ResourceConversion.wsf Parameters

Parameter Description/Values

StartDate and EndDate See the description for Rebill.wsf Parameters on
(required) page C-11.
RateCode (required) The rate code or codes that you want to change the

resource conversion factor for. If you want to change the
conversion factor for all rate codes, set the parameter to
A11, leave the parameter blank, or don’t include the
parameter.

CIMS Lab recommends that you do not use A11 as a
parameter because all resources for rate codes with an
specified resource conversion factor will be further
factored by that value. That is, if a resource has already
been factored, the resulting resource number, not the
original resource number, will be factored again.

DecimalPositions The number of decimal positions that will be written
(required) out by the conversion for resource units.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

Table C-7 < ResourceConversion Script Parameters

SampleMonthly.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

SampleNightly.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

Scan.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

B C-12 CIMS Server Administrator's Guide



Scripts H
General Scripts

SendMail.wsf

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

Shell.wsc

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.
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Batch Reporting Scripts

The scripts described in this section are in C:\Program Files\CIMSLab\Scripts\Batch
Reporting (if you installed CIMS Server in the default location).

BatchReport.wsf

This script runs and publishes reports in batch and directs the reports to the proper
location in the published reports folder. The final report location determines who can
view the published report in CIMS Server Web Reporting. For example, you can publish
the report to a folder for a specific group and only users in that group can view the report.
The location for the report is determined by the Dest= parameter described in Report
Parameters.

There are two types of parameters required run batch reports:
B The report parameters described in Report Parameters.

B The BatchReport.wsf script parameters described in BatchReport.wsf Script Parameters
on page C-21.

Report Parameters

To specify the report(s) that you want to run and to provide processing instructions, you
need to create a file containing the parameters for the report. The parameters required
depend on the reports that you are running and other factors such as where you are
running the BatchReport.wsf script.

One file may contain the parameters required to run multiple reports. CIMS Lab
provides a sample parameter files for running a single report (inputl.txt) and multiple
reports (input2.txt). If you installed CIMS Server in the default location, these files are
in C:\Program Files\CIMSLab\Scripts\Batch Reporting. To use these files to publish
sample reports, follow the steps in the readme.txt file.

Any line in the report parameter file that begins with an asterisk (*) or does not include
an equal sign (=) is considered a comment.

The parameter listed in Table C-8 on page C-15 are used for the Standard reports
included in the CIMS Server installation. (For a description of each of these reports, refer
to the CIMS Server Web Reporting User’s Guide). The parameters for custom reports used
by your organization may differ.
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Parameter Description/Values

Run Parameters

The following parameters are applicable to the entire report run. These parameters can
be in any order, but must precede report-specific parameters.

LOCALDRIVE= If you are running the BatchReport.wsf script on a
(optional) computer other than the Web server, the drive that you are
mapping to that contains the CIMS Server Reports folder.

Example: LOCALDRIVE=W

To enable drilldown within published invoices, you need set the following three
parameters as required. For more information about drilling down in reports, refer to
the CIMS Server Web Reporting User’s Guide.

RUNSERVERNODE= The name of the server running the CIMS Server Web

(optional) Reporting Web site. For more information about drilling
down in reports, refer to the CIMS Server Web Reporting
User’s Guide.

Example: RUNSERVERNODE=SERVERABC

RUNPORTNUMBER= If the port number for the Web site if it is other than port 80.
(optional) Example: RUNPORTNUMBER=81

RUNVIRTUALDIRECTORY=" The virtual directory name of the CIMS Server Web
(optional) Reporting Web site.

Example: RUNVIRTUALDIRECTORY=DIRECTORYABC

Table C-8 - Batch Report Parameters
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Parameter Description/Values

Report Parameters

The following parameter are applicable to the entire report run. These parameters can
be in any order, but cannot precede the run parameters described previously.
Parameter requirements vary by report.

The report must be a Crystal Report in the Custom or Standard report folder. The
following report identification parameters specify the beginning of a new report
request. For an example, refer to the file input?.txt in the Batch Reporting folder.
RUNREPORT= The file name of the report that you want to publish.

(required for reports) gxample: RUNREPORT=XSUMCOO1 . rpt

RUNINVOICE= If you want to publish an invoice with invoice numbers,
(required for that is, Invoice by Account Level, Invoice with Shifts, etc.,
invoices) use this parameter to specify the file name of the invoice.

Example: RUNINVOICE=RINVC007.rpt

RUNSPREADSHEET= The file name of the spreadsheet that you want to publish.
(required for Example: RUNSPREADSHEET=SYTDCO01 . rpt

spreadsheets)

ACCOUNTSTRUCTURE= The name of the account code structure to be used for the
(optional) report. If you are using the account code structure Standard,

this parameter is not required. If you are not using the
Standard account code structure, this parameter is required
after the report parameter

Note that you can use more than one account code structure
in the parameter file. The BatchReport.wsf script will use
the first account structure specified or the Standard structure
until it encounters another ACCOUNTSTRUCTURE= parameter.
Each time the script encounters a different parameter it will
use that parameter.

If the account code structure varies by report, you need to
specify Standard as a parameter if it follows a different
ACCOUNTSTRUCTURE= parameter.

Examples: ACCOUNTSTRUCTURE=Standard
ACCOUNTSTRUCTURE=D1ivisionA

Table C-8 < Batch Report Parameters (Continued)
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Parameter Description/Values

The following date parameters specify the date for the data in reports. The parameters
used depend on the report.

RUNDATESTART= and The start and end dates for the data that you want to appear

RUNDATEEND= in the report in the format mm/dd/yyyy.

ﬁgggt}ﬂtged depending on All reports within the report parameter file use these
parameters until another set of RUNDATESTART and
RUNDATEEND parameters or another date parameter (see the
following) is encountered. These parameters must appear
before the report identification parameters. For an example,
refer to the file input?2.txt in the Batch Reporting folder.
Example: RUNDATESTART=07/01/03

RUNDATEEND=07/31/03
REPORTMONTH= The month for the data that you want to appear in the

(required depending on Treportin the format mm.

report) Example: REPORTMONTH=07

REPORTYEAR= The year for the data that you want to appear in the report
(required depending on 11 the format yyyy.

report) Example: REPORTYEAR=2003

USER= The user ID used to execute the report. The report will
(required) contain only those clients that are assigned to the user’s user

group (see Adding or Removing Client Access to/from a Group
on page 3-33). If you have restricted client access for some
users, make sure that you do not execute the report using a
user ID that can view all clients.

Example: USER=admin

Table C-8 « Batch Report Parameters (Continued)
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Parameter Description/Values

DEST= The report must be saved in the published reports folder
(required) specified on the Reports tab in the Configuration dialog
box (see Reporting Settings on page 3-45). This parameter
specifies the destination location of the report as follows:

B DEST=GLOBAL. The report will be stored in the
following global subfolder in the published reports
folder. The report is available to anyone using CIMS
Server Web Reporting.

m DEST=GROUP=group id. The report will be stored in a
subfolder with the same name as the group id in the
group subfolder in the published reports folder. For
example, the destination for DEST=GROUP=Admin would be
.../group/Admin. The report is available only to users in
the specified group.

m DEST=USER=user id. The report will be stored in a
subfolder with the same name as the user id in the user
subfolder in the published reports folder. For example,
the destination for DEST=USER=joe would be . . ./group/
joe. The report is available only to that user.

B DEST=ACCOUNT=account code. The report will be
stored in a subfolder with the same name as the account
code in the account subfolder in the published reports
folder. For example, the destination for DEST=ACCOUNT=AA
would be

.../account/AA. The report is available only to users in a
group that is allowed to view the selected client account
code (see Adding or Removing Client Access to/from a Group
on page 3-33).

REPORTPERIOD= Published reports are further stored in a subfolder

(optional) indicating the report period. For example, .../account/AA/
200307 (July 2003). The report period is in YYYYMM
format. If this parameter is not included or is left blank, the
folder name defaults to the current period.

The report period can be any date. It does not have to reflect
the dates of the data in the report.

Depending on the report type specified by the RUNREPORT/
INVOICE/SPREADSHEET= parameter, a subfolder named
Reports or Spreadsheets is automatically created in the
report period folder. The published reports reside in this
folder. For example, the path for a published Invoice by
Account Level report might appear as follows: .../
Published/account/AA/200307/Reports/rinvc007.rpt.

Example: REPORTPERIOD=200306

Table C-8 < Batch Report Parameters (Continued)

B C-18 CIMS Server Administrator's Guide



Scripts H

Batch Reporting Scripts

Parameter Description/Values

NAME=
(optional)

The file name that you want to assign to the report. The
report is saved with the extension .rpt.

If this parameter is not included or is left blank, the name
defaults to the file name specified by the RUNREPORT/
INVOICE/SPREADSHEET= parameter.

Note that if you assign a new file name, the report will not
be included in the end user’s favorite reports list in CIMS

Server Web Reporting. For more information about favorite
reports, refer to the CIMS Server Web Reporting User’s Guide.

Example: NAME=AccountlLevelInvoice

Some invoice reports contain separate invoices for the account codes selected. The first
invoice number is read from the CIMS Config Options table. This number is set in the
the in the Configuration dialog box (see Invoice Subtab on page 3-47).

The invoice numbers continue to increase sequentially in the table each time you run
an invoice. For example, if the last invoice in a report was 99, the next invoice that you
run will begin with invoice number 100.

If you do not want to use the invoice number in the table when your run the
BatchReport.wsf script, use the INVOICENUMBER= parameter.

INVOICENUMBER=
(optional)

INVOICELEVEL=
(required)

ACCOUNTCODESTART= and
ACCOUNTCODEEND=

(required)

This parameter sets the number at which you want invoice
numbers within the report to begin. Invoices numbers
increase in sequential order from this number.

The invoice number in the CIMS Config Options table is
not used or changed when this parameter is used.

Example: INVOICENUMBER=10

A number representing the account code level that you want
to view in the report. For example, the account code
AABBBBCCC might contain three levels: the company code
AA, the division code AABBBB, and the department code
AABBBBCCC. The resource usage and charge data will
reflect the level that you specify—1, 2, or 3.

Example: INVOICELEVEL=2

This parameter works in conjunction with the Invoicelevel
parameter (see the following) and specifies the account
codes for that level that appear in the report. For example,
if INVOICELEVEL=2 and you want data for account codes
AABBBB, BBBBBB, CCBBBB, and DDBBBB, enter AA as the
starting account code and DD as the ending account code.

Table C-8 - Batch Report Parameters (Continued)
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Parameter Description/Values

GRAPH= If this parameter is Y a graph appears before the report. If

(optional) this parameter is N, is left blank, or is not included, the
graph does not appear.
Example: GRAPH=Y

IDENTIFIER= The identifier that you want to report data by.

(required for some Example: IDENTIFIER=JOBNAME

reports)

RATECODE= The rate code that you want to report data by.

(required for some Example: RATECODE=2003

reports)

RATEGROUP= The rate group that you want to report data by.

(required for some Example: RATEROUP=0Oracle charges

reports)

TERMINALIDSTART= and ~ The CICS terminal ID range that you want to report data by.

TERMINALIDEND= For example, if you want data for the terminal IDs 3191,

(required for some 3C02, and 8A33, enter 3191 as the starting transaction ID

reports) and 8A33 as the ending ID. Numbers precede letters in the
range order. Therefore, 3191 precedes 3C02.

TOPN= The number of account codes that appear in a report or the

(optional) drilldown for a report. For example, if you enter 1, only the

account code that used the most resources or incurred the
most charges appears. If you enter 2, the highest and second
highest account codes appear.

Example: TOPN=3

TRANSACTIONTYPE= The transaction type that you want to report data by. For
(required for some more information about transactions, refer to the CIMS
reports) Server Web Reporting User’s Guide.

Example: TRANSACTIONTYPE=Recurring

Table C-8 - Batch Report Parameters (Continued)
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ZEROCOSTPROCESSINGOPTI  One of the following letters indicating how the The Zero

ON= Cost Invoice report will be processed:
ﬁ gggwﬁgid for some m A —This factors the invoice total by the zero cost amount.
m B—This factors each resource rate in the invoice by the
Zero cost amount.
Example: ZEROCOSTPROCESSINGOPTION=A
ZEROCOSTAMOUNT The zero cost amount. You can enter this amount with our

without the decimal point. For example, 100000 or
100000.00. For more information about zero cost, refer to
page 3-11.

Example: ZEROCOSTAMOUNT=50000

Table C-8 « Batch Report Parameters (Continued)

BatchReport.wsf Script Parameters

The BatchReport.wsf script uses the following parameters. If needed, you can create a
batch script to run this script and pass the parameters.

Parameter Description/Values

Input The file that contains the parameters needed to process
the report (see Report Parameters on page C-14).

LogFolder The full path for the output file that logs the batch
reporting process. The file name is VYYYMMDDHHMM. txt.
The use of a UNC path is recommended.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

Silent (optional) If this parameter is set to Y, no messages appear when
the BatchReport .wsf script is run. If this parameter is set
to Nor is not included, interactive messages appear and
you must click OK to continue.

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not included, this information does not appear in the
log file.

Table C-9  BatchReport Script Parameters
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AllAccts.wsf

B C-22

This script produces the report parameter files that are used by the BatchReport.wsf to
publish reports in batch. The primary purpose of this script is to retrieve the account
codes associated with a user from the database and to create the parameters required to
run a separate report for each account code.

You can create the report parameter file without using the A11Accts.wsf script. In
addition, the script does not provide all required parameters for some reports. To create
a report parameter file or to add parameters to a file created by the A11Accts.wsf script,
refer to Report Parameters on page C-14.

The Al1Accts.wsf script requires an input file to determine the content of the report
parameters file. The parameters for this input file are described in Input File Parameters.
The parameters required process the input file are described in AllAccts.wsf Script
Parameters on page C-23.

Input File Parameters

To specify the parameters that you want to appear in the report parameter file, you need
to create an input file containing the parameters shown in Table C-11. You can add the
parameters in any order.

You can include other parameters in the input file, but only the parameters in Table C-11
are used by the Al1Accts.wsf script. Any other parameters are passed to the report
parameters file.

Any line in the input file that begins with an asterisk (*) or does not include an equal
sign (=) is considered a comment.

CIMS Lab provides a sample input file, input3.txt, that you can use to create a report
parameter file. If you installed CIMS Server in the default location, this file is in
C:\Program Files\CIMSLab\Scripts\Batch Reporting. Follow the steps in the
readme.txt file.

Parameter Description/Values

LOCALDRIVE= If you are running the Al1TAccts.wsf script on a computer
(optional) other than the Web server, the drive that you are mapping
to that contains the CIMS Server Reports folder.

Example: LOCALDRIVE=W

ACCOUNTSTRUCTURE= The name of the account code structure to be used (see
(required) Defining the Account Code Structure on page 3-4).

Example: ACCOUNTSTRUCTURE=Standard

USER= The user ID. Only those account codes to which the user has
(required) access are included in the report parameter file (see Adding
or Removing Client Access to/from a Group on page 3-33).

Table C-10 - Allacct.wsf Input File Parameters
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INVOICELEVEL= A number representing the account code level that you want
(required) to view in the report. For example, the account code

AABBBBCCC might contain three levels: the company code
AA, the division code AABBBB, and the department code
AABBBBCCC. The resource usage and charge data will
reflect the level that you specify—1, 2, or 3.

Example: INVOICELEVEL=2

RUNREPORT= The file name of the report that you want to publish.
(required) Example: RUNREPORT=XSUMCO01 . rpt

RUNINVOICE= If you want to publish an invoice with invoice numbers,
(required) that is, Invoice by Account Level, Invoice with Shifts, etc.,

use this parameter to specify the file name of the invoice.

Example: RUNINVOICE=RINVCO07.rpt

RUNSPREADSHEET= The file name of the spreadsheet that you want to publish.
(required) Example: RUNSPREADSHEET=SYTDCOO1 . rpt

Table C-10 « Allacct.wsf Input File Parameters (Continued)

AllAccts.wsf Script Parameters

The Al1TAccts.wsf script uses the following parameters. If needed, you can create a batch
script to run this script and pass the parameters.

Parameter Description/Values

InputFile The file that contains the parameters needed to create
the report parameters file used by the BatchReport.wsf
script (see Report Parameters on page C-14).

QutputFile The output report parameters file.

LogFolder The full path for the output file that logs the process of
creating the report parameters file. The file name is
YYYYMMDDHHMM. txt. The use of a UNC path is
recommended.

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not included, this information does not appear in the
log file.

Table C-11 « AllAccts Script Parameters
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Client Load Scripts

Client Load Scripts

The scripts described in this section are in C:\Program Files\CIMSLab\Scripts\Client
Load (if you installed CIMS Server in the default location).

LoadClientTableFromCSVFile.wsf

This script loads the data in a comma-delimited file into the CIMS Client table.

LoadClientTableFromCSVFile.wsf Script Parameters

The LoadClientTableFromCSVFile.wsf script uses the following parameters. If needed,
you can create a batch script to run this script and pass the parameters.

Parameter Description/Values

DataSourcelD, ODBCUserID, See ODBC Parameters on page C-25.
and ODBCPassword
(optional)

ClientFilename The full path for the file to be loaded. The use of a UNC
path is recommended.

Table C-12 + LoadClientTableFromCSVFile Script Parameters

Desktop Scripts

The scripts described in this section are in C: \Program Files\CIMSLab\Scripts\Desktop
(if you installed CIMS Server in the default location).

UnloadDesktop<Client/Rate/Summary>ForServer.wsf

B C24

These scripts export the data from the CIMS Desktop Client, Rate, and Summary tables
into a comma-delimited text file. This file can then be loaded into the CIMS Server
database (see To load or export a table: on page 4-12).

UnloadDesktop<Client/Rate/Summary>ForServer.wsf
Script Parameters

The UnloadDesktop<Client/Rate/Summary>ForServer.wsf script uses the following
parameters. If needed, you can create a batch script to run this script and pass the
parameters.

Parameter Description/Values

Databaselocation The full path to the CIMS Desktop database. The use of
a UNC path is recommended.

Outputlocation The full path and file name for the exported table. The
use of a UNC path is recommended.

Table C-13 + UnloadDesktop<Client/Rate/Summary>ForServer Script Parameters
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ODBC Parameters

The following optional ODBC parameters are common to many of the scripts described
in this chapter.

Parameter Description/Values

DataSourcelD The ODBC data source or data source UID for the CIMS
Server database.

If you are using only one database with CIMS Server, do
not include this parameter. The data source selected in
the Select ODBC Data Source dialog box is used as the
data source (see To create a data source: on page 4-5).

If you are using multiple databases with CIMS Server,
enter the UID for the data source. The data source UID
is entered in the Data Source List Maintenance dialog
box (see Setting a Unique Identifier for an

ODBC Data Source on page 4-7).

0DBCUserID and These parameters are deprecated. They were previously

ODBCPassword used to pass the SQL Server user ID and password for
the database (if required). For security and convenience,
the user ID and password are retrieved from CIMS
Server Administrator.

Table C-14 «+ Common ODBC Parameters
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Control and Processing
Statements

This appendix describes the statements in the AcctCnt1.txt, Bill1Cnt1.txt, and
ProcessCntl.txt files.

CIMSACCT Control Statements .........cooeiuiiiiiiiiiiiiiiiiiiiiiieieieeienieneciecncnnens D-3
ACCOUNT CODE CONVERSION .. . e e e e e e e e e D-5
ACCOUNT FIELD . . . oottt ettt et e e e e e e e e e e e e e e e e e e D-5
DATE SELECTION . ..ottt e e e e e e e e e e e e e e e e D-6
DEFINE FIELD . . .o e e e e et e e e e e D-7
DEFINE MOVEFLD . ..ottt e e e e e e e e e e e e e D-8
EXCEPTION FILE PROCESSING ON ... o e e e e et e e D-9
IGNORE ORIGINAL SOURCE IDENTIFIERS . ... ..ot D-10
INCLUDE FIELD . . . .o e e e e e e e e e e e et e D-10
PROCESS ... e D-11
PRINT ACCOUNT NO-MATCH . . . oottt e e e e et e e e e e D-11
SHIFT e e e e D-11
TEST ottt e D-12
UPPERCASE ACCOUNT FIELDS . .. o e e e e et et e D-13
VERIFY DA A o e e D-13
CIMSBILL Control Statements ........cciiuiiiiiiiiiietiieeiieeieceeeceescssscesccnsccnss D-14
BACKLOAD DAT A o e e e e e e e e e e D-16
CLIENT SEARCH ON . ..ot e e e e e e e D-16
DATE SELECTION ... e e e e e e e e e e e e e e e e e e D-17
DEFAULT CLOSE DAY .ottt et e e e e e e e e e e i D-18
DEFINE . . o e e D-19
DYNAMIC CLIENT ADD ON ..ottt ettt et e et e e e e e e e D-21
EXCLUDE . . .o e e e e D-21
INCLUDE ... e e e e e e D-22
NORMALIZE CPU VALUES . . ..ot e et e e e D-22
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PROCESS . ..ottt D-23
PRORATE MONEY ..o e e e e e e D-23
PRORATE RESOURCES . . . . . ottt e e e e e e D-24
PRINT PRORATION REPORT . . . .. e D-25
REPORT DATE ..ottt e e e e D-25
USE SHIFT CODES . ..ottt e e e e e e D-26
TEST e e D-26
Processing Control Statements .........c.ccieiiiiiiiiiiiiiiiiiiiiiiiiiiiiieieieicneenenes D-27
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CIMSACCT Control Statements

This section describes control statements that you can use in the CIMSACCT Control
File, AcctCnt1.txt. By default, the control statements in the control file reflect the
process definition settings in CIMS Server Administrator (see CIMS Server Administrator
Processing on page 5-17). However, some optional statements do not have a
corresponding GUI option and must be entered in the control file manually.

Where applicable, the control statement descriptions in this section include a reference
to the corresponding option in CIMS Server Administrator.

Note ¢ Control statements are not case-sensitive, except for the literals in the DEFINE
MOVEFLD statement (see page D-8).

CONTROL STATEMENT SEE DESCRIPTION

ACCOUNT CODE CONVERSION [page D-5] Specifies processing of the CIMS account
code conversion table.

ACCOUNT FIELD [page D-5] Defines how to build the account code
from the identifiers within the input file
record.

DATE SELECTION [page D-6] Defines a date range for records to be
processed by CIMSACCT.

DEFINE FIELD [page D-7] Used only during account code

conversion. Defines the fields for
comparison within the account code
input field (which is built from the
ACCOUNT FIELD statements or from the
identifier Account_Code).

DEFINE MOVEFLD [page D-8] Used only during account code
conversion. Defines the fields that are to
be moved from the account code input
field (which is built from the ACCOUNT
FIELD statements or from the identifier
Account_Code) to the account code
output field.

EXCEPTION FILE PROCESSING ON [page D-9] Used only during account code
conversion. When present, any record
that does not match an entry in the
account code conversion table is written
out to the exception file.

IGNORE ORIGINAL SOURCE [page D-10]  Specifies that CIMSACCT does not write
IDENTIFIERS the identifiers SourceName and
Sourceline to the CIMS Ident File.
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CIMSACCT Control Statements

CONTROL STATEMENT

DESCRIPTION

INCLUDE FIELD

PROCESS

PRINT ACCOUNT NO-MATCH

SHIFT

TEST

UPPERCASE ACCOUNT FIELDS

VERIFY DATA

[page D-10]

[page D-11]

[page D-11]

[page D-11]

[page D-12]

[page D-13]

[page D-13]

Moves identifiers into an area that is
used by CIMSBILL for include/exclude
processing.

Specifies the type of data that is
contained in the input file. CIMSACCT
can process only one type of data at a
time.

Prints the first 1000 input identifiers
that are not matched during account
code conversion.

Sets up the shifts within the system.

Prints tracing messages to the
CIMSACCT Message File.

Specifies that the account code built
from the account code input field is
uppercase.

Specifies whether CIMSACCT is to check
for embedded nulls.
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ACCOUNT CODE CONVERSION

Related interface option: Perform Account Code Conversion, see page 5-35.
Format:
ACCOUNT CODE CONVERSION

This statement enables account code conversion using and DEFINE FIELD and DEFINE
MOVEFLD statements and the account code conversion table.

When account code conversion is enabled, all no-match records are written to the
CIMSACCT Detail File with the unconverted account code input field value. If you want
the record written to an exception file for later processing, you must add the control
statement Exception File Processing On.

ACCOUNT FIELD

Related interface option: Account Fields, see page 5-34.
Format:

ACCOUNT FIELDn,identifier_name,offset_into_identifier,length
n=0-9 (up to 10 ACCOUNT FIELD statements supported)
offset_into_identifier = 1-255

length = 1-255

Note ° The overall length of all account fields added together cannot exceed 500
characters.

This statement defines the identifier(s) that you want to use to build the account code.
Begin at ACCOUNT FIELDO and continue sequentially as needed. The account fields are
used (along with DEFINE FIELD and DEFINE MOVEFLD statements) in account code
conversion if account code conversion is enabled. If account code conversion is not
enabled, then the account code is built directly from this statement or from the
Account_Code identifier in the input file records (if present). For more information, see
Defining the Account Code on page 5-34.

Example:

ACCOUNT FIELDO,UserName,1,10
ACCOUNT FIELDI,Division,1,2

In this example, the UserName and Division identifiers will be used to create the account
code. The offset for both identifier values is 1 and the length of the values are 10 and 2,
respectively.

If the UPPERCASE ACCOUNT FIELDS statement is specified, lowercase identifier values in the
account field are converted to uppercase values.
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CIMSACCT Control Statements

DATE SELECTION

H D-6

Related interface option: Input—Date Selection, see page 5-22.
Format:
DATE SELECTION {YYYYMMDD YYYYMMDD | keyword}

This statement defines a date range for records to be processed by CIMSACCT. Records
are selected by the end date in the record (either the usage end date or the accounting
end date, depending on the record type). You can use the following values:

® From and to dates. For a record to be selected, it must be greater than or equal to the
From date and less than or equal to the to date.

or

m One of the following keywords:

Keyword Description

**RNDATE Selects records based on the run date

**CURDAY Selects records based on the run date and the run date less one day
**CURWEK Selects records based on the run week (Sun-Sat)

**CURMON Selects records based on run month

**PREDAY Selects records based on run date, less one (day)

**PREWEK Selects records based on previous week (Sun-Sat)

**PREMON Selects records based on previous month

CURRENT Selects current period from the CIMS Calendar table

PREVIOUS Selects previous period from the CIMS Calendar table

The start and end dates of data processed through CIMS Server must reflect the start and
end dates of the target billing period. If the billing period runs from January 1 through
January 31, any records produced with a date of February 1 (or later) should not be
included as part of the processing. In most cases, this data screening has already been
performed, either by CIMS Server or through the creation of data inputs reflecting the
desired date range.

Note that it is rare that you would need to limit the date range of the data used as input
to CIMSACCT. CIMSBILL provides the ability to create billing records reflecting a specific
date range (see page D-17).

Examples:
DATE SELECTION 20030601 20030630
DATE SELECTION **PREMON
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DEFINE FIELD

Related interface option: Define Fields, see page 5-35.

Format:

DEFINE FIELDn,offset,length

n=0-9 (up to 10 DEFINE FIELD statements supported)

offset = 1-500 (from the start of the account field or the Account_Code identifier value)
length=1-8

This statement is used only during account code conversion. Use this statement to
specify the offset and length of the account code input field value that you want to use
for conversion. Begin at DEFINE FIELDO and continue sequentially as needed.

For more information about using define fields, see Setting the Account Code Conversion
Options on page 5-35.

Example:

ACCOUNT FIELDO,UserName,1,10
ACCOUNT FIELDI1,Division,1,?
DEFINE FIELDO,3,8
DEFINE FIELD1,11,2

In this example, the first two characters of ACCOUNT FIELDO will not be considered for
account code conversion as specified by the offset of 3 for DEFINE FIELDO. However, the
full value of ACCOUNT FIELDI will be used because the offset for DEFINE FIELD1is 11 (the
Division identifier value starts in position 11 of the combined account fields) and the
length for both the account field and define field are the same.

For example, if the combined value for ACCOUNT FIELDO and ACCOUNT FIELDI is
AABBCCDDEEXZ, the value as defined by the DEFINE FIELDO and DEFINE FIELDI is
BBCCDDEEXZ.
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DEFINE MOVEFLD

Related interface option: Move Fields, see page 5-35.

Format:

DEFINE MOVEFLDn,offset,length,literal

n=0-9 (up to 10 DEFINE MOVEFLD statements supported)

offset = 1-128 (from the start of the account field or the Account_Code identifier value)
length=1-128

Titeral = aliteral can be moved instead of a particular field (literals in this statement are
case-sensitive)

This statement is used only during account code conversion. Use this statement to move
all or a portion of the account code input field value to a position in the output account
code. Begin at DEFINE MOVEFLDO and continue sequentially as needed.

Targets within the account code conversion table are specified as @)-@9.

Note ° Although each MOVEFLD statement can have a maximum length of 128
characters, keep in mind that the total account code output field, including any
literals and the MOVEFLD(s), cannot exceed 128 characters.

For more information about using move fields, see Setting the Account Code Conversion
Options on page 5-35.

Example:

ACCOUNT FIELDO,UserName,1,10
ACCOUNT FIELDI,Division,l1,?
DEFINE FIELDO,3,8

DEFINE FIELD1,11,2

DEFINE MOVEFLDO,11,2

In this example, the value for DEFINE MOVEFLDO specifies that the value beginning at
position 11 account code input field will be placed in the output account code as defined
by the account code conversion table.

For example, if the 2-character value beginning at position 11 is X7 and the account code
conversion table is:

BBC, , FINACCT@O
The resulting account code will be FINACCTXZ.

For more information about the account code conversion table, see Creating an Account
Code Conversion Table on page 5-38.
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EXCEPTION FILE PROCESSING ON

Related interface option: Enable Exception Processing, see page 5-35.
Format:
EXCEPTION FILE PROCESSING ON

This control statement is used only during account code conversion. When this
statement is present, any record that does not match an entry in the account code
conversion table is written to an exception file. If this control statement is not present,
the records that are not matched are written to the CIMSACCT Detail File with the
unconverted account code input field value.

For more information the exception file processing, see About Exception File Processing on
page 5-14.

Example:

EXCEPTION FILE PROCESSING ON

Considerations

m If you enable exception processing, do not include a default account code as the last
entry in the account code conversion table (e.g., ", ,DEFAULTCODE"). If a default
account number is used, records will not be written to the exception file.

B When an input file is processed through CIMS Server Administrator, the default file
name for the exception file is Exception.txt. You should rename the output
exception file so that it is not overwritten if subsequent files are created.
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IGNORE ORIGINAL SOURCE IDENTIFIERS

Related interface option: None
Format:
IGNORE ORIGINAL SOURCE IDENTIFIERS

When this control statement is present, the identifiers SourceName and Sourcel ine are
not written to the CIMS Ident File. These identifiers are built by CIMS Conversion
Engine. The SourceName identifier, which provides the name and location of the input
file, can be quite long. Use this statement if you are not interested in tracking this
information and want to conserve space.

INCLUDE FIELD

Related interface option: Include Fields, see page 5-23.

Format:

INCLUDE FIELDn,identifier_name,offset_into_identifier_value,length
n=0-9 (up to 10 INCLUDE FIELD statements supported)
offset_into_identifier = 1-255

length =1-60

Note ° The overall length of all include fields added together can not exceed 60
characters.

Use this control statement to move identifiers from the input file records into an area
that can be later used by CIMSBILL for include/exclude processing. For more
information about using include fields, see Include/Exclude Processing on page 5-52.

Example:
INCLUDE FIELDO,UserName,1,10

In this example, the UserName identifier value would be moved into the DETATL-
INCLEXCL-AREA field of the CIMSACCT Detail Records. This field is used by the CIMSBILL
DEFINE control statement to define the include/exclude fields for CIMSBILL (see

page D-19).
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PROCESS
Related interface option: Process Type, see page 5-22.
Format:
PROCESS {CIMS SERVER RESOURCE RECORDS | CIMS MAINTENANCE RECORDS FROM CIMSACCT |
EXTERNAL TRANS RECORDS | CIMS SUMMARY}
This control statement specifies the type of data that is contained in the input file.
CIMSACCT can process only one type of data at a time.
Example:
PROCESS CIMS SERVER RESOURCE RECORDS

PRINT ACCOUNT NO-MATCH
Related interface option: None
Format:
PRINT ACCOUNT NO-MATCH
When this statement is present, a message is printed in the CIMSACCT Message File
showing the identifier values from the input file that were not matched during account
code conversion. If this statement is not present, only the total number of unmatched
records is provided. The system prints up to 1000 messages.

SHIFT

Related interface option: Shifts, see page 5-24.

Format:

SHIFT [day] [code] [end time] [code] [end time] ... [code] [end time]
day = SUN | MON | TUE | WED | THU | FRI | SAT

code = 1-9 (The shift code)

end time = the end time of the shift

This control statement defines shifts within the system. Seven shift records are supported
(one for each day of the week) and up to nine shifts can be specified on each. End times
are entered in hours and minutes using the 24-hour clock.

Rules that apply to shift records:

m Day is defined as the first three letters of the day

m Up to nine shifts per day can be specified

B The preceding end time must always be less than the next end time

m No shift spans midnight
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TEST

B D-12

Example:

For the following shifts:

Monday through Friday

Shift 1 - 5 AM to 8 AM and 3:30 PM to 5 PM

Shift 2 - 8 AM to 11:30 AM and 1:30 PM to 3:30 PM

Shift 3 - 5 PM to 8 PM

Shift 4 - 9:30 PM to 12 AM and 12 AM to 5 AM

Shift 5-11:30 AM to 1:30 PM and 8 PM to 9:30 PM

Saturday and Sunday

Shift 1 - 8 AM to 5 PM

Shift 2 - 5 PM to 12 AM and 12AM to 8 AM

The SHIFT statements are as follows:

SHIFT SUN
SHIFT MON
SHIFT TUE
SHIFT WED
SHIFT THU
SHIFT FRI

SHIFT SAT

2

0800 1 1700 2 2400
0500 1 0800 2 1130
0500 1 0800 2 1130
0500 1 0800 2 1130
0500 1 0800 2 1130
0500 1 0800 2 1130
0800 1 1700 2 2400

5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
5 1330 2 1530 1 1700 3 2000 5 2130 4 2400

Related interface option: Trace flag, see page 5-25.

Format:

TEST ¢

¢ = a character (A for account code conversion messages Y for general messages)

This control statement is used to print tracing messages to the CIMSACCT Message File.

Example:

TEST A
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UPPERCASE ACCOUNT FIELDS

Related interface option: Convert account fields to uppercase during processing, see
page 5-34.

Format:
UPPERCASE ACCOUNT FIELDS

This control statement instructs CIMSACCT to convert lowercase account code input
field values to uppercase values in the resulting account code. For example, the value
ddic would be converted to DDIC. By using this option, CIMSACCT account code
processing becomes case-insensitive and makes defining account conversion tables
much easier.

VERIFY DATA

Related interface option: None
Format:
VERIFY DATA ON|OFF

This control statement instructs CIMSACCT to check for embedded null characters
within an input record (if ON is specified) and changes the null characters to spaces. Null
characters should be contained only at the end of record, not within a record. CIMS
standard interfaces do not embed nulls. Turning verification on slows processing and
should be used only when processing non-standard feeds.

The default is VERIFY DATA OFF.
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CIMSBILL Control Statements

This section describes control statements that you can use in the CIMSBILL Control File,
Bil1Cnt1.txt. By default, the control statements in the control file reflect the process
definition settings in CIMS Server Administrator (see CIMS Server Administrator

Processing on page 5-17).

The control statement descriptions in this section include a reference to the
corresponding option in CIMS Server Administrator.

CONTROL STATEMENT

BACKLOAD DATA

CLIENT SEARCH ON

DATE SELECTION

DEFINE

DYNAMIC CLIENT ADD ON

EXCLUDE

INCLUDE

NORMALIZE CPU VALUES

PROCESS

PRORATE MONEY

PRORATE RESOURCES

SEE

[page D-16]

[page D-16]

[page D-17]

[page D-19]

[page D-21]

[page D-21]
[page D-22]
[page D-22]

[page D-23]

[page D-23]

[page D-24]

DESCRIPTION

Instructs CIMSBILL to ignore the close
date. The accounting dates created by
CIMSBILL are the same as the usage end
date regardless of the close date

Instructs CIMSBILL to use the account
code structure definition to search the
CIMS Client table for the rate table
associated with a client.

Defines a date range for records to be
processed by CIMSBILL.

Defines the account code structure
used by the statements CLIENT SEARCH
ON and DYNAMIC CLIENT ADD ON. Also
defines character strings in the
CIMSBILL Detail Record that are used
for include/exclude processing.

Specifies that CIMSBILL automatically
insert corresponding client entries into
the CIMS Client table for all clients that
have a resource usage charge.

Specifies an exclude record condition.
Specifies an include record condition.
Normalizes CPU values.

Specifies the type of data that is
contained in the input file. CIMSBILL
can process only one type of data at a
time.

Splits money for a specific resource (or
all resources) among multiple accounts.

Splits a specific resource (or all
resources) among multiple accounts.

B D-14
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CONTROL STATEMENT

PRINT PRORATION REPORT

REPORT DATE

USE SHIFT CODES

TEST

SEE

[page D-25]

[page D-25]

[page D-26]

[page D-26]

CIMSBILL Control Statements

DESCRIPTION

Generates a proration report that
contains the original record and all
subsequently-generated prorated
records.

Specifies the date that is put into the
CIMS Summary Records created by
CIMSBILL.

Instructions CIMSBILL to use the shift
character specified in the CIMSACCT
Detail Record and apply the appropriate
rate shift value.

Used to print tracing messages to the
CIMSBILL Message File.
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BACKLOAD DATA

Related interface option: Back Load Data, see page 5-28.
Format:
BACKLOAD DATA

This statement instructs CIMSBILL to ignore the close date. The accounting dates created
by CIMSBILL are the same as the usage end date regardless of the close date.

CLIENT SEARCH ON

B D-16

Related interface option: Enable client search, see page 5-29.
Format:
CLIENT SEARCH ON

This statement instructs CIMSBILL to use the account code structure definition (by use
of the DEFINE Jn fields, see page D-19) to search the CIMS Client table for the rate table
associated with a client. If this statement is not specified, the STANDARD rate table is
used for all clients.
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DATE SELECTION

Related interface option: Input — Date Selection, see page 5-27.
Format:
DATE SELECTION {YYYYMMDD YYYYMMDD | keyword}

This statement defines a date range for records to be processed by CIMSBILL. Records are
selected by the accounting end date in the record. You can use the following values:

m From and to dates. For a record to be selected, it must be greater than or equal to the
from date and less than or equal to the to date.

or

m One of the following keywords:

Keyword Description

**RNDATE Selects records based on the run date
**CURDAY Selects records based on the run date and the run date less one day
**CURWEK Selects records based on the run week (Sun-at)
**CURMON Selects records based on run month
**PREDAY Selects records based on run date, less one (day)
**PREWEK Selects records based on previous week (Sun-Sat)
**PREMON Selects records based on previous month
CURRENT Selects current period from the CIMS Calendar table
PREVIOUS Selects previous period from the CIMS Calendar table
Examples:

DATE SELECTION 20030601 20030630

DATE SELECTION **PREMON
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DEFAULT CLOSE DAY

B D-18

Related interface option: Default Close Date, see page 5-26.
Format:

DEFAULT CLODE DAY=nn

nn=01-31

This statement overrides the system-wide close date set in the Configuration dialog box
(see Processing Settings on page 3-44). The year and month used for the close day reflect
the year and month in which CIMSBILL is run. For more information about the close
date, see page 5-15.

Example:
DEFAULT CLOSE DAY=8

This statement sets the close date to the eighth of the month. If the CIMSBILL run date
is 20030706, the close date is set to 20030708. If the CIMSBILL run date is 20030712,
the close date is also set to 20030708.
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DEFINE

CIMSBILL Control Statements

The DEFINE statement defines the account code structure used by the statements
CLIENT SEARCH ONand DYNAMIC CLIENT ADD ON. This statement also defines character
strings in the CIMSBILL Detail Record that are used for include/exclude processing. The
format differs depending on the use of the statement as described in the following
sections.

Account Code Fields Define

Related interface option: Account Code Search Fields, see page 5-29.

This statement is used with the CLIENT SEARCH ON and DYNAMIC CLIENT ADD ON statements
to specify the client account code structure. You can specify up to nine account levels
(fields J1-J9).

Format:

DEFINE Jn start_loc len /desc/

n=1-9

start_loc = starting position within the account code
Ten = total length of the level

desc = a description for the field

Example:

Account code AAABBBCCDDDDD contains four levels. To search from the lowest level to the
highest level, use the following define fields:

DEFINE J1 1 3
DEFINE J2 1 6
DEFINE J3 1 8
DEFINE J4 1 13
CLIENT SEARCH ON

For the previous define fields:

J1=AAA

J2=AAABBB
J3=AAABBBCC
J4=AAABBBCCDDDDD

CIMSBILL first searches for AAABBBCCDDDDD and if it does not find an entry it searches for
AAABBBCC and so on.
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Include/Exclude Fields Define
Related interface option: Define Include/Exclude Fields, see page 5-54

This statement defines any string of characters within the CIMSBILL Detail Record for
include/exclude processing.

Format:
DEFINE fd Toc len /desc/
fd = two-character field ID, for example A1l

Toc = starting position in the CIMSBILL Detail Record (see CIMSBILL Detail File on
page B-7). For example 163 is the start of the account code field.

Ten = length of the field
desc = a description for the field
Example:

In this example, you want to define UserName identifier, which starts at position 301 of
the CIMSBILL Detail File, so that you can exclude all UserName values that begin with geo.

First, define the field in CIMSACCT using the INCLUDE FIELD statement (see page D-10):
INCLUDE FIELDO,UserName,1,10

Define the field in CIMSBILL:

DEFINE Al 301 3 /usergeorge/

And then use the following EXCLUDE statement:

EXCLUDE Al geo geo
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DYNAMIC CLIENT ADD ON

Related interface option: Add new clients to Client table, see page 5-29.
Format:
DYNAMIC CLIENT ADD ON

This statement specifies that CIMSBILL automatically insert corresponding client entries
in the CIMS Client table for all clients that have a resource usage charge, but are not
entered in the table. Use this statement with caution because it can quickly fill the CIMS Client
table with extraneous records.

The inserted client entries will not include descriptions or contacts.

EXCLUDE

Related interface option: Define Include/Exclude Records, see page 5-54.
Format:

EXCLUDE fd Tow high

fd = two-character field id (from the DEFINE control statement - see page D-19)
Tow = specifies the low or from selection value (1 to 8 characters)

high = specifies the high or to selection value (1 to 8 characters)

This statement specifies an exclude record condition. The specified data from the field
must be equal to or greater than the low value and equal to or less than the high value.

Example:

Assume that you want to exclude records with usage start dates between the dates of June
1,2003 and June 12, 2003. You need to define the field that contains the usage start date
in the CIMSBILL Detail Records. This field begins at position 123.

DEFINE Al 123 8 /Start Date/
EXCLUDE Al 20030601 20030612
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INCLUDE

Related interface option: Define Include/Exclude Records, see page 5-54.
Format:

INCLUDE fd Tow high

fd = two-character field ID (from the DEFINE control statement—see page D-19)
Tow = specifies the low or from selection value (1 to 8 characters)

high = Specifies the high or to selection value (1 to 8 characters)

This statement specifies an include record condition. The specified data from the field
must be equal to or greater than the low value and equal to or less than the high value.

Example:

Assume that you want to include records with usage start dates between the dates of June
1,2003 and June 12, 2003. You need to define the field that contains the usage start date
in the CIMSBILL Detail Records. This field begins at position 123.

DEFINE Al 123 8 /Start Date/
INCLUDE Al 20030601 20030612

NORMALIZE CPU VALUES

B D-22

Related interface option: Normalize CPU Values, see page 5-28.
Format:
NORMALIZE CPU VALUES

This statement instructs CIMSBILL to normalize CPU values. For more information
about normalizing CPU values, see page 5-51.
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PROCESS
Related interface option: Process Type, see page 5-26.
Format:
PROCESS (DETAIL RECORDS | CIMS SUMMARY RECORDS}
This control statement specifies the type of data that is contained in the input file for
CIMSBILL. CIMSBILL can process only one type of data at a time.
Example:
PROCESS DETAIL RECORDS
PRORATE MONEY

Related interface option: Proration Type Money, see page 5-43.
Format:

PRORATE MONEY Ten

Ten = the length to match for proration

This statement splits money for a specific resource (or all resources) among multiple
accounts. To prorate money, a prorate table must be set up to specify how the monies
are split. The length specified is used to determine at what level to match for the splitting.
Assume that the following control statement is specified:

PRORATE MONEY 5
The following prorate (or split table) is defined as:

AAABB,AAL,40,AT1
AAABB,AAZ,60,AT1

The accounts AAABB, AAABBBB, and AAABBCC will match and be split into AA1 and
AA2.

Example:

PRORATE MONEY 5
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Prorating Resources vs. Prorating Money

In CIMS Server Administrator, you can set the option to prorate on resources or on
money. Both options display the same prorated units and charges in Web reports.
However, you cannot drill down on resource units by identifier if you prorate by money.
The following describes the advantages and disadvantages of prorating resources and
prorating money:

Prorating resources. The CIMSACCT Detail File from CIMSSORT is prorated before
CIMSBILL applies rates and figures money and a new CIMSACCT Detail File is built with
all the prorated resources. The new CIMSACCT Detail File is then used in the CIMSBILL
process.

An advantage of prorating resources is that the CIMSBILL Detail Records match the
records in the CIMS Summary File. Therefore, users can drill down on resource units by
identifier when viewing invoices in CIMS Server Web Reporting. A disadvantage is that
the CIMSBILL Detail File can contain a potentially large number or records.

Prorating money. The CIMS Summary file is prorated just before CIMSBILL ends. A new
CIMS Summary File is built with the prorated values.

An advantage of prorating money is that the CIMSBILL Detail File contains fewer records
than it would if you prorated by resources. A disadvantage is that the CIMSBILL Detail
Records do not match the CIMS Summary Records and drilling down by identifier will
not produce accurate data.

PRORATE RESOURCES
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Related interface option: Proration Type Resources, see page 5-43.
Format:

PRORATE RESOURCES Ten

Ten = the length to match for proration

This statement splits a specific resource (or all resources) among multiple accounts. To
prorate resources, a prorate table must be set up to specify how the resources are split.
The length specified is used to determine at what level to match for the splitting. Assume
that the following control statement is specified:

PRORATE RESOURCES 5
The following prorate (or split table) is defined as:

AAABB,AAL,40,AT1
AAABB,AAZ,60,AT1

The accounts AAABB, AAABBBB, and AAABBCC will match and be split into AA1 and
AA2.

Example:

PRORATE RESOURCES 5
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PRINT PRORATION REPORT
Related interface option: Print Proration Report, see page 5-43.
Format:
PRINT PRORATION REPORT

This statement generates a proration report that contains the original record and all
subsequently-generated prorated records. The proration report will reside in the
processing directory with the file name of ProrateRep.Txt.

Example:

PRINT PRORATION REPORT

REPORT DATE

Important! « CIMS Lab recommends that you do not use this statement. This
statement will place report dates rather than actual usage end dates in the accounting
date fields of the CIMSBILL Summary Records. You should use the default Auto
option in CIMS Server Administrator rather than report dates (see page 5-26).

Related interface option: Output-Summary Date Range, see page 5-28.

Format:
REPORT DATE {YYYYYMMDD YYYYYMMDD | keyword}

This statement specifies the dates that are used as the accounting dates in the CIMS
Summary Records created by CIMSBILL. This is the date that is used for reporting
purposes in CIMS Server. You can use the following values:

®m From and to dates
or

m One of the following keywords:

Keyword Description

**RNDATE Sets the date range based on the run date

**CURDAY Sets the date range based on the run date and the run date less one
day

**CURWEK Sets the date range based on the run week (Sun-Sat)

**CURMON Sets the data range based on the run month

**PREDAY Sets the date range based on the run date, less one day

**PREWEK Sets the date range based on the previous week (Sun-Sat)
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Keyword Description

**PREMON Sets the date range based on the previous month

CURRENT Sets the date range based on the current period from the CIMS
Calendar table

PREVIOUS Sets the date range based on the previous period from the CIMS
Calendar table

USE DETAIL DATES  Sets the date range based on the CIMSACCT Detail record (consult
CIMS Lab before using this keyword [see Contacting Technical
Support on page 6-7])

Examples:
REPORT DATE 20030601 20030630

REPORT DATE **PREMON

USE SHIFT CODES

TEST

B D-26

Related interface option: Use Shift Codes, see page 5-28.
Format:
USE SHIFT CODES

This statement instructs CIMSBILL to use the shift character specified in the CIMSACCT
Detail Record and apply the appropriate rate shift value.

If a shift value is not defined for the rate, the default rate value for the resource will be
used. The default rate value is also the SHIFT1 rate value.

Related interface option: Trace flag, see page 5-30.
Format:
TEST ¢

c = a character (D for dates, R for display rate information [each rate code read from the
database], Y for general messages, 7 for trace client processing [dynamic client add and
client searching|)

This control statement is used to print tracing messages to the message file.
Example:

TEST Y

CIMS Server Administrator's Guide



Control and Processing Statements N
Processing Control Statements

Processing Control Statements

CIMS Server Administrator stores additional processing setting for each process
definition in the ProcessCnt1.txt file. This file resides in the folder of each process
definition.

The following table describes the processing settings in the ProcessCnt1.txt file and
provides the corresponding GUI option in CIMS Server Administrator.

Processing Statement GUI Option

AcctInputFile f7lename Input File, see page 5-23
Where f77ename = the name of CIMSACCT input file.

AcctOutputDetailFile f7lename Output Files: Detail,

o see page 5-23
Where filename = the name of CIMSACCT Detail File.

AcctOutputIdentFile f7ilename Output Files: Ident,
. see page 5-23
Where f7lename = the name of CIMS Ident File.

AcctOutputExceptionFile filename Output Files: Exception,
. . see page 5-23
Where f77ename = the name of CIMSACCT exception

output file.

AutoLoad Yes/No Load record type records,
. . . . . see page 5-19

This setting determines if the system automatically

loads process output at the conclusion of processing.

BillInputFile filename Input File, see page 5-28
Where f77ename = the name of CIMSBILL input file.

BillDetailFile filename Output Files: Detail, see
o page 5-28
Where 77]ename = the name of the CIMSBILL Detail File.
BiT11SummaryFile f7ilename Output Files: Summary, see
' . page 5-28
Where f7lename = the name of the CIMS Summary File.
BilIMultFile filename Proration Table, see
) page 5-43
Where filename = the name of the proration table file.
AcctCodeConversionTable filename Conversion Table, see
page 5-35

Where filename = the name of the account code
conversion table.

Description name Process Description, see
- . page 5-19
Where name = a description of the process definition.
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Processing Statement

GUI Option

DSN name

Where name = the name of the data source.

Data Source Name,
see page 5-21

DSNUID wuser ID

Where user ID=the user ID needed to access the data
source.

Database User ID,
see page 5-21

DSNPWD password

Where password = the encrypted password needed to
access the data source.

Database Password,
see page 5-21

GenerateODBCINF Yes/No

This setting generates an INF file that passes along user
ID and password information to the data source.

Automatically generate
ODBC INF file from above
parameters, see page 5-21

RunCIMSAcct Yes/No

This setting determines if CIMSACCT is run as part of
the process.

Run CIMS Account,
see page 5-19

RunCIMSBi11 Yes/No

This setting determines if CIMSBILL is run as part of the
process.

Run CIMS Bill, see page 5-19
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Glossary

ASP ¢ Acronym for Active Server Pages. A server-side scripting environment developed
by Microsoft for developing Web pages and applications.

cascading style sheets « Cascading style sheets contain typographical information on
how an HTML page should appear (i.e., fonts, colors, table and list formats, etc.).

CIMS Server Resource File ¢ The resource file that contains the data that is input into
CIMS Server. The CIMS Server Resource File contains CIMS Server Resource Records.
These records are comma-delimited and can contain a very large number of resource
identifiers and resources. See also identifier and rate code.

client « 1. A computer that accesses shared network resources provided by a server. 2.
In CIMS Server, an entity that consumes resources. A client is represented by an account
code.

COM < Acronym for Component Object Model. A specification developed by
Microsoft for building software components that can be assembled into programs or add
functionality to existing programs running on Microsoft Windows platforms.

cookie < A small text file that stores information about a Web site user. CIMS Server
Web Reporting stores user information, such as the report parameter values entered by a
user, in a cookie.

DBMS ¢ Acronym for Database Management System. Software used to organize,
analyze, and modify information stored in a database.

domain ¢ A set of network resources (applications, printers, etc.) for a group of users.
The user need only to log in to the domain to gain access to the resources, which may be
located on a number of different servers in the network.

DSN ¢ Acronym for Data Source Name. The name assigned to an ODBC data source.

ERD -+ Acronym for Entity Relationship Diagram. A diagram that illustrates the logical
structure of a database.

identifier ¢ In the CIMS Server Resource Record, a unique key that denotes the source
of a resource that has been consumed. Examples include device name, server name,
system ID, phone number, user ID, state code or building number. A consumed resource
can have one to many identifiers.
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B Glossary-2

internationalization ¢ In software development, internationalization is the process of
planning and implementing a product so that it can easily be adapted (localized) to
specific languages. The word “internationalization” is sometimes abbreviated as “118N”
because there are 18 letters between the first letter “I1” and the last letter “N”. See also
localization.

IIS » Acronym for Internet Information Services. Microsoft software that supports Web
site creation, configuration, and management.

localization ¢ In software development, the process of adapting an internationalized
product for a specific language, script, culture, and coded character set. The word
“localization” is sometimes abbreviated as “I.10N” because there are 10 letters between
the first letter “L” and the last letter “N”. See also internationalization.

ODBC ¢ Acronym for Open Database Connectivity. An interface providing a common
language for database access.

offset ¢ A number that indicates how far from a starting point an item is located.

rate code < A rate code represents the resource units being reported (for example, CPU
time, transactions processed or lines printed). The rate code includes the value for the
resource and other rate processing information.

UNC ¢ Acronym for Universal Naming Convention. A file naming system beginning
with two backslashes (\\) that indicates that the resource exists on a network computer.
The syntax is \\Servername\Sharename.

URL ¢ Acronym for Uniform Resource Locator. The address for a resource on the
Internet or an intranet.

Windows Script Host ¢ A language-independent scripting host for Windows Script-
compatible scripting engines. WSH acts as a host for scripts—it makes objects and
services available for the script and provides a set of guidelines within which the script
is executed.

XML < Acronym for Extensible Markup Language. A meta-markup language that
provides a format for describing structured data. XML allows for more precise
declarations or content and more meaningful search results across multiple platforms.
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archive file path setting 3-54
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previous CIMS Processing Engine output 5-20
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browser requirements, CIMS Server Web
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removing 3-20
bulk loading the database option 5-20

C
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about 3-22
considerations 3-24
enabling the use of 3-44
setting 3-22 to 3-24
using 13 accounting periods 3-24, 3-44
CIMS Advanced Spreadsheets
enabling 3-46
installing
during the CIMS Server installation 2-14
stand-alone 2-43
system setup 2-40 to 2-43
CIMS Aggregation Engine, installing 2-14
CIMS Conversion Engine, installing
installing
CIMS Conversion Engine 2-14
CIMS Data Collectors
about 1-5
installing 2-14
CIMS Ident File
about B-6
eliminating duplicates from 5-23
layout of B-6
load option 5-20
CIMS Processing Engine
about 5-5
archiving previous output created by 5-20
components 1-6
installing 2-14
removing previous output created by 5-19
CIMS Rate Identifiers table, updating 4-14
CIMS Server
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configuration settings, accessing 3-43
debugging 6-7
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getting started 2-18 to 2-45
installing 2-13 to 2-16
on multiple computers, about 2-34
pre-installation procedures 2-6 to 2-11
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internationalization of 2-9 to 2-11
license key, entering 3-48
setup instructions 2-24 to 2-34
system
components 1-5 to 1-9
specifications 2-3 to 2-5
updates, downloading 2-46
upgrading 2-13 to 2-16
CIMS Server Administrator
about 1-7
dialog boxes, moving and resizing 2-45
help, accessing 2-45
installing 2-14
client installation, system specifications for
2-5
processing data using 5-31
setting data processing options in 5-17 to 5-31
starting 2-24
CIMS Server Web Reporting
about 1-8
auto log on, enabling 3-50
browser requirements 2-5
installing 2-14
starting 2-44
CIMS Summary File
about B-11
layout of B-11 to B-14
load option 5-20
CIMSACCT
about 5-6
account codes and account code conversion,
about 5-14
control statements D-3 to D-13
Detail File
about B-5 to B-6
layout of B-5 to B-6
load option 5-20
Exception File, about 5-9
input
file selection option 5-23
files, list of 5-7 to 5-8
record date selection option 5-22
record type selection option 5-22
Message File
about 5-9
file name setting 5-23
printing trace messages to 5-25
printing unmatched identifiers to D-11

CIMS Server Administrator's Guide



Index H

null character check, using D-13
output
file name options 5-23
files, list of 5-9
run option 5-19
CIMSAdminLib, about 5-14
CIMSBILL
about 5-10
control statements D-14 to D-26
Detail File
about B-7 to B-10
layout of B-7 to B-10
load option 5-20
input
file selection option 5-28
files, list of 5-12
record date selection option 5-27
record type selection option 5-26
Message File
printing trace messages to 5-30
Message File, about 5-13
output
file name options 5-28
files, list of 5-13
run option 5-19
CIMSLib.wsf script C-3
CIMSSORT, about 5-10
CIMSUtil.wsf script C-3
CleanUp.wsf script C-3
client (account code) 3-19 to 3-20
about 3-16
add to client table option 5-29
adding 3-17 to 3-18
budgets
about 3-19
removing 3-20
contacts
adding 3-21
automatic creation of C-4
editing 3-21
removing 3-21
data, exporting 3-21
editing 3-17 to 3-18
name
assigning 3-17
automatic creation of C-4
rate table search option 5-29
removing 3-18
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installing CIMS Server Administrator on 2-5
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system specifications 2-5
viewing Web reports on 2-5
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about 5-15
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rate groups 3-11, 3-14 to 3-15
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system specifications
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for the Web server 2-4
version 8.5, using 6-8
custom
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about 1-8
path setting 3-45
Web site, settings for 3-51 to 3-52

data collectors See CIMS Data Collectors
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process options
eliminate duplicates (from CIMS Ident File)
5-23
data processing See processing data
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adding 4-5 to 4-6
editing 4-6
removing 4-7
selecting 4-7
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about 1-9
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editing 4-6
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time-out setting 3-48, 3-53
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alternate account code structures 3-8
alternate rate tables 3-14
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unused identifiers 3-41
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users 3-28
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Web headlines 3-40
Detail File See CIMS Account Detail File or
CIMSBILL Detail File
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account code structure levels 3-4 to 3-7

client contacts 3-21

clients 3-17 to 3-18

rate codes 3-10 to 3-12

report settings 3-35

user groups 3-30 to 3-31
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Web headlines 3-39
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events, viewing 5-32
exception file processing

about 5-14
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file name setting 5-23
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ExportRateToMVS.wsf script C-8
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file layouts
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CIMS Ident File B-6
CIMS Server Resource File B-2
CIMS Summary File B-11 to B-14
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including or excluding from processing 5-52 to
5-57
removing unused 3-41
updating in Rate Identifier table 4-14
11S
enabling Web reporting in 2-35 to 2-36
required version 2-4
restarting 6-4
user access options with SQL Server user access
2-20
user access, enabling
anonymous access 2-36 to 2-37
Windows authenticated access 2-36 to 2-37
include fields, specifying 5-23
include/exclude processing 5-52 to 5-57
example 5-55 to 5-57
initializing the database 2-26
installing
CIMS Advanced Spreadsheets
during the CIMS Server installation 2-14
stand-alone 2-43
CIMS Aggregation Engine 2-14
CIMS Data Collector 2-14
CIMS Processing Engine 2-14
CIMS Server 2-13 to 2-16
CIMS Server Administrator 2-14
CIMS Server Web Reporting 2-14
crystal reports 2-12
MSDE 2-15
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installing CIMS Server
modifying an existing installation 2-17
on multiple computers, about 2-34
pre-installation procedures 2-6 to 2-11
internationalizing CIMS Server 2-9 to 2-11
Internet Explorer, required version 2-5
Internet Information Services See I1S
invoices
entering contact information for 3-21
entering organization information for 3-43
setting invoice numbers 3-47

L

license

key, entering 3-48

third-party software 2-6
LoadClientTableFromCSVFile.wsf script C-24
localizing CIMS Server 2-9 to 2-11

M
MSDE 2000
database, creating 2-21, 4-3
IIS authentication method required for 2-19
installing 2-15
when to use 1-9

normalizing CPU values 5-49 to 5-51

0

offsets for account code levels 3-7

P
password for CIMS Server Web Reporting user
default 3-25
setting 3-27
path for, setting 3-45
permissions (folder) required for Web user 2-38
pre-installation checklist 2-7
ProcCIMS.wsf script C-8
ProcConvEngine.wsf script C-8
process definitions
See also processing data
about 5-17
adding 5-17 to 5-18
processing options, setting 5-18 to 5-30
samples 2-33
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processes folder
creating 2-27
path setting 3-44
processing control statements D-27 to D-28
processing data
about 5-3
account code conversion
about 5-14
example 5-40 to 5-42
options for, setting 5-35 to 5-37
table, creating 5-38 to 5-39
account codes
about 5-14

defining the identifiers used for 5-34 to 5-35

accounting dates
about 5-15
and the close date 5-15
calculation of 5-15
CIMS Processing Engine, about 5-5
CIMSACCT
about 5-6
control statements D-3 to D-13
input files, list of 5-7 to 5-8
output files, list of 5-9
CIMSBILL
about 5-10
control statements D-14 to D-26
input files, list of 5-12
output files, list of 5-13
CIMSSORT, about 5-10
control statements
CIMSACCT D-3 to D-13
CIMSBILL D-14 to D-26
processing D-27 to D-28
CPU values, normalizing 5-49 to 5-51
events, viewing 5-32
exception file processing
about 5-14
enabling 5-37
file name setting 5-23
in CIMS Server Administrator 5-31
include/exclude processing 5-52 to 5-57
example 5-55 to 5-57
process definitions
about 5-17
adding 5-17 to 5-18
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process options 5-20
account code search fields 5-29
account fields 5-35
add new clients to Client table 5-29
archive process files 5-20
back load data 5-28
check for bad file input 5-25
CIMSACCT input file 5-23
CIMSACCT input record date 5-22
CIMSACCT input record type 5-22
CIMSACCT output files 5-23
CIMSACCT trace flag 5-25
CIMSBILL input file 5-28
CIMSBILL input record date 5-27
CIMSBILL input record type 5-26
CIMSBILL output files 5-28
CIMSBILL trace flag 5-30
client search 5-29
conversion table 5-37
convert account fields to uppercase 5-35
data source name 5-21
data source user ID and password 5-21
default close day 5-26
define fields 5-36
define include/exclude fields 5-54
define include/exclude records 5-54
enable exception processing 5-37
generate ODBC INF file 5-21
include fields 5-23, 5-53
load CIMS Ident File 5-20
load CIMS Summary File 5-20
load CIMSACCT Detail File 5-20
load CIMSBILL Detail File 5-20
move fields 5-36
normalize CPU values 5-51
perform account code conversion 5-35
print proration report 5-44
process definition path 5-19
process description 5-19
process name 5-19
proration match length 5-43
proration table 5-44
proration type 5-43
remove output files before processing 5-19
run CIMSACCT option 5-19
run CIMSBILL run 5-19
shifts 5-24
use shift codes 5-28
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process priority, setting 3-48
proration
about 5-43
options, setting 5-43 to 5-48
results of, viewing 5-31
setting processing options in CIMS Server
Administrator 5-17 to 5-31
shifts, recalculating 5-24
suggested frequency 5-4
processing engine See CIMS Processing Engine
proration
about 5-43
account code match length setting 5-43
enabling 5-43
money vs. resources 5-48
options, setting 5-43 to 5-48
report, printing 5-44
table
creating 5-44
examples 5-45 to 5-47
specifying 5-44
published reports
about 3-45
creating using batch scripts C-14 to C-23
path setting 3-45
PurgeDetail.wsf script C-9
purging
data from CIMS Detail and CIMS Ident tables
C-9
database loads 4-25, 4-26

R

rate codes
about 3-9
adding 3-9 to 3-12
adding to rate groups 3-11, 3-16
editing 3-10 to 3-12
moving to another rate group 3-16
rebilling C-10 to C-12
removing 3-12
removing from rate groups 3-16
setting shifts for 3-12 to 3-13
rate groups
about 3-14
adding 3-11, 3-14 to 3-15
adding rate codes to 3-11, 3-16
changing descriptions of 3-15
changing titles of 3-15
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moving rate codes 3-16
removing 3-15
removing rate codes from 3-16
Rate Identifiers table, updating 4-14
rate tables
alternate 3-13
adding 3-13
removing 3-14
duplicating 3-14
exporting 4-13
loading 4-13
STANDARD 3-9
rates See rate codes
Rebill.wsf script C-10 to C-12
removing
account code structure levels 3-7
alternate account code structures 3-8
alternate rate tables 3-14
client budgets 3-20
client contacts 3-21
clients 3-18
clients from user groups 3-33
data from CIMS Detail and CIMS Detail Ident
tables C-9
data sources 4-7
database loads 4-25, 4-26
previous CIMS Processing Engine output 5-19
rate codes 3-12
rate codes from rate groups 3-16
rate groups 3-15
report groups 3-37
reports from report groups 3-37
reports from reports list 3-35
reports from user groups 3-33
unused identifiers 3-41
user groups 3-32
users 3-28
users from a group 3-32
Web headlines 3-40
report groups
about 3-36
adding 3-36 to 3-37
adding reports to 3-37
removing 3-37
removing reports from 3-37
re-sorting display order of 3-38
types of 3-36
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reports
adding to reports list 3-34 to 3-35
batch See batch reports
changing description of 3-38
custom
about 1-8
path setting 3-45
editing settings 3-35
last reporting date setting 3-46
path setting
custom reports 3-45
published reports 3-45
standard reports 3-45
published
about 3-45
path setting 3-45
removing from reports list 3-35
renaming 3-38
re-sorting display order of 3-38
security, setting 3-46
standard
about 1-8
path setting 3-45
user-defined reports default group, setting 3-38
ResourceConversion.wsf script C-10 to C-12
restoring database loads 4-25

S

SampleMonthly.wsf script C-12
SampleNightly.wsf script C-12
Scan.wsf script C-12
scripts
AllAccts.wsf C-22 to C-23
BatchReport.wsf C-14 to C-21
CIMSLib.wsf C-3
CIMSUtil.wsf C-3
CleanUp.wsf C-3
ClientPropogate.wsf C-4
ConvertSummaryDailyToMonthly.wsf C-5 to
C-7
ExportClientToMVS.wsf C-7
ExportRateToMVS.wsf C-8
FIP.wsc C-8
FTP.wsf C-8
LoadClientTableFromCSVFile.wsf C-24
ODBC parameters for C-25
ProcCIMS.wsf C-8
ProcConvEngine.wsf C-8
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PurgeDetail . wsf C-9
Rebill.wsf C-10 to C-12
ResourceConversion.wsf C-10 to C-12
running C-3
SampleMonthly.wsf C-12
SampleNightly.wsf C-12
Scan.wsf C-12
SendMail.wsf C-13
Shell.wsc C-13
UnloadDesktopForServer.wsf C-24
Secure Sockets Layer See SSL, enabling for Web
site
SendMail.wsf script C-13
Shell.wsc script C-13
shifts
enabling CIMSBILL to process 5-28
recalculating using CIMSACCT 5-24
setting 3-12
shifts for rates, setting 3-12 to 3-13
software, suggested 2-3
client 2-5
server 2-4
SQL Server 2000
database, creating 2-21 to 2-23, 4-2
simple recovery, setting 4-4
user access options with IIS user access 2-20
user logins, creating 2-22 to 2-23
SSL, enabling for Web site 2-39
standard reports
about 1-8
path setting 3-45
starting
CIMS Server Administrator 2-24
CIMS Server Web Reporting 2-44
Summary File See CIMS Summary File
system specifications 2-4
client
browser 2-5
CIMS Server Administrator 2-5
Crystal Reports 2-5
server 2-4
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tables, database
auditing 3-53
converting daily summary data to monthly
summary data C-5 to C-7
creating 4-13
description of A-3 to A-47
dropping 4-13
ERD (entity relationship) diagrams A-48 to A-
53
exporting 4-12
loading 4-12
profiling 4-28
purging data from CIMS Detail and CIMS
Detail Ident tables C-9
viewing 4-15
technical support 6-7
trace flag option
for CIMSACCT 5-25
for CIMSBILL 5-30
transactions
auditing 3-53
troubleshooting 6-2

u

UnloadDesktopForServer script C-24
updates, downloading 2-46
upgrading
CIMS Server 2-13 to 2-16
the CIMS Server database 4-29
use bulkload interface 5-20
users and groups
about 3-25
groups
adding 3-29
assigning administrative privileges for 3-25,
3-30
clients, adding 3-33
clients, removing 3-33
default 3-25
editing 3-30 to 3-31
removing 3-32
reports, adding 3-32
reports, removing 3-33
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users

w

Web

adding 3-25

adding to a group 3-32

assigning administrative privileges for 3-25,
3-30

Crystal Viewer, setting 3-26

default 3-25

editing 3-26 to 3-27

enabling automatic log on for CIMS Server
Web Reporting 3-27

removing 3-28

removing from a group 3-32

headlines

about 3-39
adding 3-39
editing 3-39
removing 3-40

reporting 3-50

additional options settings, configuring 3-54

enabling in IIS 2-35 to 2-36

starting 2-44

starting and ending account code levels for,
setting 3-49, 3-50

using multiple databases for 4-7 to 4-10

server

about 1-9
installing on a separate computer 2-35
setup instructions 2-35 to 2-39

site

adding an unique identifier for 4-8
Crystal Report Viewer, choosing 3-49
customizing 3-51 to 3-52

Secure Sockets Layer (SSL), enabling 2-39
session time-out setting 3-49

user, required folder permissions 2-38

1

zero costing, about 3-11
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